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Copyright 
This documentation is protected by law. All rights, especially the right to duplicate, 
circulate, and translate, are reserved. 

No part of this publication may be reproduced in the form of copies, microfilms or 
other processes, or transmitted into a language used for machines, especially data 
processing machines, without the express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. Errors in 
and changes to the contents as well as program modifications reserved. 

Copyright © MAGIX Software GmbH, 2000 - 2016. All rights reserved. 

MAGIX and Cleaning Lab are registered trademarks of MAGIX Software GmbH. 

VST is a registered trademark of Steinberg Media Technologies GmbH. 

MAGIX Audio Cleaning Lab uses patent-pending technology. 

Other mentioned product names may be registered trademarks of the respective 
manufacturer. 

MAGIX licensing conditions are included in the installation and also at 
www.magix.com under EULA. 



 

 

Preface 3 

 

Preface 
Congratulations! You now own a high-performance digital audio lab, which is perfect 
for cleaning your records, tapes, CD tracks, MP3 collections, audio or video files, 
enhancing the sound, combining your media in any order, and burning or exporting 
everything in optimum quality directly onto CD or DVD. 

The volume and sound on each track can be perfectly synced and equalized. Various 
audio formats can be combined, simultaneously edited, and burned. The method is 
especially easy and clear, since automatic settings, assistants and step-by-step 
instructions make sure that the process goes smoothly and easily. Neither previous 
experience using the software nor long processing time are necessary. 

The print manual provides an introduction and tutorial that explains all the most 
important features with step-by-step instructions.  

In addition, an electronic manual is supplied in PDF, which systematically explains all 
of the program's components one after the other. You can also use the program's 
help file by pressing "F1". If you prefer to discover the many possibilities of the 
program by yourself, then use the PDF manual and help file simply as a reference. An 
alphabetical index is included for this purpose. 

Have fun with MAGIX Audio Cleaning Lab. 

The MAGIX team. 
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Support 
Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. To this 
end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at www.magix.com 

• The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 150,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products: 
For each new MAGIX product you will automatically receive 12 months free 
customer support by email. 

• Premium Email Support: 
For priority support, or if you want the support team to help with non-MAGIX 
related hardware problems you can purchase a premium email support ticket. 
Proceed as follows: 
1. Go to the MAGIX customer support page at http://support.magix.net. 
2. Sign in using your login details. 
3. Click on "Purchase access code" in the navigation bar. 

Each ticket corresponds to a specific problem, it will remain valid until the 
problem has been solved. A ticket is not limited to a single email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. The serial number can be found on the sleeve of the installation 
disc or on an insert card included in the package. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a 
fee-based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 

http://support.magix.net/ 

http://support.magix.net/�
http://support.magix.net/�
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Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  

Denmark: 45 699 18763 

Sweden: 46 852 500713  

Finland: 35 89 42419023 

Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 

Phone: 1-305-722-5810  
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Introduction 

What is MAGIX Audio Cleaning Lab? 
MAGIX Audio & Music Lab Premium is a gentle but powerful cleaner for all kinds of 
acoustic material including records, tapes, CD tracks, speech recordings and MP3s. 
Digital cleaning removes everything from light crackling to severe interference on 
scratched records, old cassettes and MP3s that have been compressed too many 
times. A fine polish of the sound brings new life to every song and the disc-burning 
function lets you save your sensitive sound material on audio or data CD to protect it 
from further damage. 

Individual tracks, even individual passages within a track can be given their own effect 
settings. Additionally, the entire sound can be cleaned up, refreshed, and especially 
important for compilations, the volume can be balanced. 

MAGIX Audio & Music Lab Premium is fast, easy-to-use and very gentle: Almost all 
effects are calculated in realtime during playback without damaging the recorded 
material in the least. The original recordings and songs remain untouched on the hard 
disk. This means you can experiment as much as you like without having to worry 
about causing any lasting damage to your audio material. 

MAGIX Audio & Music Lab Premium and 
MAGIX Audio Cleaning Lab 
Audio & Music Lab comes in two versions, MAGIX Audio Cleaning Lab and MAGIX 
Audio & Music Lab Premium. This program help file and manual describes the 
functions in MAGIX Audio & Music Lab Premium. Program functions that are not 
available in the "smaller" version MAGIX Audio Cleaning Lab are indicated 
throughout document. 

The following functions are only available in MAGIX Audio & Music Lab Premium and 
are not in MAGIX Audio Cleaning Lab: 

• 24-bit Recording: The default setting for recording is CD quality (44.1 kHz 
sample rate, 16-bit resolution). MAGIX Audio & Music Lab Premium can record 
at higher resolutions and bit rates if the sound card supports it. 

• More tracks: You can switch to two or four audio tracks which enables you to 
mix music with speech and other sounds. This makes it possible to include 
spoken commentary parallel to the other audio in a video recording. 

• More analyzer types: MAGIX Audio & Music Lab Premium offers nine different 
analyzers - MAGIX Audio Cleaning Lab only offers two. 

• VST Effects: MAGIX Audio & Music Lab Premium supports the integration of 
third-party VST effects, some effect plug-ins (AM-Track SE, Energizer and the 
Essential FX) are included. 



 

 

Introduction 13 

 

• Video editing: Load and edit the video sound, the Video Sound Optimizer effects 
and the video preview monitor are only available in MAGIX Audio & Music Lab 
Premium. 

• Recording web radio stations (view page 52) 
• A scrubbing slider (view page 36) 
• Batch processing (view page 131) 
• Spectral view and spectral editing (view page 32) 
• Voice-over function (view page 130) for automatic volume curves on 

background music 
• Improved Auto Mastering: MAGIX Audio & Music Lab Premium uses object 

effects for the Auto Mastering process which leads to better results, especially 
in projects that contain audio from various sources. 

What is new in MAGIX Audio Cleaning Lab? 
User interface improvements  

We implemented many user suggestions to improve the user interface: 

• A better readability of the effects presets. 
• Dedicated Buttons for edit functions (Copy, Paste...)  
• The order of the effects was optimized, the most important effects are placed 

topmost in the fx sections, so you can acess them withou scrolling also on 
smaller screens. You can even change this order to suit you needs. 

• You can now switch between the effects via button from within an effect dialog. 
• Options regarding the program display are moved into a new "View" menu, 

there are new keyboard shortcuts to maximize single screen areas. 

More and better effects 

• The detailed effect views are now also available in MAGIX Audio Cleaning Lab. 
• Auto Cleaning was integrated in the main programm interface and has better 

setting options. 
• The Timestretching now uses the zPlane Elastique Pitch algorithms for  better 

quality. 

Only in MAGIX Audio & Music Lab Premium  

• There is a secondary reverb effect available, the essentialFX Reverb 
• In the mouse mode "Edit spectrum directly" (spectral cleaning) there is a 

secondary play button for a comparison between filtered and unfiltered audio. 
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Better edit functions 

• A new mouse mode Range Mode. For faster cutting there is now a Range Mode 
in  MAGIX Audio & Music Lab Premium where you can select a time range in 
the audio material for editing. 

• You can have up to four tracks in MAGIX Audio & Music Lab Premium. 
• You can change the curve form also for single fades (not just crossfades). 

More Improvements 

• A better video import (only MAGIX Audio & Music Lab Premium): Audio & 
Music Lab is capable of importing a lager range of videos directly, without 
converting it first. The calculation of the video preview strip is done in a separate 
process so you can play the video immediately after loading. 

• Search function: With the search function you can search for a key word in every 
menu item, help topic or effects preset. 

• No fee based activation for using the AAC codec (except Windows Vista). 

Features 
Import 
You can either import existing audio files in many conventional formats into MAGIX 
Audio Cleaning Lab or simply use MAGIX Audio Cleaning Lab to record your own 
music. Whether from cassette, tape, LP, or Internet streaming, with only a few clicks 
you can digitize your music and edit it further with MAGIX Audio Cleaning Lab. 

Cleaning 
The key feature of MAGIX Audio Cleaning Lab is its ability to remove unpleasant 
noise in music and enhance the overall sound. There are numerous professional tools 
available for this such as the "DeClicker", "DeCrackler", "DeClipper", "DeNoiser" 
(including DeRumbler preset), and "DeHisser". You can also add several sound 
effects to your music. 

Mastering 
So that your recordings sound optimal, a selection of mastering tools are available to 
you once you have cleaned up the audio material. Try them out yourself to see which 
settings are the best, or let MAGIX Audio Cleaning Lab do the work for you by 
searching for the best settings automatically. For more detailed information about the 
tools, please read MAGIX Audio Cleaning Lab's help file. 
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Export 
Of course, you can also export your recordings. There is a wide range of formats 
available which enable you to enjoy your recordings anywhere you like. 

Audio Import: WAV, MP3, WMA, AIFF, OGG Vorbis, M3U, CUE, CD-A, FLAC, AAC3 

Audio Export: WAV, MP31, WMA, AIFF, OGG Vorbis, CD-A, FLAC, AAC3, 
Data-CD/DVD 

Video import/export2:  MPEG-24, MPEG-4 (incl. AVCHD)4, MOV, WMV, MXV 

1 Requires Microsoft Media Player 
2 Not in MAGIX Audio Cleaning Lab  
3 Fee-based activation under Windows Vista 
4 Requires free activation under some circumstances 
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Quick start 
In this chapter, we will guide you through all of the important functions in MAGIX 
Audio Cleaning Lab step-by-step. You don't need any special experience; just some 
time for recordings and hard drive space. 

With MAGIX Audio Cleaning Lab you can load audio material from a number of 
different sources into projects in order to clean it up, edit it, or export it. 

Analog material like records or tapes have to be digitized first so that it can be 
processed by the computer. The recording function in MAGIX Audio Cleaning Lab 
can be used for this purpose. 

Load and playback audio files 
After starting the program, MAGIX Audio Cleaning Lab displays an empty project 
window. You are in the "Import" section, which is recognizable by the lit button below 
the project window. 

 

In the import area you can choose from seven (six in MAGIX Audio Cleaning Lab) 
different options, depending on what type of audio material is to be edited: 

 

• You can load your audio files, e. g. in MP3 format, by clicking the "Audio files" 
button. This will open the file browser. 

• You can import audio CDs via the "CD" button. 
• You can record records or audio cassettes using the "Record" or "Cassette" 

buttons.  
• Speech recordings are created using a connected microphone in the "Speech" 

area. 
• "Digital" can be used to record the current playback of the computer, e.g. the 

Internet browser. 
• "Web radio" allows you to record web radio stations. 

The file browser works like the Windows file explorer. Search for the files in the file 
system of the computer and select them with the mouse. Several individual files can 
be selected with Ctrl + mouse click. For a group of files, click on the first file first, then 
press shift and click on the last file. Click on "Import".  
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After import, a waveform display of the audio track appears in the main window. Each 
file is symbolized by an individual checkbox, a so-called "object". More information on 
the objects can be found in the chapter Cutting and arranging objects (view page 54). 

 

The waveform display gives you an idea of the audio track's progression. Even some 
noises can be recognized. Crackling, for example, creates a clearly identifiable spike in 
the waveform. 

Below to the right, you'll find the transport controls for playback, stop and moving the 
playback marker. You'll be familiar with these functions from other playback devices. 

 

Use the mouse for quicker navigation: If you click on a position in the timeline above 
the waveform display, the position line will be moved exactly to this position. You can 
start and stop the track by pressing the spacebar of your keyboard. 

Cleaning 
There are many different types of noise. Let's start with the easiest ones: Constant 
humming or irritating hissing. These kinds of noise are usually caused by tape 
recorders, record players or microphones and are audible throughout the complete 
track. Find out how to get rid of these irritating noises: 

• Switch to the "Cleaning" section. 
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In the middle of the function area you can now find various function modules for noise 
removal that can be used individually or combined. If you click on one of these 
modules, you will find explanations regarding purpose and workflow of the individual 
module on the info monitor located in the bottom right-hand corner. To the left side of 
them, you can find presets for the entire Cleaning area, sorted into headings 
depending on the sound source of the source material (record, cassette,...). 

The modules are operated in the same way: 

You can use the knob to control the 
amount of each cleaning effect. 

If you are not satisfied with the presets 
in the start dialog, you can choose 
further presets using the arrow menu. 

To get an idea of how the selected 
effect affects your audio material, you 
can turn it on and off by clicking on the 
symbol in the left-hand corner. 

The cog wheel button at bottom right is 
used to open a user interface where you 
can set other parameters of the effect. 
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Depending on the effect unit, you can specify very effective audio editing settings 
here. To do so, it's necessary to know a bit about audio editing though. Usually, 
however, you will not need these special functions, but they can be useful in complex 
cases. You can find more information in the "Cleaning effects" (view page 62) 
chapter. 

Mastering 
• Click on the "Mastering" button. 

"Mastering" is the second effects area and is meant for optimizing audio material. For 
example, you can increase the volume of the music (Multimax), copy the audio 
characteristics of a particular musical style (Sound Cloner (view page 80)) or 
sonically "freshen up" old MP3s with a low bit rate (Brilliance Enhancer (view page 
75)). 

Here you will also find a column with preset categories and the various effect modules 
on the right. 

The functionality of the optimization effects is the same in principle: Adjust the 
strength of the effect via the slider, switch the effect on and off to compare the 
advanced settings of an effect by clicking on the symbol in the bottom right-hand 
corner. 

Object effects 
If you combine the audio material from various sources, it's normally not sensible to 
apply cleaning and mastering effects to all objects in the same way. Tape recordings 
typically have different noise than LP recordings. Therefore, there are two different 
ways you can use the effects: Project effects and Object effects. 
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In the cleaning and mastering area you can see how the two types of effects are 
applied. "Project" is the default setting. 

 

The settings for project effects are applied to the entire sound, i.e. for all objects in the 
master track. 

Each object can also have its own individual effect settings. To add an effect to an 
object, click on "Object". 

This will highlight the object that you want to edit. There are also many audio effects 
available. These effects can be set separately for every object in the master track . 

 

Remove unwanted sections 
Now let's take a look at some special kinds of audio noise that occur when something 
bangs against the microphone. 

These types of clicks, pops, rustling or even longer unwanted sounds can be cut out of 
the track by using the scissors tool in the track window. 

Note: This technique is only useful if the noise is the only sound and nothing else 
should be heard. If a click or pop occurs in the middle of the music, it's better to use 
theRetouching clicks and pops (view page 21) method described in the section 
below. 

1. Play the audio track and search for the section that you want to cut out. 
2. Set the position line in front of this section. 
3. Now click on the scissors icon. This will cut the object at this position.  
4. Now place the playback marker behind the section that you want to remove and 

cut again. 
5. This creates three separate objects on the track. 
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• Select the object in the middle and delete it by pressing the "Delete" key. 

 

The back of the object automatically moves back and slightly overlaps with the front 
part of the object. You can use the handles to make fine adjustments to the transition. 

 

• There are handles at the top left and right hand corners, which allow you to 
create fade ins and outs. 

• The handle at the top center is for adjusting the volume. If you pull it 
downwards, the volume of the object is reduced. 

• The handles at the bottom left and right corners adjust the object borders. You 
can fine tune your cuts by extending or contracting the object. 

Retouch short noises such as clicks or pops 
Let's take a look at a quick and elegant way of retouching short noises such as pops 
and clicks using a pen tool. 

Note: You can't undo editing that you did with the waveform drawing tool.   After 
selecting the pen tool, you can decide if you want play it safe and edit in a copy of 
the file or proceed directly in the original material. 

• Search for a section in the material where you hear crackling and set the 
playback marker to that position. 

• Zoom into that section so that you can see the details of the waveform display. 
You can either use the zoom button in the bottom right corner of the track 
window. 
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• Take a close look. Can you see the click or pop? Look for a "mountain" that is flat 
on top or exceeds its surroundings. 

 

• Select the Wave Draw mode ("Options" > "Wave Draw mode"). 

The mouse pointer turns into a pen which you can use to draw directly into the 
waveform. If you click, the zoom level increases automatically and you can draw. It's 
about trying to turn the flat form a bit more into a peak and moving it slightly towards 
the bottom. The critical section should then look like this at the end: 

 

If you play back the material now, the cracks have disappeared. 

Set track marker 
Your recording is now ready and should be burned to CD. For burning to CD and also 
exporting to individual MP3 files, you now need track markers in the project that 
indicate where a new song starts in a recording.  

To do so, switch to the "Tracks" view. 



 

 

Quick start 23 

 

 

Here you have the opportunity of checking and changing track markers and names.  

For records or cassettes, there is an automatic system that already sets the track 
markers during the recording using the silence between the tracks. This means that all 
track markers are probably already set after the recording, but you may have to move 
one or other of them slightly. And, of course, the tracks still need to be correctly 
named.  

Click on freedb. Audio & Music Lab tries to determine the names of the tracks from 
an online database using the special combination of track lengths. If that doesn't 
work, whether you like it or not you will have to enter them by hand. Double-click on a 
name (album, artist, name of the individual tracks) in the middle of the window in 
order to change it.  

Under ID3 Editor you can access other editing options, e.g. for changing the order of 
the tracks. Click on CD Cover to automatically load a cover from the Internet. 

Export 
After you have "cleaned up" the material, you can export it either song by song as 
MP3 or WAV files or all songs on the track as an audio CD. 

To do this, switch to the "Export" interface. 
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There are various export options available. "Files" saves the music on the hard drive 
as an MP3 or Wave file. Use "Audio CD" or "Data disc" to burn your project to CD. 
The "Share" option can be used to upload files to social networks. 

To save your project (view page 54) go to "File" > "Save project". This does not save 
the actual music, but instead saves all of the edits made in Audio & Music Lab in case 
you want to change something later or burn another CD. 



 

 

Overview of the program interface 25 

 

Overview of the program interface 

 

Program interface of MAGIX Audio Cleaning Lab 

 Menu bar: Here you'll find all the features available in MAGIX Audio Cleaning 
Lab 

 Overview track: The entire project is displayed here. The area that you are 
currently editing is highlighted. 

 Track: Here you can perform detailed editing of the audio material (view page 
54). 

 Editing buttons: Here you'll find buttons for important editing functions like 
split objects (view page 57) or delete and set track marker. The "Undo" and 
"Redo" buttons are also found here 

 Work areas: Here you switch between the Import (loading and recording of 
audio material), cleaning, mastering (sound cleaning and improvement), tracks 
(names and sequence of the songs) and exporting (saving ready-to-use audio 
files, burning or sharing on the Internet) work areas. 

 Transport console: Controls track playback. 

 Presets: Presets for the cleaning and mastering effects according to the audio 
material. You can hide the presets using the up arrow. 

 Project/Object: Here you can determine whether an effect will be applied to 
the whole project or only to a selected object 

 Effects section: Here you can access the individual cleaning (view page 62) or 
mastering effects (view page 74). 
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 Search function: Click on „Search” and enter a key word, the search lists all 
menu items, help topics and effect presets that contain the key word. 

 Master volume: Here you can set the master volume of the track. The limiter 
prevents clipping and the auto function enables the volume to be automatically 
optimized. 

 Info area: Displays the InfoBox with help texts on the effects that are offered, a 
visualization of the audio signal or the video preview (not in MAGIX Audio 
Cleaning Lab. 
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Track window and constant control elements 
This chapter describes the display and control elements which are available to you 
independently from the selected section in MAGIX Audio Cleaning Lab 

Search 
At the top right of the program window is a search function. 

 

Click on "Search" and enter a key word, the search list all menu items, help topics and 
effect presets that contain the key word. 

Keyboard shortcut:  Crl + F 
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The master track 
Audio material display 
All of a project's audio material is displayed in the master track of the track window as 
a waveform. The waveform corresponds with the acoustic properties of the material. 
This means that there isn't anything to listen to at places where there isn't anything 
visually; higher waves mean high volumes. The tracks waveform display forms the 
most important basis for locating specific passages. 

The display is compressed, meaning that the waveform is displayed as a ratio of loud 
passages to quiet passages. This ensures correct display for quieter sections at the 
beginning or end of a song. 

Position line 
During playback a thin line will move horizontally from the left to the right over the 
master track. This is the position line, which indicate, which part of the wave form is 
currently reproduced.  

The last starting point of the playback is indicated by a small triangle in the master 
track. The position line will jump back to that position, once playback has finished. 

Timeline/Marker 
The timeline is located above the track. It shows the time position in the project. The 
measurement unit for the time position can be changed in "Options" > "Measurement 
Unit". You can choose from: samples, milliseconds, hours/minutes/seconds, and CD 
frames. 

 

The markers are also displayed in the timeline. There are two different types of 
marker. 

 Track markers show where new CD tracks begin and where new files start when 
exporting MP3s. More information about this is available under Set track marker 
(view page 60). 

 Simple markers can be used to tag specific positions in a project. To set a simple 
marker, place the position line at the according time position and chose  "Set 
marker" from the Edit menu. 

To move markers, simply click on them and move them with the mouse. Clicking on a 
marker moves the position line to that position in the project. If the position line is on 
a marker, it can be removed using the Del key. 
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Overview track 

 

The overview track lets you select the project section which is displayed in the track display 
(displayed in blue). 

The track window now includes an additional overview track with a reduced display of 
the complete project. Now you can work at a specific position or on a certain song 
while maintaining an overview of the complete project and quickly navigate to areas 
that need more work. In the overview track you can also select the song or position in 
the material to be displayed in the track window. 

Move the section to the part of the project simply by clicking in the overview track; 
the zoom level remains the same. Define a new range in the overview track by clicking 
and dragging. Vertical yellow lines indicate the markers in the overview track.  

Use the "Overview mode" entry in the "Options" menu to show/hide the overview 
track. 

Video preview strips 

 

When a video file is loaded the video footage will be displayed as a filmstrip. This 
makes it easier and quicker to find specific scenes in the video. The further you zoom 
into the video the more images will be displayed, all the way until you reach individual 
frames. 

Note: Video sound editing is not available in MAGIX Audio Cleaning Lab. 
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Navigation 
The task of the transport controls is to help you navigate through the audio material in 
the master track. Here you can find functions that you will already now from your old 
tape recorder. You can get more information in the chapter Transport controls (view 
page 34). 

The simplest solution, however, is to navigate directly in the track: a mouse click on 
the time ruler will set the starting point for the playback (even if playback is already 
running!) The space bar starts and stops playback. 

Zoom 
The waveform display allows you to recognize certain parts of the material from the 
shape. For many tasks it is quite useful to enlarge the waveform display. For detailed 
editing, e.g. editing with the scissor tool, there are several zoom options: 

Quick zoom: For quick zooming it is sufficient to click with the mouse in the timeline, 
keep the mouse button pressed down and move it up or down. This way, you can 
quickly zoom the cursor in and out at any position without releasing the mouse. 

  The +/- zoom button at the bottom right corner of the track 
window zoom in/out the display. 

This enlarges the central area of the track window. Clicking on the adjacent triangle 
opens the zoom menu. Here you can open different zoom and navigation commands 
(view page 29). 

By selecting an area in the overview track (view page 28), you can also determine the 
visible section of the project. The overview track is located above the track window 
and displays the entire project irrespective of the selected zoom level. 

 You can click on this symbol or the "a" key to quickly restore the fullscreen view 
of the project. 

 

Moving the scroll bar forward and backward allows you to quickly navigate through 
the project. Dragging the scroll bar ends adjusts the size, which also zooms in and out 
of the project. 
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Zoom settings 
Command Keyboard shortcut Description 

Play/Position marker  Commands for quickly editing 
the playback position 

Marker left Alt + right 

Marker right Alt + left 

The play marker can be moved 
quickly between the markers. 

Object border left Shift + Alt + right 

Object edge right Shift + Alt + left 

The play marker can be quickly 
moved from object edge (object 
start and end) to object edge. 

Zoom ranges   

Show all A The entire project is visible. 

Zoom 1s 1 

Zoom 10 s 0 

Zoom 60 s 6 

Zoom 4 min 4 

Zoom 10 min Shift + 0 

The visible section of the project 
is quickly set to the selected 
value. 

Vertical zoom  

Zoom into waveform Ctrl + Cursor down 

Zoom out of waveform Ctrl + Cursor up 

Vertically zooms in and out of 
the wave shape. This is useful for 
locating the crossover point (for 
precise sample editing). 
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Control elements on the right side of the track 
window 
On the right side of the waveform display you'll find various buttons that influence the 
display and playback of the project. 

Master fader 
 This slider adjusts the output level of 

the track. For maximum sound 
quality, the project should be 
optimally controlled. 

 Use the "Auto" button to find this 
optimum level automatically. To do 
this, set the position line just in front 
of the loudest position in the project 
and start playback. (The loudest 
position can be found by locating the 
highest peak of the waveform 
display).  

After you have played the loudest 
part of the range, click on the "Auto" 
button to the right of the volume 
control. MAGIX Audio Cleaning Lab 
automatically adjusts the level so 
that the loudest part of the range 
just played back is exactly 0 dB - 
this will be the maximum volume. 

Note: The master fader adjusts the volume of the project which means that it will be 
exported at this volume. The Monitor fader (view page 36) can be used to set the 
playback volume for editing. 

Peak meter display 
The display beside the master fader is a peak meter and shows the peak level of the 
audio in the track during playback. For stereo tracks the the left bar shows the level of 
the left channel and the right bar shows the level of the right channel. Both bars react 
together for mono tracks. 
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Stereo 

 

If the stereo button is activated, the waveform display of 
the audio material for both stereo channels will be 
displayed separately. 

This view is useful to visually monitor processing of the material in the stereo 
panorama, or to locate precise crossover points during editing operations. 

Volume curve 

 

Use the "Volume" button to activate a volume curve (view 
page 59). 

 

Spectral 

 

In addition to the waveform display, this button allows a 
spectral display (view page 152) of the audio material to be 
shown as well. 

At the same time the mouse mode „Edit spectrum directly” (view page 147) is set. By 
using this mode you can mark noises directly in the spectral display and filter it out. 
See for more information on mouse modes in the Options menu chapter (view page 
146). 

Hint: You can activate the Spectral display separately by using the according menu 
option in the View menu. 

Note: The spectral functions are not available in MAGIX Audio Cleaning Lab. 

Number of tracks 
Use the "Number of tracks" button to create a second or three 
additional stereo tracks, e.g. if you want to mix several audio 
sources (narration, music and sound effects) or to "park" a 
song on the additional tracks for the meantime. 

Additional track provide a better overview when there are multiple objects in play. All 
objects can be moved randomly between the tracks. If moved between tracks while 
holding the "Shift" key, the horizontal position will be retained, i.e. only the track is 
changed. Materials which are placed over one another will be played back 
simultaneously  and burned on CD as well. If this is desired, then the volume level at 
this position should be monitored, since objects which are playing back 
simultaneously add to the overall volume. 

Note: The second track is not available MAGIX Audio Cleaning Lab. 
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Ripple 

 

This button controls the behavior of subsequent objects when 
objects are deleted and moved (view page 57). 

 

Range Mode 

 

This button switches to the Range Mode (view page 58) for 
audio editing. 

Note: The Range Mode is not available in MAGIX Audio 
Cleaning Lab.   

Limiter 

 

The limiter can be switched on to reduce clipping. This 
device works sound-neutrally and provides a final guard 
against extreme levels. 

 

Bypass 

 

You can use this button to turn all effects on or off to compare 
the edited material with the original. 

 

Buttons under the track window 
Split 

A selected object is split into two objects at the position line. This also works 
during playback. 

Keyboard shortcut:  T 
 

Delete 
The currently selected object will then be deleted from current project. The 
subsequent objects are moved forward so that there is no gap in the track.  

Keyboard shortcut:  Del 
 

Copy 

 

The selected object is copied from the project into the clipboard. It can then 
be re-inserted elsewhere. 

Keyboard shortcut:  C 
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Paste 
The content of the clipboard is inserted into the project at the position line.  

Keyboard shortcut:  Ctrl + V 
 

Markers 

 

Opens a menu with different functions to set track markers (view page 141) 
automatically.  

 

Undo 

 

In the project you can undo the last changes you made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
you can always revert to the previous state using "Undo". 

Keyboard shortcut:  Ctrl + Z 
 

Redo 

 

The “Redo” function undoes the previous “Undo” function. 

Keyboard shortcut:  Shift + Y 
 

Transport console 
The transport console determines the playback position in the project. The current 
playback position is indicated by the position line, a thin vertical line in the track 
window. Use the transport console to start and stop playback, move forward and 
backward within the project and set the playback position back to the very beginning. 

 

 

Return to start: Resets the position line to the start of the project 
(also works during playback). 

 

Next Track/Previous Track: Sets the playback position at the next 
or previous track marker. 

 

Stop: Stops playback, the position line jumps back to the starting 
position 
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Play: Starts playback; clicking again stops playback at the current 
playback position. 

 

Record: Begins recording. Right-clicking opens the settings dialog 
for recording where you can define the recording format, level and 
other. 

 

Loop: Display and control for playback in a loop (see Loop Playback 
(view page 35) 

Controlling with the computer keyboard and mouse: 

• The space bar starts or stops playback. 
• Clicking on the timeline above the track moves the position line to the 

corresponding position (also works during playback). 
• Other special keyboard commands can be used to jump between markers and 

object edges quickly (see Zoom settings (view page 29)). 

Loop playback 
During loop playback, a range of the project is played back in a repeating loop. This 
function is useful if you want to listen to parts of the audio repeatedly, e.g. to optimize 
transitions or effect settings in critical sections. 

The loop range can be dragged out in the timeline using the mouse. The loop button 
lights up to indicate that a loop is activated. Now when you start playback using the 
spacebar, the loop range will be played back. 

 

Tip: The borders of the loop range can be adjusted during playback. 
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If no range has been defined and you click on the loop button, a default range of two 
seconds will be set.  

Scrubbing slider 

Note: This function is not available in <Program name_classic>. 

Scrubbing refers to "searching" through the audio material at different speeds to 
locate a certain position "acoustically".  

In this case, MAGIX Audio Cleaning Lab behaves like the editing function of a tape 
player. The motor is switched off, but the tape remains at the sound head. Turning the 
tape reels by hand can slowly move the tape past the sound head to make it easier to 
find specific positions on the tape. 

By varying the playback speed, it's possible to quickly approach a position, but also to 
arrive at the exact position at a reduced speed. 

 

You can use the Scrubbing slider to control the playback 
with variable playback speed. The further you drag the 
slider to the right or to the left, the quicker the project is 
played forward or rewound. 

 

Time display 
The time display shows the playback position in the project. The measurement unit is 
the same as in the timeline and can be adjusted in the Options menu.  

Monitor fader 

 

The monitor fader controls the monitoring volume during playback. In contrast to the 
master fader (view page 31) it does not influence the volume of exported files or 
songs burned to CDs. Instead, it acts as a practical extension of the volume control on 
the sound card or on the computer speakers. 

Attention: The monitor fader works in addition to the volume control on the sound 
card mixer. This means that if the volume is set to 0 on the sound card, the monitor 
fader will have no effect. 
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Info area 
The info area at bottom right can be switched between three different views: 

 
InfoBox. The InfoBox provides 
information on how to use the selected 
effect.  

 
Analyzer. The analyzer displays the 
audio material graphically. 

Video monitor (not in MAGIX Audio 
Cleaning Lab). The video monitor 
shows previews of videos (view page 
124). 

 

 
This can be completely hidden using the arrow to the right of the monitor. 

 

Info Box 
The Info Box offers fast and immediate help when working with MAGIX Audio 
Cleaning Lab. You can open it with the arrow button on the right side of the Cleaning 
and Mastering section. Click on an effect to get information about its range of 
application, functionality, correct handling and possible sources of error. 

Clicking on an object displays the applied Object effects (view page 72), if available. 
The Info Box also offers useful tips for other program areas. 
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Analyzer 
The analyzer provides a graphical display of the played back audio material. Here you 
can choose from the following display options: 

Peak meter 

Vectorscope 

Spectroscope 

Spectrogram 

Bit meter 

Correlation gauge 

Direction meter 

Peak meter + 
spectroscope combined 

Peak meter + 
spectrogram combined 

Note: Views 5-9 are not available in MAGIX Audio Cleaning Lab. 

Click on one of the graphics to select the appropriate display mode. 

 
Use this button to select the display mode. 

You can also change the display mode directly by right-clicking in the monitor 
window; Here there are also different presets under "Presets". 

Peak meter: Display of the peak level and the RMS value (average loudness, for more 
about this, see also Loudness normalization). 

Vectorscope (phase oscilloscope): The vectorscope gives you information on the 
distribution of the stereo image in your recording. The signal of the left channel is 
depicted above the left axis, that of the right channel above the right axis. A mono 
signal is depicted as a vertical dash in this display; the more the signals of the two 
channels in a stereo signal differ, the wider the displayed "cloud". Please note that a 



 

40   

www.magix.com 

broadening of the display implies more deletions, and in turn that the signal is not as 
mono compatible. 

Spectroscope: In the spectroscope the signal is divided into individual frequency 
ranges (frequency bands). The level amplitude of each frequency band displays 
volume of the relevant frequency range. This is a way of telling whether certain 
frequency bands are being strained. 

Spectrogram: In the spectrogram, the signal is specified as frequencies against time. 
The volume of frequencies is visualized by its brightness. 

Bit meter: The bit meter shows you the bit rate at which the played signal is 
calculated and the maximum editing rate which is possible. 

Correlation meter: The correlation meter can be used to read the phase shifts 
between the two stereo channels and thus the degree of erasure. If the signal display 
is in the left, red area between 90° and 180°, the mono signal is no longer played back 
perfectly. 

Direction meter: The direction meter indicates the location direction of the signal. The 
width corresponds to the degree of correlation. 

Video Monitor 
The video monitor displays a 
preview of the loaded video. 
The playback position in the 
project corresponds to the 
position in the video. The 
video monitor, therefore, 
serves as a kind of 
orientation help so you can 
see where in the video you 
are currently working.  

Detach video window: 
Double click on the "Video" 
tab to make the video 
window floating. This means, 
you can then move it around 
and resize it. 
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Note: The function „Load video sound” is not available in MAGIX Audio Cleaning 
Lab. 

Changing the size of sections in the program 
interface 
The program interface of MAGIX Audio Cleaning Lab automatically tries to optimize 
the use of the available space on screen, depending on the screen resolution. 

 

By dragging the horizontal border between the lower and the upper area (audio track 
and effects) or dragging the horizontal border between the lower area and the info 
area you can adapt this screen spacing to your needs. The space distribution will be 
saved when you close the program. 

With the keyboard shortcuts F5 (upper area), F6 (lower area) and F7 (info area) you 
can maximize the according screen area. 

 

Upper area maximized Lower area maximized Info area maximized 
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Import 

 

In this section audio material is imported into MAGIX Audio Cleaning Lab. You can 
load audio files ("Files"), import tracks from audio CD ("CD") or record audio material 
("Record", "Cassette", "Language", "Digital", "Web radio"). 

Files 
In the "Files" view you can import audio files from the hard drive or connected data 
storage devices into MAGIX Audio Cleaning Lab. This feature works in much the 
same way as Windows Explorer. 

 

 File list: Here all of the files in a folder that are supported by MAGIX Audio 
Cleaning Lab are displayed in a list. They can be selected by clicking on them. 
Just like with Windows Explorer you can extend your selection with "Ctrl" + click 
and select a series of files with "Shift + click". 

 One click on the file properties (name, type, size, date) in the table header sorts 
the files according the corresponding property. 

 Go one layer up 

 The file path of the displayed folder 

 Shortcuts for predefined folders 

 Import: This button can be used to import the selected files. 
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The selected file is added to the project at the position 2 seconds after the last object. 
This value can be changed in the CD/DVD menu with the option Set automatic 
pauses (view page 142). If you have tracks which blend over one another and are 
distributed on several files, you should change this value to "0". 

CD 
With CD you can import music from a CD into the program. You can import entire 
Audio CDs or individual CD tracks into the project. Unlike data CDs, audio CDs 
require special treatment while importing ("grabbing" or "ripping"). The data is 
imported digitally which eliminates any loss in sound quality. 

 

 Track list: Tracks can be selected for import by checking the box in front of 
them. The box at the very top selects all the tracks. 

 freedb: Request for track information from the freedb Online CD Database (view 
page 143)  

 Here the parameters for the import are displayed, e.g. the CD drive name, the file 
format, the storage location and the file name. In the default setting the CD 
content is imported as a wave file into the  project folder (see Path settings 
(view page 151)) 

 Settings: To select a different CD drive, file format or storage location you can 
open the advanced settings dialog (view page 43) here. Changes made here will 
be applied to all subsequent imports. 

 Import: The audio material is copied from the drive onto the hard disk. A 
progress bar is displayed. 

When this process is finished, the tracks are added to the project as individual objects 
with corresponding track markers. 
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CD Import Settings 
In this dialog you can adjust the settings for CD import, e.g. to change the save 
location or the file format. 

In the upper part of the dialog you'll find a file explorer which you can use to set a new 
name or target folder for the audio file. Under „Last storage location” you can choose 
from a list of save locations that are already being used.  

Reading speed: The default setting is „Maximum”, i.e. as fast as the drive allows. 
However, if reading errors occur, you can reduce the speed here.  

CD drive options: Here you can change the settings and select the drive for importing 
the CD if you have installed several CD drives. 

File options: Here you can determine whether all of the CD tracks will be imported as 
a single file or each track as a separate file. In the case of separate files you can select 
from various file name schemes in the list field. 

Import: This closes the settings dialog and starts the import process. The changes to 
the settings will be applied to any subsequent imports. 

LP/Cassette/Voice recording 
In these views music or speech from an analog source can be recorded. 

Note: All three views are identical to use, only the settings of the automatic track 
marker detection on the medium that is used are different; for cassettes, there is the 
additional High Speed Dubbing (view page 50) option. 

To record from analog sources, proceed as follows: 
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1. Connect the recording source now if you haven't already done so. 
2. Switch to the corresponding import view (in this example "LP") and play back 

the audio from the source to set the level. It is best to use a loud section for this. 
3. Adjusting the recording level is essential when recording digitally via sound 

cards in order to achieve optimum sound quality. The peak control can be 
checked using the "Recording level" LED chain (1). They should not move 
beyond the "safe" area. If the level moves into the "too loud" or "too quiet" areas, 
correct it with the yellow level fader (2). But be careful. If you lower the input 
level, you also lower the precision of the resolution with which the analog signal 
is digitized. For this reason, the fader should also be set as loud as possible. 

4. Now check the threshold values for automatic CD track recognition. To do this, 
play back one song until the end and into the pause. The level must fall under 
the green zone (3) so that the next song will be recognized. Correct the 
threshold value if necessary. 

5. The recording function in the import section is reduced to only the most 
important features. For recordings in other file formats and various other 
options, open the Recording settings (view page 46) dialog under "Settings..." 
(4). 

6. You can start the actual recording with the large red record button (5). The 
duration of the recording and the remaining storage capacity is displayed on the 
right (6). You can monitor the recording level on the LED display during 
recording. If the display reaches the upper LEDs, clipping occurred at some 
point. In this case, you should definitely check the recording for clipping and, if 
necessary, repeat the recording using a lower recording level. 

7. If you do not hear your source although it is correctly connected and also the 
peak meters deflect, you can activate the "Monitor" (7) button. Internal 
monitoring is realized in this way. (For more information on the subject of 
Monitoring while recording (view page 49), see below).   

8. At the end of the recording  you will be asked if you want to use the recording. 
The newly-recorded material will be placed at the current position of the 
playback marker in the project. 

Note: If there is no level displayed, chances are the wrong input has been selected. 
Open the record settings dialog using the "Settings..." button and click on "Audio 
line-in" to correct the error with Automatic input and level (view page 49). 

Basic knowledge about recording with the PC 
The record function converts analog audio signals – records, tapes, sounds, speech – 
into digital data, which can be saved on the PC and edited with MAGIX Audio 
Cleaning Lab.  

The device which is used to digitalize the audio signals is already built into most 
sound cards and aptly called an analog-digital converter, often abbreviated with 
A-to-D, ATD or A/D. In order to record sounds, the A/D converter takes samples of 
the sound to be digitalized at fixed intervals by measuring the voltage level of the 
signal. The frequency of the sampling is called the sample rate and naturally lies 
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within the kHz frequency range; several thousand times per second. The higher the 
sample rate, the more samples are recorded by the A/D converter, thus making the 
sound conversion closer to the original.  

The precision with which the A/D converter measures the voltage level of the analog 
signal is determined by the sample resolution. The same principle applies here: The 
finer the resolution, the better and more natural the digital conversion.  

Audio recordings in CD quality are recorded with a sample rate of 44.1 kHz and a 
resolution of 16 bits. 

About the term "sound card" 
When the first version of MAGIX Audio Cleaning Lab, the MAGIX cleaning lab was 
released in 2001, having audio functionality integrated on the computer mainboard 
was rather new and not the default option, and the sound quality of these 
on-board-sound devices was really bad. For a decent recording an additional 
expansion card, from specialized vendors, was obligatory: the so-called "sound card". 

Today every PC is equipped with audio inputs and outputs by default, nevertheless we 
continue to talk about sound cards for simplicity. And even though the sound quality 
of these built-in devices was improved over the years, to obtain a really good 
recording quality we would still recommend the use of a dedicated "sound card" 
(which is nowadays mostly an external USB device) from a music shop. 

Connecting the recording sources 
First, the recording source must be connected to the computer. There are several 
possibilities depending on the equipment you are using: 

• If you would like to import music from a stereo system, use your sound card's 
line-in input. If the stereo system amplifier comes with separate line-out or AUX 
out connectors, they should be used. In this case, they have to be connected to 
the computer's line-in. Hi-Fi amplifiers usually have RCA (composite) 
connectors and the computer has mini stereo connectors. You need to then get 
a suitable cable with two small RCA (composite) connectors and a mini stereo 
jack. 

• If the amplifier comes without separate outputs (other than the speaker 
connectors), you can also use the headphone jack for recording. Normally, you 
will require a cable with stereo or mini stereo jacks. This type of connection has 
the advantage of a separate volume control to set the headphone input signal 
level. However, headphone jacks are often not very high-quality. For this reason, 
you should use line-out outputs whenever possible. 

• To record cassettes from a tape deck, connect the tape deck’s line-outs directly 
to the computer's line-in. 

• When recording LPs, the record player's outputs should not be connected 
directly to the computer because the phono signal has to be pre-amplified. In 
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this case, connecting through the headphone jack or an external preamp is 
recommended. Some record players also have normal line-out connections. 

• If you would like to make recordings with a microphone, connect it to the 
computer using the microphone input (usually a red jack). 

Recording settings 

 

Audio input: Opens the input and level automation (view page 49) for automatic 
selection of the correct input signal and level. 

Recording level: Displays the recording level; corresponds to the peak meter in the 
main window (see above (view page 43)) .  

Record: This button starts the actual recording. During recording, the recording time 
and remaining space on your hard disk are indicated.  

Record pause: Pauses the recording. Click the "Pause" button again to resume. 

Stop: This button ends recording.  
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Markers 

Automatic recording stop: If this button is activated, recording will cease 
automatically after approx. 16 seconds of silence. This lets you make long recordings 
without having to worry about stopping it once the recording is finished, e.g. recording 
an entire LP or cassette.  

Automatic CD track recognition: If this button is activated, then track markers are 
automatically placed at the end of the pauses after a track. In order for pause 
recognition to function seamlessly, you will have to set the proper source in the 
selection box (LP, cassette, CD, or Internet). You can specify the detection 
parameters even further using theAutomatic track marker recognition options (view 
page 150)in the Options menu. 

Save automatically in individual files: If this feature is active, then every individual 
track that is recognized will be saved as a unique file. 

Set CD track marker: Even during recording, you can set track markers by clicking the 
corresponding button in the recording dialog. 

Start new file: If you want to record very long sessions or multiple sources one after 
the other, the recording file can become extremely large. This button will create a new 
sequentially numbered file. 

Recording format: 

In the front list field (preset is "Wave") you can change the file format giving you the 
option of recording directly in compressed formats such as MP3 or OGG VORBIS. 
You can set details such as the bit rate and compression method for each format in 
the "Format options". 

Resolution/Sample rate: Here you can set the sample rate and bit resolution for the 
recorded audio file as well as define whether it will be recorded in mono or stereo. 
24-bit recording (view page 50) requires a high-quality audio card with 20 or 24-bit 
conversion, plus a 24-bit capable MME driver. Audio cards with SPDIF digital 
interfaces can also record audio material in 24-bit quality. 

Note: MAGIX Audio Cleaning Lab always records in 16-bit resolution with a 
maximum sample rate of 44.1 kHz.  

High-Speed Dubbing: Activates the Recording at double speed (view page 50) 
function. 

Audio input 

Audio input: The button "Sound card settings" opens a dialog with special settings 
(view page 48) for whatever sound card is present. The name of the selected sound 
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card is also displayed. If you are using several sound cards (or such with several 
inputs), then you can select one from the menu.  

Timer: Enter a starting time for a recording and the length of the recording. The 
recording won't begin immediately after pressing the "Record" button, but rather at 
the specified time. This way, time-delayed recordings (for example, at night or when 
you're out) are now possible. Of course, the system clock has to be set correctly. If 
"Record length" is also activated, then the recording will end automatically after the 
indicated period. 

File name/file path: The name of the audio file to be created and the preset folder are 
displayed in the recording window. Both can be changed by clicking the folder button. 

Shut down computer automatically after recording: If you are working with timer 
recordings, you might as well have the computer shut down automatically after the 
recording is complete. 

Advanced/Simple...: The settings dialog can be "folded up" so that only the peak 
meter and control elements are visible. 

Help: Opens the program's help file for the recording dialog. 

Close: Closes the recording dialog. 

Keyboard shortcut: R 

Record properties 
This dialog provides you with information regarding the currently selected sound card. 
Supported audio formats of the sound card and the sound card driver's information is 
also displayed. 

Driver system: Here you can switch between driver types (MME and WDM).  

Note: Adjust this setting only if you have problems with audio playback or recording. 

Special: Some sound cards or audio devices (for example, USB turntables) do not 
offer mixer support. With the "Monitor input signal" option you can listen to the 
sound during recording (monitoring).  

"Filter DC offset" allows you to remove the DC offset section (view page 73) of the 
input signal, even during recording. 
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Monitor while recording 
Monitoring while recording (referred to as 'Monitoring') can take place in two 
different ways, either directly inside the sound card or provided by MAGIX Audio 
Cleaning Lab ("Monitor" button). 

Most sound cards, including those integrated in the computer ("Onboard sound"), 
provide support for the Windows sound card mixer. Within the mixer there is also a 
signal path that passes an input signal directly to the sound card output.  

To activate monitoring using the sound card mixer: 

1. Open the "Control Panel" > "Sound" and switch to the "Record" tab, or 
right-click on the loudspeaker symbol in the right lower corner of the screen and 
select "Recording device" from the context menu 

2. Double-click the required recording device. If your source is connected and 
playing, the device can be recognized from the appropriate peak on the peak 
meter. 

3. Switch to the "Listen" tab and activate the "Use this device as playback source" 
checkbox. 

4. If you now click "Accept", you should hear their input signal. 

Some sound cards or audio equipment, such as USB record players, lack this 
possibility for monitoring. 

 
For this reason, the "Monitor" button appears in the Import 
section of all areas. 

If it is activated, MAGIX Audio Cleaning Lab passes the input signal to the output. 

Attention: If the monitoring sounds hollow and strange or you hear echos, probably 
both ways of monitoring are active and are interfering with each other. In this case, 
either deactivate the "Monitor" button or "Listen" in the sound card driver. 

Input and level automation 
Every sound card has a least two inputs (microphone and line), as well as various 
"internal" inputs for the CD drive or the signal from another program, for example, 
Internet radio. With input and level automation you can automatically select the 
correct input for your recording without having to search and adjust the input level in 
order to avoid distortions. 

To do so, click on "Audio input" in the record dialog. If you had already connected 
your source and begun playback, the correct input will be determined immediately. 
Otherwise do this now and click on "Search channel again". 
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If this didn't work, use the "Windows mixer" button to open the Windows Mixer and 
select the channel manually. 

Adjusting the recording level is essential when recording digitally via sound cards in 
order to achieve optimum sound quality. If the adjustment is set too high, distortion 
occurs and the incoming signal must be reduced. If you reduce input sensitivity, the 
resolution at which the analog signal is digitized is also reduced. The level controllers 
of your sound card should generally be set as high as possible in order to achieve 
optimum results. Yardstick for an optimal level is the loudest part of the material. The 
loudest part should be adjusted to the maximum. You can now adjust the recording 
level with the help of the LED display in the record dialog. 

You can adjust the level of the source manually using the "Volume" controller. If you 
activated "Automatic level adjustment", the level controller will automatically be set 
to the correct value.  

High Speed Dubbing 
Some double cassette decks have a "High Speed" copy function. On one deck a 
cassette will be played at double speed and on the other recorded at double speed. 
Doubling the speed cancels itself out so you will end up with a completely normal 
cassette recording. Thereby making it possible to copy cassettes in half the time. 

With the "High Speed Dubbing" option you can also use this function with MAGIX 
Audio Cleaning Lab. If it's activated and you record played audio material at double 
speed, after recording the speed of the recorded material will be automatically halved 
in order to end up with the original speed. 

Note: Since, with a cassette deck, it cannot be assumed that exactly double the 
speed is used for high speed dubbing, it's best to compare the tempo of the 
recording with the original and to correct it with Resampling/Timestretch mouse 
mode (view page 147) if necessary. 

24-bit Audio Support 

Note: 24-bit recording is not available in MAGIX Audio Cleaning Lab.  

Not only can audio data be recorded in MAGIX Audio & Music Lab Premium in 16-bit 
CD quality, but also in higher-quality 24-bit resolution. You can select this 24-bit 
resolution audio format in the recording dialog. 24-bit recording requires a 
high-quality audio card with 20 or 24-bit conversion, plus a 24-bit capable MME 
driver. Audio cards with SPDIF digital interfaces can also record audio material in 
24-bit quality. 
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The high-resolution audio data are saved and edited by MAGIX Audio & Music Lab 
Premium in 32-bit floating point data format. This ensures full 24-bit quality 
regardless of the level. The dynamics increase to more than 140 dB, the 
signal-to-noise ratio of the recordings drops to 110 dB and more depending on the 
sound card. Thanks to Floating Point Processing there is no need to worry about 
clipping during internal processing. A Floating Point Signal only begins to clip at 
approximately 1500 dB above 0 whereas a 16-bit signal clips as soon as 0 dB is 
exceeded. 

Even if the audio material is to be burned on a 16-bit audio CD in effect, it pays to use 
a 24-bit audio resolution for the recording because all effect calculations also then run 
with a higher quality and do not generate any rounding errors in the audible 16-bit 
range. 

Compared with 16-bit recordings, 24-bit recordings take up double the memory on 
the hard drive (by saving them as 32-bit float data), but considering the capacity of 
modern hard drives this is a good compromise for the increase in quality. 

High-resolution audio data can be imported and exported as 24-bit WAV files so that 
the data exchange with other high-quality audio systems – e.g. MAGIX Samplitude – 
is not a problem. 

Digital 
The "Digital" view is used for recording digital sources. This can be the digital input of 
the sound card, for example, but also the output of other programs on the computer. 
Operation is analog to the other views. The option for automatically setting the track 
markers is adjusted accordingly. 

Record output 

 

The "Record output" option allows you to use the current output of the computer as a 
digital recording source.  

Note: Many sound cards also offer the entire sound output for selection as a 
recording device, often under the title of "Stereo mix" or "What You Hear". This also 
works, but the result of such a recording is not really a digital recording. Technically, 
the analog output signal is simply fed back here to the analog input, i.e. on the sound 
card, that is to say a double conversion takes place - from digital to analog and back. 

"Record output" is used to carry out a genuine digital recording, i.e. exactly those 
digital data are saved that the playback software (e.g. the player in the browser) 
provides to the sound card driver. 
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This function uses the WASAPI driver model in "Shared" mode for the sound card, 
which means one set of audio equipment can be used by several programs at the 
same time. Here, however, it is a condition that all programs must work with the same 
sample rate (view page 44). Some sound cards (especially many onboard sound 
cards) are preset with a sample rate of 48 kHz for system playback. In this case a 
warning message appears and Audio & Music Lab automatically adapts the sample 
rate of the recorded material. In this case, for optimum sound quality, however, we 
recommend changing the sample rate used in Audio & Music Lab to 48 kHz prior to 
recording in the Options menu > Playback parameters (view page 149) dialog. 

Typical use 
Recording a copy-protected audio CD: According to the copyright act, it is forbidden 
to copy a CD with or without copy protection. However, an owner of a CD may create 
a backup copy for himself  - even if it's a copy-protected CD. The problem with 
copy-protected CDs is that they cannot be imported using conventional PC drives. To 
create a backup of such a copy-protected CD, you can play it in the CD drive as an 
audio CD and use the "Record output" option. 

Record Internet Stream: Many Internet contents are only available as "streaming 
media" and can, in fact, be played but not downloaded for listening to them later 
offline. With the "Recording output" option you can record such streams, thus 
safeguarding them for posterity. 

Note: It is possible that this function will be prevented by the appropriate player 
software for copyright reasons. In this case, you can only use the above-mentioned 
analog recording of the output signal via the "stereo mix" recording source. 

Web radio 
Note: This function is not available in <Program name_classic>. 
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In this view you can play back web radio while also recording it at the same time. 

 

 List of stations: All of the available stations are listed here. At the top level there 
is a series of folders where the stations are classified according to musical style as 
well as geographically. Double-click a folder in order to change to it. 

 Current folder: The current folder is displayed at top left. You can move up a level 
using the arrow. 

 Playback: A click on the Play symbol starts (after a short loading time) the 
playback of the station. 

 Add to favorites: Select your favorite station with an asterisk. 

 Current track: The track just played is displayed here. (Not all web radio stations 
make this information available.) 

 Favorites: Use this button to switch to the Favorites folder. All stations with an 
asterisk are listed here. 

 Add station: If you know the URL of a web radio, you can use this button to add 
other stations. Even entered stations automatically end up in the Favorites folder. 
To remove them again, simply click on the asterisk. 

 Refresh list: A click on this button loads an updated list of stations from the 
MAGIX server. 

 Record: The current web radio playback is recorded. 
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Cutting and arranging objects 
This chapter is about working with objects and track markers. Descriptions of the 
individual control elements can be found further on in the „Track window“ (view page 
26) chapter. 

What are objects? 
Objects provide a waveform display of audio material. The starting point of an object 
is assigned to an audio file. The length of the object determines the length of the part 
of the audio file. This means that an object does not actually contain the audio 
material and is only a set of instructions for audio playback. When objects are edited 
(transitions, volume adjustments, cuts (view page 57)) more instructions are defined 
that are applied in realtime during playback. The actual audio file is not changed 
("non-destructive editing") but the adjustments to the settings are saved 
permanently. 

As objects contain simple playback instructions and only reference audio material, 
they can be easily moved to any position within the track window, or deleted without 
changing the audio file. 

Project 
The project (*.vip file) contains all the data from MAGIX Audio Cleaning Lab. It does 
not contain audio data but only the names of the imported and recorded audio data 
and the saved locations on the hard drive, the data for the contained objects and most 
of the effects processing. To keep things simple the object display on the tracks is 
subsequently referred to as a project. 

Adjust object volume 

 

The handle at the top center can be used to adjust the volume of the objects. This 
handle is particularly important for synchronizing the volume of songs originating 
from different sources. The volume of audio CDs may also differ. 
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Fading objects in and out 

 

At the top corners of every object there are two fade handles that can be adjusted to 
fade an object in or out. It is particularly useful to use the fade handles to avoid hard 
transitions or crackling when you have cut passages out of a recording. 

 
Click on this symbol to change the fade curve. 

 

Linear Fade Exponential Fade Logarithmic Fade 

 

Fading objects 
With every cut the two objects that are created are slightly crossfaded in order to 
avoid crackling. This is called Auto crossfade. A crossfade is also added if two objects 
in a track are moved into each other or overlap each other. 
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The top handle of the right object allows you to regulate the fading in and out of both 
objects.  

The bottom handle controls the length of the two objects. If you move them, one of 
them is extended whereas the other is shortened. The length of both objects together 
remains the same. 

 
A crossfade symbol is added to each crossfade. By clicking on the symbol, you 
can change the curve of the transition like with the simple object's fade in and 
out. 

 

"No crossfade" deactivates the crossfade. The front object is cut by the back object: if 
the playback reaches the back object, the front object is muted immediately (not 
fades out). However, the fade in of the back object is still active. 

Reducing and increasing the length of objects 

 

Objects can be shortened by dragging the lower right corner to the left. During this 
process the mouse pointer turns into a double arrow. This can be used to shorten 
songs or recordings without having to cut them. To make the object longer again, 
simply drag the handle to the right. (When you can't move it any further, the full 
original length has been reached). 

An object can be shortened from the start in the same way, e.g. if too much silence 
has been recording before the actual audio begins. To do this, simply use the handle in 
the lower left corner. If too much audio material was removed, you can restore it by 
moving the object border back in the other direction. 
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Splitting objects 
To remove unneeded audio material (e.g. from recordings) you can split an object into 
several smaller objects and delete the ones you don't want. 

This can be done with the function „Split objects”. Set the position line by 
clicking on the timeline at the position in the waveform where the object 
should be split. Now click on this button or press the T key to split the 
object. 

The unwanted objects can then be deleted using the delete button. The 
subsequent objects will then move to fill the gaps. (This behavior can also 
be deactivated; for more about this see below).  

If you split an object, a short transition (view page 55) ("Crossfade") is created 
automatically at the position of the cut to avoid crackling being caused by the cut. 

To find the best positions for object cuts we recommend working with a zoomed 
waveform display. There are various options for adjusting the display size in the Zoom 
(view page 29) section. 

Tip: Use the commands "Remove object beginning" or "Remove object end" (keys D 
and U) in the "Edit" menu to remove unnecessary beginnings and ends of 
recordings. 

Object effects 
Splitting objects also has another application: All effects are also available as object 
effects (view page 72) and can be additionally added. This means you can remove 
noise from the entire project or a humming sound that only occurs at one point in a 
specific object. 

Deleting and moving objects 
To delete an object select the object and click on the delete button (or press the Del 
key). No gap will be created in the project, i. e. the subsequent objects are moved.  If 
you move an object, all subsequent objects will be moved along in unison 
automatically so that no gaps appear. 

 

The "Ripple" button at the top right can be used to change this 
behavior. 

The button has 3 modes that can be set by clicking them one by one: 
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Ripple objects When objects are deleted or moved, subsequent objects are 
moved in unison. 

 

Move objects freely When objects are deleted or moved, subsequent objects 
are not moved in unison.  

 

Lock objects The objects (view page 54) are generally locked and cannot be 
moved. 

This option is important for video editing to prevent the audio track of the video from 
being moved out of sync with the images. (The audio comes too early or too late). 
This mode is automatically activated when videos are loaded. 

This option is not available in MAGIX Audio Cleaning Lab.  

Range Mode 
The Range Mode is a different method to cut and edit audio material on the track.   

 

To activate the range mode, click this button to the right of the 
track view. 

 

The mouse pointer changes to the range selection symbol when you move the 
mouse over the audio material.  

When you drag the mouse over an object you won't move the object but select a 
range over the audio.. 

 

You can change the range selection by dragging the green brackets on the timeline over of the 
wave form. 

The edit menu commands "Split", "Cut", "Copy", "Paste" and "Delete" and the buttons 
below the track view no longer apply to a selected object but to a selected range of 
audio. 
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This makes working on audio faster if there are many cuts necessary. The work flow 
as shown in Remove unwanted sections (view page 20) in the tutorial chapter, for 
instance, is now shortened to just selecting the unwanted noise and clicking the 
delete button. 

Note: The Range Mode is not available in MAGIX Audio Cleaning Lab.  

Draw volume curves 

 

Use the Volume button to activate a volume curve. 

You can use it to add volume curves to your audio material, for instance, for 
compensating volume fluctuations or increasing the volume of quiet passages. 

The waveform display adjusts to the curve, giving you visual aid to help work out how 
much you need to raise specific sections.  

 

On the left side you can see that a section in the audio material is quieter than the rest, on the 
right this is corrected using a volume curve. 

There are two ways to edit these volume curves: Create a "handle" by clicking on the 
curve. This can be moved using the mouse to create volume progressions. This 
method should be used if gradual volume changes over longer passages are needed. 

Alternatively you can use the Volume Draw mouse mode (view page 146). This 
allows you to "draw" any volume curve using the mouse. This way, you can create 
irregular volume progressions quickly. This mouse mode can be found in the 
"Options" menu. 

Note: Sometimes increasing the volume isn't enough even though the curve is at the 
top end of the object. You then need to zoom out of the track vertically (e.g. Shift + 
Mouse wheel), which will create more space above allowing you to drag the handle 
to the necessary height. 

Tip: The voice over effect (view page 130) creates volume curves for automatic 
fading in/out based on the audio material in the second track. 
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Set track marker 
Recording the entire side of an LP most often involves several songs one after the 
other. If the record is going to be burned to CD, track markers must be used to define 
the beginning of each song. Otherwise the whole side of the LP will appear on the CD 
as a single track. Even when the project is being exported as an MP3, MAGIX Audio 
Cleaning Lab still has to know where each MP3 starts.  

MAGIX Audio Cleaning Lab is preset to divide audio material into CD tracks 
automatically directly after recording (view page 46). Track markers can also be set 
"by hand" in the recording dialog while the recording is in progress.  

Another option is to set the track markers directly in the track view:  

To do this simply set the position line at the beginning of a new song and 
click on the button. (or you can press the m key on your keyboard or select 
"Set track marker" in the CD menu). 

The new track marker will appear over the position line in the timeline. 

Automatic track recognition - How it works 
The process goes like this: MAGIX Audio Cleaning Lab searches for points where a 
new track starts, i.e. the end of a pause. Pauses are normally 0.5 - 3 seconds long. 

The second step checks to make sure the interval between the pauses is long enough. 
For example, it is very improbable that a recording of the Top Ten hits will contain 
pauses a minute long. If this sort of thing is detected, the marker for the second pause 
is removed. 

The third step examines the start and end of the audio material more precisely. 
Records always feature a loud bump when the needle is placed on the record and 
another one when it is removed from the record at the end of the recording. MAGIX 
Audio Cleaning Lab attempts to recognize these noises and to exclude them, i.e. 
object edges are automatically moved inwards to match the start and end of the 
actual music. 

There are sensible presets for thresholds and times in the track marker automation 
which depend on the selected recording source (records, cassettes, CDs/DVDs, 
Internet). If these don't work properly, you can change them in the Track marker 
recognition options (view page 150) dialog ("Options" menu). 

Sometimes it is helpful to place the first one or two markers manually and to separate 
the objects using the "T" key, especially if the volume levels are very different. MAGIX 
Audio Cleaning Lab will examine the objects individually. 
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MAGIX Audio Cleaning Lab cannot recognize the correct track markers in every case 
(e. g. during live recordings or with classical music).  If you've tried using a number 
of different settings and still aren't satisfied with the results, you can set the track 
markers manually (see above). 

Check and move track markers 
Before burning the audio material to CD, it is best to check and make sure that the 
track markers are in the right places. To do so, the "Tracks (view page 109)" section 
offers an easy-to-read list with all track markers and names. Use the ID3 Editor (view 
page 110) for detailed editing. 

To adjust the track markers directly in the track window, move the position line using 
the skip button on the transport console (or Alt + Arrow keys) from marker to marker 
and play back the audio material from that point. If the marker is unnecessary or 
incorrectly positioned, you can click on it and delete it or move it using the mouse 
button. 

Change song order 
Sometimes it is necessary to change the song order. The easiest way to do this is 
when you have already assigned track markers. Then you can resort the tracks in the 
section Tracks (view page 109) in the ID3 Editor (view page 110) (Marker/Positions 
tab). In this case objects may be split automatically.  

Note: When using multiple tracks (not in MAGIX Audio Cleaning Lab) all the 
objects on all tracks that are between two track markers are moved together.  

Use also the feature of placing the track markers automatically ("Automatic" button 
in the "Tracks" section or keyboard shortcut Ctrl + M). 

Hint: For a quick sorting directly in the track, you can drag a track marker ahead of or 
behind another track marker. This will regroup the corresponding objects in the 
track. 

In MAGIX Audio & Music Lab Premium there is also a different method: to split the 
material into separate objects and arrange them as you like, you could also use the 
additional track (view page 152)s as a clipboard for the objects. 

Note: MAGIX Audio Cleaning Lab does not have a second track. Here you can cut 
an object (Ctrl + X) and paste it at the desired position (Ctrl + V).  
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Cleaning 

 

Most cleaning functions are activated in the Cleaning FX section. Cleaning effects are 
used to remove annoying noises from the audio. 

All effects in the "Cleaning" section are applied in realtime. You can switch them on 
and off during playback or change their parameters and hear the results immediately. 

Additional cleaning functions can be found in the "Effects" menu (view page 136). 

Choose preset 

  

The presets can be found to the left of the 
effect modules. Here there are presets for 
specific types of cases that are organized in 
categories. These presets always affect the 
entire page of effect modules and can also 
contain a combination of several effect 
modules. 

Under My Settings (or in the "Edit" menu), 
you can save and load your favorite effect 
settings so they can be applied to other 
objects or in other projects. 

Various presets (e.g. "Restore a poor 
quality record") are included and can be 
tried out right away. 

Cleaning FX presets can be applied to 
individual objects or to the entire sound. 

If the expanded user interface of an effect 
is open, the list contains presets for this 
effect. 

 
The presets can be hidden using the arrow button. 
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Using the effect modules 
  

On/Off: Individual effects modules can be turned off and on using 
the buttons to the left. 

 

Control knobs: Each feature has a knob that controls the intensity of 
the effect. 

 

The effects include a range of useful presets which can be chosen from a 
drop-down list. Click on the arrow to access the feature you want. In most 
cases one preset is enough to achieve good results. 

 

Audio perfectionists can perform further settings with the effects. To do so, 
you can open the detailed view of the effect using this button. 

 

Hint: The order of the FX modules can be changed. Make a long mouse click on an 
effects module an pull it to another position. If there is not enough screen space and 
you had to scroll through the effects to get your favorite ones you can put these on 
top of the list. 

Detailed view of the effects 

 

If the detailed view is open, the list of presets to the right includes presets for this 
effect so they correspond to the selection options in the drop-down menu on the 
effect modules. But there is also the "Own settings" area where the current effect 
settings can be saved as a presetting for later use. Here there is also the "Reset 
settings" entry that sets the effect back to its basic settings. 

 
This switch can be used to switch the effect on and off.  

 
Opens the help concerning the respective effect. 

Changes to the next effect from the section (cleaning or mastering). 
So you can make changes in various effects without closing the 
detailed view.    

 
Use this button to close the detailed view and to return to the 
overview. The effect remains active however. 
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The following two options are only available in the cleaning effects: 

 

The "Inverse" button is used to switch over the playback. Instead of the filtering result, 
just that part of the audio signal that was filtered out by the cleaning effect is now 
played back. This allows more control of the effect: If you also listen to parts of the 
music track to the right of the filtered out disturbances, the effect is too strong. 

 
Use this button to reset the realtime displays (spectrograms) 
in the effects. 

 

DeClicker/DeCrackler 
This function removes crackling and clicking noises which are typical on scratched 
records. The DeCrackler was specially developed for removing uniform "crackling 
noises" from old records. 

 

There is a waveform graphic in the middle of the effect dialog, which shows the 
crackling removed during playback (upper range) and crackling removed in real time 
(lower range). On the right and left of the graphic there is a slider for each of the two 
noise types, which is used to control the strength of the respective effect. 

The "Inverse" button at the top of the dialog is used as an additional acoustic control. 
If this is activated, instead of the editing results, you hear only the removed clicks and 
crackling. This means you can judge whether too much of the original audio material 
is included in the filtered out noise and then reduce the strength of the effect 
accordingly. 



 

66   

www.magix.com 

Click markers 
Along with normal crackling on a vinyl recording, there can be some more noticeable 
crackling on a record which is scratched. If the DeClicker is set very high for those 
sections which are particularly noisy, it can lead to several components of the wanted 
signal being affected by the DeClicker if they exhibit similar characteristics as the 
crackling. 

To avoid this, we recommend setting the DeClicker at a lower setting and removing 
the sharper crackling and clicks with the help of the Marker DeClicker. In this case, 
the crackling is marked with a click marker. Only at those points does the special 
marker DeClicker act more intrusively on the audio material; at the other points the 
"normal" DeClicker can be applied less strongly and without damaging the material 
accordingly. 

You can use "Search" to look for especially strong 
clicks throughout the entire project and have 
them marked automatically. Use the "Sensitivity" 
slider to set the sensitivity of the search. The 
higher it is, the more clicks will be found. 

But you can also set the click marker manually by 
placing the position line on a click and clicking on 
"Set". Use "Delete" or "Delete all" to remove the 
click markers again.  

 

DeClicker as object effect 
If the clicking and crackling noises only occur in specific parts of the audio, you can 
use this function as an object effect. 

Search for the noise interference in the track window. Once you have found a noise, 
cut the object just before it begins and once again where it stops (keyboard shortcut 
T) in order to make it into an individual object. Then activate the "Object" button in 
the cleaning area to use the DeClicker only on the area where the noise occurs. 



 

 

Cleaning 67 

 

Tip: If the DeClicker is not able to remove the crackling, you can also cut it out 
manually. To do this, you have to zoom in as much as possible on the object to cut 
out the crackling (preferably on a zero crossover - use the stereo display to get as 
close to a zero crossover as possible on both channels) and move the second object 
created back to first object (zero crossover). Then you can move the object ends of 
both objects sightly over each other to blend them together. 

DeNoiser 
The DeNoiser removes persistent background noise like mains hum, hissing, noises 
from sound cards, disturbance from ground wires, interference from audio equipment 
with high-impedance outputs (e.g. turntables). Impact sound or rumbling can be 
removed effectively from LPs with the rumble filter. 

The DeNoiser requires a short section from your music which contains a sample of 
the noise interference, usually from the start or end of the recording. 

When the DeNoiser is activated in the project for the first time, a sample of the 
interference signal will be searched for immediately under the playback marker. This 
automatic noise sample also enables extremely good successes to be achieved 
without opening the DeNoiser dialog. 

Settings in the effect dialog. 

 

Noise sample: If the automatic noise determination cannot find any suitable material, 
a noise sample can be selected from the list. There are several typical noises to 
choose from. 

Get: Another better possibility is to to create a noise sample yourself. Click on "Get" 
to take a short sample as a noise sample from the current playback position. The 
playback marker can also be moved with the transport console when the dialog is 
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open to search for a suitable position. If the playback position is between two objects, 
no noise sample can be obtained. The Play button can be used to preview the noise 
sample for test purposes. 

Wizard: A wizard that helps in the creation of the noise sample is opened. The wizard 
primarily contains a search function that helps when searching for a suitable noise 
sample in the audio material. Various types of noise can be selected. 

Length: The length can be set in ms if the "auto" button is switched off, otherwise the 
length of the noise sample will be determined automatically. 

Audio type: Here you can set the type of audio material edited; the algorithm is 
adapted accordingly. 

Editing mode: In Broadband interference mode the DeNoiser works in a mode 
optimized for removing noise. In the low-frequency sound interference mode, the 
DeNoiser works in a mode optimized for removing tonal disturbances. This includes 
feedback from power cables, mains hum, PC fans, video cameras or ventilation noises. 
Depending on the editing mode, one of the two following options are available: 

• Responsive: The value for the noise level parameter is set automatically here by 
determining the level of the noise available in the signal. You can find more 
information about this option in the Dehisser section. 

• Maximum attenuation of tonal noise: If this option is active, these types of 
disturbance are totally removed. The "Reduction" slider now only has an effect 
on any simultaneously available noise components. This makes sense because 
tonal disturbances are much more annoying than other noise - a small amount 
of "extra" noise in the recording may be allowed in order to avoid a greater loss 
of highs in the wanted signal. 

Noise level: Here the application threshold of the function for noise removal must be 
set as precisely as possible. Values that are too low will result in insufficient noise 
dampening which causes artifacts such as interference or "twittering" (see below). 
High settings produce dull results – useful signals that sound similar to hissing noises 
are also filtered away. Take your time to find the best setting for the individual case. 

Reduction: Here a balance between the original signal and suppressed signal can be 
set. It's often better to reduce interference signals in small increments, e. g. 3 to 6 dB, 
rather than as much as is possible to keep the sound "natural". For humming, it’s best 
to apply complete removal. 

DeRumbling: Here you activate a special filter for low-frequency rumbling noise. 
Examples of these noises are mechanical noises from old record players, wind and 
impact sounds in microphone recordings. 

Spectrogram: The right spectrogram can be switched between a realtime display of 
the effect result and a static display of the used noise spectrum. 
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Artifacts 
If the settings are incorrect, the DeNoiser and DeHisser can leave behind a metallic 
chirping or twittering sound, the so-called artifact noise. The cause of this is the 
incomplete removal of the noise interference. The ear is quite sensitive to this sound 
because of its synthetic character. This problem, in practice, only occurs in especially 
difficult cases. 

To achieve the best possible results, you should pay attention to the following notes: 

• First, select a preset from the selection menu. In most cases the result is 
satisfactory. 

• Be careful when "denoising" the effect: Less is more! The noise interference 
should no longer be audible, otherwise artifacts may be brought about. 

It’s best to remove any available DC component (see"Removing DC voltage" (view 
page 73)) from the audio material before using the DeNoiser or DeHisser. 

Dehisser 
The DeHisser eliminates regular "white" noise typically produced by analog tape 
recordings, microphone preamplifiers, or AD transformers. 

 

Noise Level: Here you should set the threshold of the DeHisser as precisely as 
possible. Setting the value too low will result in insufficient removal of the noise. 
Incomplete removal of noise produces artifacts and should be avoided. Setting the 
values too high leads to dull results – parts of the wanted signal that are similar to 
noise, such as the blow-off from wind instruments, are filtered out. 

The setting doesn't cause any problems at a reduced noise level. 
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Responsive: The value for the noise level parameter is set automatically here, by 
determining the level of noise available in the signal. The setting on the noise level 
knob now has a relative effect, i. e. the used value results from the automatic system 
plus the setting of the noise level slider. 

An advantage of this is that you no longer have to adjust the noise level manually and 
the values are adjusted for fluctuating noise levels, e. g. if you use different tracks with 
varying noise levels in one project. 

If the noise volume is constant, you may be able to achieve better results by setting 
things up manually (responsive off). But the value for noise level has to be set exactly. 

Noise Reduction: Here you can adjust the dampening of the hissing in decibels. It is 
often better to reduce noise in smaller increments, e. g. -3 to -6 dB, rather than as 
much as is possible to keep the sound natural.  

Audio type: Here you can set the type of edited audio material, the algorithm is 
adapted accordingly. 

Declipper 
If the input level of an audio recording is too high, distortion may result at the louder 
parts (the signal peaks). This digital distortion is also called "clipping". At the 
overmodulated area, the values that are too high are simply cut off and the typical, 
annoying crackling and distortions are heard.  

MAGIX Audio Cleaning Lab has a special function for dealing with digital clipping. 

Distorted sections are discovered and filtered out based on the material in the 
selected object. Lastly, the master volume of the material can be reduced so that the 
interpolated parts can be played back without distortion. 

The declipping algorithm is particularly good for audio material with clearly audible 
clipping, e. g. distorted piano or vocals. The sound of distorted drumbeats on the other 
hand is hardly ever improved. 
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Peak meters: The peak meters show the input signal, the output signal and the 
strength of the declipping. 

Clipping level: Here you can enter the level at which the algorithm will consider a 
sample to be clipped and correct it. This is important because different sound cards 
have different clipping characteristics. 

Get: Here you can determine the clip level automatically. 

Output level: The interpolated signal peaks cause a change to the total level that you 
have to offset with the output level slide in order to avoid renewed distortion. To do 
this, observe the peak meter at the top of the dialog. 

For security, a limiter that reliably avoids clippings can be connected with the "Output 
limiter" option. 

Tempo/Resampling 
This effect is only available as an object effect (view page 72). 

The fader lets you change the playback speed of objects so that they are better 
aligned. The effect can be applied in two ways, either as resampling or as 
timestretching. You can change the mode in the preset list at the very bottom. 

• Resampling mode can be used to change speed and pitch just like on a cassette. 
Use this mode to adjust LP recordings made at the incorrect speed. 

• Timestretching mode applies a high-quality timestretching algorithm to keep the 
pitch constant in spite of speed changes. Use this mode to adjust the tempo of 
different tracks to match each other without influencing the pitch, e.g. for a DJ 
mix. 
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The effect is also available as a mouse mode (view page 147) for changing the tempo 
across a larger range of values. 

Resampling for incorrect record speeds 
If you want to record a record that was recorded at 78 rpm, then you normally have a 
problem: These older shellac LPs aren't able to be played back by most turntables. 
With the help of this resampling technology, it's possible to playback the record at the 
incorrect speed, record it, and then correct the speed with a single click. 

Different presets have been provided for this. The first number indicates the speed at 
which the record was played back, and the second shows the speed that it should be 
played at. For example, if an older 78 rpm shellac record was played at 33 rpms, then 
you would use the "33/78" preset. 

A second group of presets are for adjusting wave files with different sampling rates to 
the project. These are selected automatically when this sort of wave file is loaded into 
the project. The first number here is also the sample rate of the project (for playback, 
normally 44.1 kHz or CDs), and the second is the wave file (the target playback rate). 

Auto Cleaning 
Auto Cleaning analyzes the audio material for disturbances and recommends suitable 
settings for the Dehisser, Denoiser, DeClicker and DeCrackler effects. 

Start the analysis with this button. 

The result of the analysis is shown and suitable effects with the right strenght are 
activated: 

 

You can now change the strength of the single effects or deactivate them. Those 
changes from the original proposal of the analysis are marked red. A double click on a 
slider turns it back to its original proposed value, with "Reset" you go back to the 
whole analysis result. 
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For a comparison you can play back the original audio with "Original" and the 
processed audio with "Result". 

Once you are happy with the iprovements, just close the Auto Cleaning with the close 
button at the top right, the last effect settings are kept. 

Object effects 
All "Project" settings effects are also available as object effects and can be applied in 
addition to the project effects. This means you can remove noise from the entire 
project or a humming sound that only occurs at one point in a specific object. 

 

The object effects can be opened using the "Object" button located above the effects 
or directly on the objects in the track window using the cogwheel button. While the 
effects in the project section affect all objects in the master track, the object effects 
are only applied to the selected object. 

You can create new objects by splitting objects (view page 57) into several smaller 
ones. Use the Scissors button or the "t" key to do this. 

Tip: If there are already track markers in the project, e.g. ones that have been 
automatically set (view page 60) you can automatically split the object so that each 
track is a separate object. This can be done in the menu "CD ”> „Split objects at 
track marker positions” (Keyboard shortcut: Ctrl + T).   

As different objects can have distinct object effects, the indicator for object effect 
settings changes when you click on a different object. The selected object will then be 
noticeably emphasized to make it clear which object the current object effect settings 
are affecting. 

 

 If there are active Object FX, the gear symbol is marked with "FX". In this way 
active object effects are identifiable even if project level effects are displayed. 
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If you select an object, the InfoBox 
(view page 37) displays which 
object effects are active.  

 

Remove DC offset 
This function can only be opened using the "Effects" menu and can thus only be 
applied to selected objects. This can be useful if your sound card overlays your 
sample with a constant DC offset during recording, which leads to crackling during 
playback or editing. (This is pretty much always the case with recordings that use the 
integrated sound card of your PC.) 

 

In (preset) Responsive mode, an entirely constant DC voltage cannot be assumed. A 
variable DC voltage value is also recorded. From a technical point of view, all 
frequencies below 10 Hz are regarded as DC voltage. If "Responsive" is deactivated, a 
constant DC voltage value is determined. Then you can also enter a minimum DC 
offset threshold, which indicates where DC offset removal will kick in. You can also 
edit stereo channels together to reduce processing time. 
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Mastering 

 

The mastering functions are activated in the Mastering section. Mastering effects are 
used for either improvement or a dedicated change of the sound of the audio. 

All mastering effects function in realtime which means that you can switch them on 
and off and change their parameters during playback and listen to the result of the 
changes immediately. 

On information about the general usage of the effect modules, the project and object 
effects and the presets look above in the Cleaning Effects (view page 62) section! 

Stereo Enhancer 
With the Stereo Enhancer you can determine the positioning of the audio material in 
the stereo panorama. If the stereo recordings sound unfocused and undifferentiated, 
an extension of the stereo base width can often provide better transparency. 

Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 
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 Volume control: Sets the volume, and thus the panorama as a whole, for the 
individual channels. The damping of left and right levels is displayed in dB 
underneath the controllers. 

 Panorama: The slider allows you to move the sound source that comes out of the 
middle into the stereo panorama. The signals at the outer edges of the sound 
picture remain unchanged. 

 Base width/Maximize sensor field: This sets the base width between "Mono" 
(completely to the left), unchanged base width ("Normal Stereo") and maximum 
base width ("Wide", completely to the right). Raising the base width (values over 
100) diminishes the mono compatibility. This means that recordings edited this 
way sound hollow when listened to in mono. 

Maximize strengthens the spatial component of the recording, which also 
increases the stereo transparency without influencing the mono compatibility. 

 Multiband: This can be used to switch Stereo FX to Multiband mode. Stereo 
editing only applies to the middle frequency; the bass and highs remain 
unchanged. 

 Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to check the alignment of the signal in 
the stereo panorama and the effect of the stereo enhancer. To maintain mono 
compatibility, the "cloud" shown should always be higher than it is wide. 

 

Brilliance enhancer 
The brilliance enhancer is a high-end audio tool with which losses in high frequencies, 
which occur with MP3 compression or while recording older records, can be regained. 
As opposed to the equalizer, which only raises the available frequencies, the brilliance 
enhancer generates new overtones from the material available and really refreshes 
the sound. 
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Soft: This option reduces any distortions that occur. The entire sound appear less 
clear. The activation of "Soft" depends on your sound settings. If you prefer a brighter 
sound, you should deactivate the "Soft" option. 

High quality: This option improves the results, but increases the computing power 
required. As a rule of thumb, you should decide as you go and rely on your own 
judgment. 

Strength: This controls the strength of the effect. 

Parametric 6-band equalizer 
The parametric equalizer has six filter bands that you can use to shape the sound of 
the music track. Each band is a filter with a typical "bell shape". Within a certain 
frequency range around an adjustable middle frequency you can increase or reduce 
the signal level gain by a specific amount (raising). The width of this frequency range 
is called bandwidth. The bandwidth is defined by the Q value. The higher the Q value, 
the narrower and steeper the filter curve.  

You can influence the basic sound of the mix by boosting or cutting specific frequency 
ranges (low Q value) to give it more "depth" (lower mids 200-600 Hz) or more "air" 
(highs 10 khz). You can also decrease very specific frequencies (high Q-value) to 
remove unwanted noise. 

 

 Sensor field: The sensor field displays the resulting frequency response of the 
equalizer. The frequency is displayed horizontally and the increase or decrease 
of the respective frequency is displayed vertically. 

 The yellow bullets 1-6 symbolize the six frequency bands. You can move them 
around with the mouse until you find the frequency response you want. The 
bandwidth (Q value) can be adjusted using the mouse wheel. 
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 The faders under the filter graphic display the parameters of the currently 
selected band. The rotary knobs can be used to adjust the values for each band 
more precisely:  

 

 Frequency: The center frequency of the single bands can be set between 10 Hz 
and 24 kHz with the frequency controller. Freely choosing the frequency enables 
multiple filters to be set to the same frequency in order to have a greater effect. 

 Raising: This controller allows you to raise or lower the filter. Setting the 
controller to 0 deactivates the frequency band so it does not use any processing 
time. 

 Quality: This sets the quality (bandwidth) of the individual filter. 

 Bands 1 and 6 include a special feature: They can be operated with three different 
filter curves. 

 
Peaking: This corresponds to the normal bell shape that is also used for 
the middle bands. 

 
Shelving (basic setting): From the set frequency, the frequencies will be 
gently raised or decreased.  

 
High-pass or low-pass: All higher or lower frequencies from the set 
frequency are filtered away. 

 

 You can control the output level of the equalizer with the peak meter. With the 
Output Gain beside it you can offset the level changes resulting from the EQ 
adjustments. 

 

Grafic EQ 
The Grafic Equalizer subdivides the frequency spectrum into ten areas (‘bands’) and 
equips them with separate volume controls. This way, it is possible to create many 
impressive effects, from a simple bass boost up to complete distortion. Note: If low 
frequencies are boosted too much, the total level is heavily increased which may lead 
to distortion. In this case, the master volume should be decreased with the aid of the 
"Master Volume" slider in the main window. 
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Bullets 1-10: Each of the 10 frequency ranges can be separately increased or reduced 
with the 10 volume controls. 

A/B: If you have selected a preset for the effect and make manual changes to it later, 
you can compare the original preset sound with the new settings by using the A/B 
button.  

Link: Using this function randomly combines the frequency ranges with each other in 
order to avoid artificial-sounding overemphasis of an individual frequency range. 

Reverb 

 

The reverb effect unit offers realistic reverb algorithms to add more depth to your 
recording. You can control the sound of the reverb effect with the following 
parameters: 
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Room size: Here you determine the size of the space (or, with plate and spring, the 
systems). The larger a space, the longer the sound travels between walls or objects. 
With some low "size" settings, you can also reduce the distance between the 
individual reflections. This allows resonance to develop (accentuated frequency 
ranges), which can sound oppressive if the reverberation time is too long. 

Tone quality: Here you can influence the audio characteristic of the effect to a certain 
extent. The effect of this controller depends on the used preset. In rooms, "Tone 
quality" controls the dampening of the highs in the reverb (from dark to bright) as 
well as pre-filtering of the signal. With plate and spring presets, this fader determines 
the dampening of the basses as well. 

Reverberation time: With this knob you can adjust the reverberation time and 
determine how much of it will be absorbed and, simultaneously, the reverb's decay. 

Pre-Delay: The reverb portion ("mix") as well as the early reflections play a large role 
in the perception of sounds in the room. The time required for the perception of the 
early reflection is know as "Pre-Delay". For sound sources that are close, the reverb 
portion is usually low and the early reflections reach the ear noticeably later than the 
direct sound. In contrast, sound sources that are far away usually have a high reverb 
portion and the early reflections reach the ear almost simultaneously with the direct 
sound. The length of the pre-delay also influences the "sensed" distance of the sound 
source from the listener. 

Mix: This controller sets the mix ratio between the original and the edited signal. For 
rooms, you can therefore move a signal further into the room by increasing the effect 
percentage. 

Presets: 

The presets represent the basic settings for the various room algorithms, which can 
be still be varied along with the other parameters. Hence, they are more than just 
simply parameter sets. 

Hint: In MAGIX Audio & Music Lab Premium you can use a second reverb effect, 
the  VST plugin efx_reverb (view page 97)! 
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Echo 

 

"Delay" actual means a time delay. This effect acts like an echo, as the signal is 
reproduced after a delay. 

Delay: This sets the time span between the individual echoes. The more the control is 
turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the amount of echo. Turn the dial completely to the left, there 
is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). 

SoundCloner 
SoundCloner 2 analyzes the sound characteristics of songs and transfers them to 
other recordings. Allowing you to apply the sound of a 60s soul recording to a 
modern pop song for example. You can also use SoundCloner to analyze compilations 
of different songs and compare their sound.  

SoundCloner features an FFT Filter (1024 - band equalizer) and a compressor. The 
filter curve and compression properties are automatically calculated and presented as 
a combination of the cloned sound and output sound. 

As well as "Clone" presets the SoundCloner presets menu contains a few useful filter 
settings that provide a typical sound for a range of eras (70s, 80s, 90s etc.). 
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Filter curves can also be edited manually, SoundCloner can therefore also be used as a 
filter for creating strange effects. It can also prove more effective than the DeNoiser at 
removing noise in certain circumstances, e.g. for removing whistling in the 
background. 

Using the Sound Cloner 
1. Load a song with a sound you really like. 
2. Now change to "Object" on the effect page or click on the cog wheel icon next to 

the audio object to activate the object effects. 
3. Open the Sound Cloner and click on "Get Sound". The sound characteristics are 

now calculated. After that, the sound will be available as a SOUND CLONE 
preset and can be saved permanently for later use by clicking "Save". 

4. Activate the Sound Cloner on the object you want to apply sound to and click on 
"Apply sound clone". The Sound Cloner detects the sound and dynamic 
properties of the target object and calculates the filter curve and/or the dynamic 
setting, which resulted when the audio characteristics of SOUND CLONE and 
the edited object were combined. 

5. The filter curve and the dynamics editing of Sound Cloner compare the audio 
characteristics of the target object to those of the analyzed object. Using the 
"Strength" slider under the filter graphic, you can regulate the intensity of the 
frequency adjustment. 

Note: The Sound Cloner has to be used as an object effect because the final filter 
setting depends on the audio characteristics of the "cloned" object and of the target 
object.  

However, if you have uploaded a record, you should only use the Sound Cloner on 
the master because a record has already been mastered. The frequency response 
and compression differ in fact from plate to plate, but the tracks on a record have 
already been synchronized with each other. Just think about recordings of classical 
concerts or conceptual albums, for example. In these cases different mastering of 
the tracks from each other would be rather distracting. 
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Controls 

 

 Get Sound: This button analyzes the audio characteristics and makes the 
SOUND CLONE preset available. 

 Save: Save the SOUND CLONE preset under another name for later use. 

 Apply Sound Clone: The result of the current analysis, the SOUND CLONE 
preset is applied. 

 List of the five last presets used 

 Original/Result: Plays the edited/unedited object. 

 Filter graphic: This is the centerpiece of Sound Cloner, it is a filter drawn 
freehand that displays the frequency response, before and after applying the 
filter in realtime. (See below for instructions on how to use.) 

 Strength: The strength slider allows you to enhance or diminish the differences 
in the curve movement. You can therefore control how much Sound Cloner 
adjusts the sound to the presets. 

 Audio Type: You can choose from a range of different audio types (speech, pop 
music etc.) to optimize the compressor's function. 

 Compression: This slider lets you change how much the preset's dynamic range 
should be adjusted. Dynamic range can only be reduced, so if the reference 
material has a higher dynamic range than the edited material, this slider won't 
have any effect. 

 Level correction: The slider allows you to balance out any volume changes 
caused by the compressor. The peak meter next to it displays the input and 
output levels. 
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Filter graphic 

 

The frequencies are listed in ascending order from left to right. The height of the curve 
represents the amount of a specific frequency in the entire sound. The yellow curve 
(1) shows the original frequency response, the blue curve (2) displays the corrected 
frequency response, i.e. the frequency response the spectrum has after applying the 
filter.  

The red curve (3) is the filter curve, its height determines to what extent the 
respective frequency should be amplified or attenuated. When using Sound Cloner as 
a filter this curve is a combination of the desired frequency response ( = content of 
the SOUND CLONE analysis) and the current frequency response. The means the red 
curve will always look different regardless of the object when using the same preset. 

The filter curve can be drawn using the mouse in the filter graphic. Draw or rotate a 
straight line by pressing and holding the Shift key. "Reset display" resets the red filter 
curve to neutral, i.e. to be on a straight line with the initial position. 

Removing audio distortions with Sound Cloner 
Sometimes the DeNoiser isn't the right tool for removing certain kinds of noise 
interference. For example, if the noise doesn't occur anywhere "alone" in the 
recording it is hard to get a sample to use, or if the noise is particularly loud, the 
DeNoiser filters too little of the useful signal resulting in a hollow, artificial sound.  

Some noise interference consists of a few frequencies, and often only one frequency 
(pure tone, such as the "pips" on the radio). A typical example of this is a constant, 
clearly-audible drone in old video recordings. The FFT filter is perfect for this kind of 
noise as it allows you to remove specific frequencies without affecting the rest of the 
recording. 

Follow these instructions to do so: 

1. Reset the filter curve ("Reset display" button in the top left of the dialog). 
2. You will be able to spot the noise interference during playback as it is the only 

spike that remains constant in the otherwise constantly changing yellow filter 
curve. 
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3. Draw a horizontal line below the spike on the lower edge of the filter display, 
ideally it should be just long enough that the spike in the blue (resulting) filter 
curve disappears. 

4. If the noise interference can still be heard, you can also remove the overtones of 
the signal, which are weaker peaks that can be found in the second, third, fourth 
multiples of the frequency etc. 

Video sound optimizer 
There is a complex signal processing algorithm at work which combines different 
functions for emphasizing speech and reducing background noises (wind, rumbling, 
hissing). 

Dynamics 

 

Dynamics is an automatic, dynamic volume controller: The volume of a loud section 
will be lowered and the volume of muffled sections will be raised.  

Processing is carried out using a "look-ahead" method, similar to high-quality studio 
appliances.  There are no peak overmodulations or other artifacts as the algorithm 
can never be 'surprised' by sudden level peaks. 

Threshold: Set the volume threshold, below and above which compression is applied. 

Ratio: This parameter controls the amount of compression. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short attack 
times can create an undesirable "pumping" sound, as the volume is quickly reduced or 
increased correspondingly. 

Release: Sets the algorithm's reaction speed to falling sound levels. 
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Gain: The gain controller amplifies the compressed signal. 

A/B: If you have selected a preset for the effect and make manual changes to it, you 
can compare the original preset sound with the new settings using the A/B button. 

MultiMax 
 

 

MultiMax is a compressor with three independent frequency bands. The dynamics 
editing is carried out separately for each band. 

The advantage of a multi-band compressor in comparison to a "normal" compressor 
is that the "pumping" tendency and other disturbing side effects are dramatically 
reduced during dynamics editing. For instance, it can prevent a bass level peak from 
"dragging down" the entire signal. 

Multiband technology also lets you specifically edit individual frequency ranges. 

Setting the frequency bands: The settings of the frequency bands are changed 
directly via the graphic. Simply click on the separator lines and move them. 

Bass/mid/high: These knob controllers define the level of compression for each 
frequency band. 

Link bands: When this button is activated and one fader is adjusted, all faders are 
changed in the same ratio. However, the way the dynamics are edited is not affected. 

Presets: In MultiMax, you can use the presets to open 2 further special functions: 

• Cassette NR-B decoder: MAGIX Audio Cleaning Lab simulates decoding of 
Dolby B + C noise reduction if a Dolby player is not available. Cassettes 
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recorded with Dolby B or C sound more muffled and slurry if played back 
without corresponding Dolby.  

• De-Esser: These special presets help to remove overstressed hissing sounds 
from speech recordings. 

Auto mastering 
The Auto Mastering feature enables you to automatically apply the sound of typical 
musical styles from the past and present (e.g. 70s disco, 90s club, jazz etc.). The 
sound of the source material is analyzed and appropriate equalizer and dynamic 
effects are applied. 

The auto mastering wizards are activated 
by the corresponding button at top left 
above the presets. 

Now choose the musical style. 

 

MAGIX Audio Cleaning Lab analyzes the audio material in the project. The settings 
that are used to achieve the optimum sound for a particular musical style depend on 
the audio characteristics of the source material. If the audio material in all the objects 
is from the same source and are similar enough in sound, the wizard will apply the 
appropriate effects at the project level. If the objects differ too greatly, the effects are 
applied to each object separately. Audio & Music Lab automatically decides whether 
the auto mastering will be applied to individual objects or to the entire project. 

Note: In MAGIX Audio Cleaning Lab the effects are always applied at the project 
level. If you want to work with separate objects, you can apply the Sound Cloner 
(view page 80) manually. 
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Selecting "Original" can be used for the comparison of the editing and the original. 
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Plug-ins 
DirectX and VST-compatible plug-ins can be used for effects calculation in MAGIX 
Audio & Music Lab Premium. This makes it possible to use third party effects and 
dithering processors in addition to the effects that are already integrated into MAGIX 
Audio & Music Lab Premium. 

Some of the included effects are loaded as plug-ins. These include: 

• MAGIX essential FX (view page 89): DeEsser, Vocal Strip, Gate, Reverb, Tube 
Stage and Chorus Flanger 

• Energizer 
• am-track SE 

Note: Plug-ins are not available in MAGIX Audio Cleaning Lab but the DeEsser 
effect is included as a simple effect module. 

Both the cleaning and the mastering sections have special effect modules where 
plug-ins can be loaded. The plug-in module has no effect level controller but consists 
of two selection lists. 

 

 On/Off: This button turns the plug-in effect on or off. 

 Selection menu: Select the plug-in from the selection menu on the right side of 
the module. For this, you will need to have plug-ins installed on your computer. 
The path to search for installed VST plug-ins can be set in the "Options" menu via 
-> "Path settings". All recognized plug-ins will be added to the menu list. 

 If the plug-in has presets, they will be included in this list. Many plug-ins also 
come with their own preset manager which can accessed through the plug-in 
interface.   

 Edit: The selected plug-in is opened in the VST Plug-in Editor (view page 88) in 
order to make specific effect settings. 
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VST PlugIn Editor 
The editor has two views: the so-called "GUI" (graphic user interface) of the plugin 
and the parameter view mode. The latter is either activated automatically if the VST 
plugin does not have its own GUI or can be used of the GUI of the plugin is too 
confusing or occupies too much space on the screen. The parameter view displays 
eight parameters of the plugin as sliders. In the Plugin menu you can switch between 
these views. 

Load/save patch/bank: The instrument settings can be saved and loaded in the patch 
and bank formats typical for VST plugins (*.fxp and *.fxb respectively). 

Random parameters: This function can be an important source of inspiration. 
However, before using it please save the current preset you've just created as this 
feature does not ask before it is applied.  

Program menu: Here you can select the included plugins or the presets loaded via the 
plugin menu. 

essentialFX 
The essentialFX is a collection of various studio effects with a standardized interface. 
The DeEsser (view page 93) and Gate are typical cleaning effects, the Vocal Strip 
(view page 92) and Tube Stage (view page 99) effects are used for sound 
optimization.  The Chorus/Flanger is a special effect for distorting the sound. 

Note: The essentialFX were originally developed for the professional audio program 
MAGIX Samplitude. For this reason even the Help files are oriented towards 
professional users. But there's no need to worry because these plug-ins include a 
wide range of helpful presets. Simply try them out until you find the sound that's 
right for your project. 

MAGIX plug-ins 
Console 
Some MAGIX plug-ins show a so-called "Console" at the top edge when they are 
opened – a display bar for managing presets with expanded settings options. 

 

A menu containing available presets is located behind the display. To the right is a 
prev/next button, which lets you leaf through presets. 

 This button is used for saving presets. MAGIX plug-ins use a proprietary 
preset save format (*.fxml) 
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You can return the presets to their initial settings by clicking on the 
"Reset" button. 

 
Bypass switch: Routes the signal directly to the output instead and 
bypasses processing. Internally, processing is continued so that you can 
toggle between processed and unprocessed material anytime. 

 
A/B comparison: Very useful for trying out settings. The controller 
setting "A" memory is normally activated when the interface is opened. 

As this is the initial status, "B" also contains the same settings. If you would like to 
experiment without losing the current setting, press the "B" buttons and try other 
settings. To transfer the values to "A", press the copy button between the two letters. 

 
"?" button: This opens the online help for the plug-in. 

 

Parameter smoothing/ Controller knobs 
Each plug-in offers soft controlling. Pot settings are softly faded internally from the old 
value to the new one. This is particularly noticeable when playing in "Live" mode. Due 
to performance reasons, switches (e.g. on/off) and some settings of VariVerb II that 
change delay times directly or indirectly are excluded from this action. 

Use the mouse wheel to move the knobs (pots). A combination of the mouse wheel 
and "Shift" key slows down the increase or decrease by a factor of ten. 
Double-clicking resets the knob to the original value. 

Vpot Controls 
Some controllers snap to the middle setting, which may be useful for quickly returning 
to a "neutral" status. It is extremely difficult to adjust the fine settings within close 
proximity of this snap point. You can temporarily deactivate this snap mode by 
holding "Shift" before touching the controller. 

Use the mouse wheel to adjust the controllers. A combination of the mouse wheel 
and "Shift" key reduces the increase/decrease by factor ten. 

Apropos the controller movement, note that all plug-ins follow the host settings 
regarding linear or circular mouse movement.  You can usually choose whether you 
prefer up/down or a circular movement to adjust the value. 
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essentialFX Presets 
By clicking on the tool symbol in the graphic display, you can open the presets.  

Under "Tweak" you can find specific settings options for each effects device. 

Under "eFX Globals" you can find settings options for graphic level display as well as 
mouse control. 

 

eFX Globals 
These settings apply to all Essential FX. 

Metering: Here you can set the meter display.  

• Decay Time controls reaction speed.   
• Peak Hold controls the hold of the highest peak. 
• Brightness controls the display brightness. 

Mouse: Here you can set the display reaction to mouse movements in the essential 
FX graphic display. 

• Linear mode lets the faders move in response to vertical and horizontal mouse 
movements. 

• Circular mode lets the faders be controlled by circular mouse movements. 
• Mode As Host lets the faders move in response to the mouse exactly how 

mouse settings in MAGIX Audio & Music Lab Premium  specify it. 
• [Shift] Factor specifies the factor for fine adjustment of individual faders with 

the mouse with simultaneously held Shift key. 
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Vocal Strip 
This plug-in combines several components in one special tool which is ideal for 
working with speech or vocal tracks. Virtually all recurring voice signal edits are 
integrated in a compact, simple interface. 

 

The signal flow is set by the e_FX_VocalStrip and is directly represented by the 
position of the fader. 

Vocal Strip Parameter 
IN / OUT: Here you can set the input and output level. 

• highpass: This fader determines the cut-off frequency for a steeply sloped 
highpass filter (24dB/octave) to remove part with low frequencies, such as 
rumbling or noises created when touching the microphone. 

• gate: With gate you can attenuate the signals that fall below the threshold. Here, 
a smooth curve and a maximum 'softening' of up to 24dB is used to avoid hard 
transitions. 

• DeEsser: The effect is very similar to that of the eFX_DeEsser. Here, however, 
the application frequency is set. The filter used in eFX_VocalStrip works in 
another range. The fader determines the degree of reduction. 

• compression: For the most part, an eFX_Compressor component contributes to 
working parameters for optimizing voice recordings. The further the fader is 
turned the lower the threshold and higher the compression ratio. The Attack and 
Release times are selected according to the program.  

• tone: This EQ corresponds principally to the filter network, which is also used in 
the eFX_TubeStage plug-in. With this you can simply and effectively calibrate 
the sonic balance of the voice signal, e. g. for better integration into the mix. 
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Tweak  

• DeEss DetFreq: Determines the frequency of the filter used for detection, and 
filter blocking in the signal route. Typically the sibilants in speech or singing 
voices are in the 6 - 8 kHz range. 

• CompAutoMakeup: The maximum level is retained while overall level is 
reduced. 

• Comp Attack: Here you can determine how fast the compressor responds after 
reaching the threshold. 

• Comp Adapt.Rel.: Rising values cause the compressor to work increasingly with 
"Adaptive Release". This means that the longer and harder the compressor 
intercedes upstream in the signal path, the longer is the resulting release phase.  

Note: Detailed information about compressor-specific settings can be found under 
"essentialFX > Compressor > Compressor Parameter". 

DeEsser 
This plug-in filters/attenuates sibilants in vocal recordings in a simple yet effective 
way. Since the underlying process operates on the basis of a dynamic filter, other 
signals are weakened such as cymbals in drum recordings or other signals in a similar 
frequency range. 

 

In contrast to other devices of this type, the eFX_DeEsser works without adjustable 
thresholds. The plug-in constantly evaluates the input signal and recognizes signal 
peaks that are high above in the frequency range of the average levels. Through this 
comparative analysis with the wanted signal, a constant reduction of noisy sections 
can be adhered to, so a traditional threshold often requires adjustments for changing 
levels. 
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DeEsser Parameters 
IN / OUT: Here you can set the input and output level. 

• freq: Determines the frequency of the filter used for detection, and filter blocking 
in the signal route. Typically the sibilants in speech or singing voices are in the 6 
- 8 kHz range. 

• Speaker symbol (pre-listen): This allows you to hear the "solo" filter frequency 
so you can locate noisy sections quickly and easily. 

• reduction: Regulates the filter attenuation in the signal route. 

Tweak  

• Filter Q: Set the bandwidth of the individual filters between 0.10 (very wide 
bandwidth) and 2 (extremely narrow bandwidth). 

Gate 
This plug-in can be used to remove noises in the pauses between audio material, e.g. 
a pause in speech during commentary. When the signal level falls below a certain 
threshold, the entire audio signal is faded out. The assumption is that there is no 
wanted signal present. The noise gate can be used in situations for original audio 
recordings with noise that is so strong that it cannot be removed using the DeNoiser 
without leaving the wanted signal muffled and hollow. For certain types of instrument 
recordings it is also not a good idea to remove all of the "dirtiness" from the sound, 
e.g. distorted guitar. With the gate you can at least clean up the sound during the 
pauses. 

 

The operation is similar to a classic analog gate. Here emphasis was placed on a fast 
and accurate response, where the typical artifacts from digital gates such as rough, 
"fluttering" sounds are avoided. The essential FX Gate continuously scans the signal 
and automatically selects optimal settings according to the current values. 
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Gate parameter 
IN / OUT: Here you can set the input and output level. 

sidechain int/ext: As with the essential FX Compressor an external control input can 
be used for triggering. 

Note: Sidechaining is not available MAGIX Audio & Music Lab Premium. 

soft knee: Normally the Gate has a hard characteristic i. e. below the threshold this 
signal is cut hard, in addition it is transmitted in an unchanged form. "Hard Knee" 
deals with abrupt transitions. "Soft Knee", however, allows the signal to be modified 
by "Gating" in the pass so that transitions can be softer and less detectable. This is 
particularly recommendable for work with acoustic instruments such as drums where 
the signal levels can fluctuate a lot. 

hold: This three-way switch controls how long the gate process waits after passing 
through the attack phase before subsequently passing through the release phase. The 
Hold function is useful for signals that need a rather short release time, but shouldn't 
be flattened out. 

• sc filter: Operation is the same as the essential FX Compressor. 
• threshold: This fader defines the threshold beneath which the gate should be 

applied. 
• range: Here you can set the gating strength. When it is set fully to the right, the 

signal beneath the threshold is cut out completely. Subtly attenuating the signal 
can  remove background noises or breathing from vocal tracks. Where 
necessary the process can be attenuated even further by switching on the soft 
knee mode. 

• attack: Regulates the attack time from the closed gate to the point at which 
signal is let through again. 

• release: Sets the time that the gate requires to go from a normal state to gating. 

Tweak 

• Look Ahead: This control sets how long ahead the gate previews the signal. The 
audio signal will be delayed by this time. 

Chorus/Flanger 
This plug-in offers a simple way to make signals sound more interesting, "spacier", 
thicker, etc. by modulating or delaying the pitch - the classical domain of application 
is for guitars, Hammond organs, electric pianos, or synths. 

Chorus and flanger are two closely related effects, which are combined into a single 
plug-in. They normally differentiate in terms of delay time, type of modulation, and 
degree of internal feedback. 
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Chorus flanger parameters 
IN / OUT: Here you can set the input and output level. 

mode: 

- Stereo chorus:  Compared to mono chorus, two copies of the original are created, 
modulated against each other in pitch, and then fed accordingly to the set mix ratio to 
the left and right output channel. 

- Mono Flanger & Stereo Flanger In contrast to the Chorus Effects the lower delay 
periods and a slightly changed modulation are processed. 

- Ensemble: This creates a denser chorus, similar to Boss/Roland CE-1: Instead of two 
voices, six are generated. Two internal sine LFOs for de-tuning, whereby for both 
LFOs the second and third voice phase length by 120°. This results in a 
denser-sounding effect that is also less warped. 

• Rate: This specifies the speed of the modulation. Lower rates provide slight 
hovering effects, and high speeds produce a wobbling, typically distorted 
"underwater" sound. 

• Depth: This parameter specifies the depth of the modulation, i. e. the maximum 
deviation of the modulation and the resulting pitch bending. 

• phase: This fader moves the right channel's oscillator phasing relative to the left, 
wave is put back to the right. So that the Tremolo effect drifts apart in the stereo 
field with ever increasing values. At 180° both oscillators work in reverse, 
therefore the stereo effect is at its strongest. 

• Feedback: This parameter defines the portion of the delay that is sent back to 
the input. Feedback causes the effects of modulation to be more drastic and 
cutting. Nullification of the feedback is set at the middle of the fader. Set to the 
right, the feedback is fed to the input equi-phasal; to the left, the feedback 
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occurs. Both variants may sound very different depending on the signal, since 
they prefer different frequency ranges for dissonance. 

• Mix: Regulates the mix ratio of the original signal and the delayed portion. 

Tweak  

• Low Cut: This knob sets the filter frequency of a high-pass filter. Signal 
components below this frequency will be filtered out. 

Reverb 
This involves a completely algorithmic reverb plug-in. Selectable algorithms produce 
thick and extremely transparent reverberation for all kinds of signals. Processing is 
therefore "true stereo", i. e. the selected algorithm includes the original localization of 
instruments in a stereo signal in the calculation of reverberation so that the original 
image will not be distorted.  

"Reverb" features algorithms that are set up for natural quality and transparency. A 
signal treated with this reverb retains power at correct dosage in the overall context 
of the audio without perception of a conspicuous effect. The CPU load is also 
relatively low. 

 

Reverb parameters 
IN / OUT: Here you can set the input and output level. 

Mode: Select the desired algorithm here. The following options are available:  

- Plate: Simulates a reverb plate. Very dense reflection pattern, penetrating but 
musically open "metallic" appeal. Very well suited to Drums and Vintage/special 
effects. 
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- Room: Small room reverb. Middle to high signal diffusion, low to middle reverb time. 
Well suited for adding a "dry", natural sound to instrumental, spoken, or vocal 
recordings. 

- Hall: Mid to large hall. Low to mid diffusion, later response than a "Room". Ideal for 
simulating concert halls and larger soundscapes. 

- Plate II Classic: Classic stereo plate reverb. The design is based on an algorithm that 
was frequently used in the 80's. This mode produces the typical "Cloud reverb", 
which is not very transparent, a bit sticky. Plate II Classic is a good fit for lead 
instruments and vocals. 

• Size:  The size of the room being simulated or of the reverb plate. This setting 
has a direct effect on the distance of the reflection and indirectly on the 
resonance behavior: smaller rooms/reverb plates possess a larger inclination for 
natural resonance than larger ones. 

• Time:  Length of reverberation time (in seconds). This value refers to the RT60 
time, i. e. how long the reverberation requires for the level to fall 60 dB. 

• Damping:  Real rooms and reverb plates dampen certain frequencies according 
to their construction. This is most often audible in upper frequencies. Using this 
parameter you can set the cut-off frequency, above which the reverb will be 
particularly strong. In some cases, the "Time" parameter should be adjusted, 
since sometimes the subjectively perceived reverberation time will also be 
affected. 

• Modulation:  For several critical signals, the reverberation may produce 
disturbing resonance. This can be scattered by temporal modulation of the delay 
signal used in an algorithm. Excessive application may create an effect similar to 
chorus in tonal signals. The liveliness of the reverberations will be emphasized 
with lower values. In this case, the modulation applies a random pattern, the 
intensity of which may be visualized via the "MOD" display.  

• Mix: This regulates the ratio of the unprocessed signal to the portion including 
reverberation. 

Tweak  

• Pre-delay: This knob sets time in milliseconds between the direct signal and the 
appearance of early reflections. The late delay comes only following this time 
span. 

• Diffusion: This knob simulates scatter on irregular walls in percent. Increasing 
values make the reverb sound denser. 

• Low Cut: This knob sets the filter frequency of a high-pass filter. Signal 
components below this frequency will be filtered out. 
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Tube Stage 
Preamplifier are still used today, if the signal needs a warm, flattering sound. This is 
often not only about saturation or distortion artifacts, but rather more about getting a 
compact and more vivid sound picture. A tube stage makes things a little more 
dynamic, this is not due to the tubes itself, but rather the entire circuit, which interacts 
with the tube in a way that amplification levels don't do on a semiconducter basis. As 
with guitar amplifiers, the complexity increases with the number of stages. 

 

Optionally inside the essentialFX_TubeStage plug-in, either one or two tube stages 
work.  

Tube circuits, especially if they work in the border area and saturate/distort the signal 
with the gain control, react very sensitively to the input signal's spectral composition. 

Two independent filter circuits accompany this plug-in's tube stage (s). The first 
(pre-eq) acts directly on the input signal. With this you can determine which 
frequency range should be principally edited. The second filter circuit (post-eq) is 
located behind the tube stage (or after the second) and determines the tonal balance 
of the output signal. 

This enables you to create various sound nuances. For example, you can accentuate 
the high frequency range on the input side, for example, to create Exciter-/Enhancer 
effects, so that the signal appears more "tangible". To avoid overemphasizing this 
amplified range, a reverse process with the post-EQ can be subsequently made. 

Both of the available tube stages can be globally switched in the A or AB operation. In 
the A-circuit the entire signal runs through, as is common with simple tube preamps, 
through a tube. However, since these can only edit a half-wave, the working point of 
the circuit is set approximately in the middle of the reference line. However neither 
halve will ever be treated equally, so that positive displacements are amplified 
differently to negative displacements. (so-called Class A operation). Thereby odd and 
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even harmonics are created. The typical 'warm' tube sound to a large extent dates 
back to the characteristic overtone spectrum. 

For each half-wave in class-AB operation, a separate tube is used, so that in principle 
there is a symmetrical reinforcement. The signal contains predominantly uneven 
harmonics. The sound image appears thinner but more transparent and solid. This is 
comparable to the sound, that tape machines create when they are slightly 
overmodulated. 

Tube Stage Parameter 
IN / OUT: Here you can set the input and output level. 

stages: In signal section 1 the signal only passes through the tube stages. In setting 2, 
two stages are cascaded. This divides up the gain so that both stages are driven less 
'hotly'. This increases the signal complexity and any tube artifacts. 

class A / AB Optionally, a simple gain stage with asymmetric reference line (Class A) 
or symmetric AB mode. In the A-mode odd and even harmonics emerge, the sound 
image is similar to a 'warm' tube guitar amp. In the AB section only uneven harmonics 
are created. The sound image is somewhat 'colder', but more transparent with 
complex materials and can also be driven louder. 

oversampling: If this switch is active, the virtual tube stages are controlled with 
one-to four-times the project sampling rate, i.e with an internal sampling rate of 176 - 
192 kHz. 

• pre-eq: This knob (called "Tilt" or "Level" on some devices) controls the effect of 
a soft, passive 6 dB filter for prefiltering signals before the (first) tube stage. If 
turned to the left the bass is emphasized and the highs are dampened. To the 
right the inverted filtering happens. With this filter the signal can be 
correspondingly processed before "Warming up" by selecting the prominent of 
desired section. Compared to a standard EQ the effect of this filter is more 
subtle, but it does possess a high 'musicality', by the internal circuitry and also 
because of the slightly different phase response. 

• gain: This set the entire amplification factor. If two two tube stages are selected 
using 'stages', the available Gain is divided by two and is distributed equally over 
both stages. 

• post-eq: Operation and function is like pre-eq, however, this filter is placed 
behind the (second) stage tube. 

Tweak  

• Tube Bias: With this parameter you can control "Bias", or electric current voltage 
inside a tube. 
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Energizer (plug-in) 
The Energizer belongs to the so-called psycho-acoustic processors genre. These 
devices are used in the studio, acoustic irradiation, and restoration areas in order to 
enhance the sound. 

An effect like this usually can only be partially achieved with standard methods like 
equalizing since an equalizer can only compile the frequency parts that are already in 
the signal. Additionally an excessive increase in the signal (of the highs) increases the 
chances of hissing. 

With bass the problem often arises that for each device in an analog processing chain 
(for example, tapedeck, mixing desk, pre-amp) slightly delays the signal compared to 
the remaining spectrum. This type of phase lag cannot be restored with an EQ and 
increasing the depth often results in a washed-out and feebler sound. 

Psycho-acoustic devices are based on our hearing's ability to perceive attributes like 
"freshness", "liveliness" and "naturalness" in a recording as a result of various 
parameters. One of them is the harmony spectrum. The mid and high frequency 
ranges of a loudly played instrument are richer than those of a quietly played 
instrument. The "Exciter" tries to imitate this property with artificial harmonies. 
However, this type of method cannot function statically as the noise and low-level 
signals will be influenced otherwise. 

The order in which individual frequencies are heard is just as important for lively 
sound. 

The psycho-acoustic method used in the Energizer is based on a combination of 
frequency-dependent phase correction, additional harmonics creation and recognition 
of so-called transients (short signal peaks). 

The Energizer is subdivided into a bass and middle/high area. In both of these areas, 
the audio can be enhanced independently of one another. 

The parameters of the Energizer 

 

The available effect presets cover typical areas of usage and are already set up as 
presets in order to, for example, format a CD for playback on the car radio, use as a 
soundtrack for your home entertainment system or for restoring distorted frequency 
response curves of old records. The Energizer can have a drastic effect on the sound 
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even if only small changes are made to the parameters. So that you know which 
faders to change to get the audio results you want, the following section describes the 
available faders in detail. 

Low tune: Here you can tune the bass processor to a specific input frequency 
(between 50 and 150 Hz). This is the preferred frequency at which, for example, a 
kick drum or an acoustic/electric bass is played. The phase position of the bass range 
can be influenced according to the set frequency, resulting in deeper sounds sounding 
more "succinct" and "broader". 

Low attack: Using the transient recognition fader the attack behavior of the tuned 
range can be increased (fader to the right) or decreased (to the left). You can use this 
to create a "hard" or "dynamic" bass foundation or have a range sound "legato" or 
"soft. 

Low mix: Here the processed bass signal is mixed with the unprocessed input signal. 
Please note that material that is already highly modulated may become 
overmodulated/distorted. For strong increases in the bass you should, if required, 
reduce the source material in order to have enough reserves. It is also recommended 
that you use the Audio Cleaning Lab Limiter as the next step. 

High tune: This fader specifies the input frequency of the high tone circuitry (between 
1 and 10 kHz). A part of the input signal is filtered and a phase lag is created 
depending on its frequencies. Simultaneously, the dynamic harmony is enhanced. 
When turned to the left you can influence the mids and highs of the signal so that, for 
example, the "articulation" of speech and instruments can be edited. The further up 
the frequency you go, the more the harmonies or bright sounds, like drum cymbals, 
are registered. You can use this to add "shine" or "silkiness" to your recordings. 

High stereo width: Use this fader to specify whether the signal that's added to the 
high tone processor should be edited in mono, stereo or as a broadened signal if at all. 
This way you can specify whether the range should be compiled from the stereo mids 
of a recording or from the parts of the pages (for example, room information) 

High mix: Here you can specify the amount of data from the high-frequency 
processor that should be mixed into the original sound. 

Tip: At the beginning when using psycho-acoustic devices there is a danger of 
overkill. We recommend regularly toggling from unedited signals to processed ones. 
In order to make subtle changes in the sound it is often enough that the change be 
just about audible or that when switching off the effect, you get the feeling that 
there's something missing. If the effect sounds like it's in the foreground, this usually 
means that it's exaggerated too much. 
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Analogue Modelling Suite: AM-Track SE 

 

AM-Track SE is a purely analog compressor simulation. The tape simulation 
contained in the full version (Analog Modeling Suite AM-Track 
http://pro.magix.com/de/audio-plugins/analogue-modelling-suite.175.html) is not 
included. This is used primarily for so-called "tracking", i.e. editing individual channel 
strips or subgroup signals. The compression takes place in the "vintage" setting, 
whereas an additional "vca" setting is available in the full version. The plug-in 
recognizes the number of incoming signals and, if necessary, edits the signal in mono. 

Am-Track SE limitations compared to the full version: 

• No tape simulation  
• No "VCA" mode in the compressor, only "Vintage" operation can be 

implemented along with the presets. 
• Some expert compression settings (view page 107) are integrated in the 

interface, parameters: "ahead" (pre-delay) and "adapt release" (switchable 
release automation) are missing. 

(Release automation is always activated in the SE version which corresponds to the 
set value of the mid position of the 'capacity' controller.) 

Below, the full version of AM-Track is explained and its features compared to 
"normal" software compressors and the available parameters. 

Compressor Section 
Two completely different compressors work in AM-Track, each with their own 
independent control and sound methods. You may be wondering why we mention 
sound when talking about a compressor, since compressors merely relate to control 
actions. This isn't as simple as the idea of "making loud quiet".  

Various designs, algorithms, and topologies for solving the actual problem (dynamic 
reduction), which all have their own unique character, have come from the history of 
analog and digital signal processing. For example, pre-filtering in the detector circle 

http://pro.magix.com/de/audio-plugins/analogue-modelling-suite.175.html�
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and the type of detection have a large influence on the audio results. Plenty of 
hardware compressors have the same established VCAs (voltage controlled 
amplifier), but they all sound different and influence a signal, an entire production (or 
even a genre) with their "signature sound". We intend to provide you with acoustic 
variation via these dynamic tools in the digital world. 

The two operating modes of the AM-Track may be selected using the switch 
"vca/vintage": 

VINTAGE mode 

 

This mode appears as a preset on start-up of the AM-track. It has fewer 
parameters than the VCA mode and has audibly less of a "surgical" quality, 
but more of a trimmed sound character. 

"Vintage" mode simulates a circuit design from the time when VCAs were not yet or 
could not be fully implemented. Instead, a FET (field effect transistor) was often used 
as a controllable resistor. Together with constant resistance at the circuit's gate, this 
forms a so-called voltage splitter, which is to say  it forms a resistance change at the 
FET (caused by a change in voltage at its gate) which results in a damping of the input 
signal. A very simple detector circuit is used to activate the FET which obtains its 
signal from the output of the compressor (behind the whole control circuit). For older 
designs, this feedback loop provides a stabilization of the work parameters and is one 
of the decisive factors for the often quoted soft and musical compression of 
exponents of this design, e.g. the Urei 1176 or 1178. The control circuit sees the layout 
of its previous work and oscillates to the signal. 

 

The disadvantage is that the set time parameters for attack and release depend 
somewhat on the program. In some cases,  it's actually advantageous for vocals, 
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bass, or even drums (e.g.  subgroup, ambience, mics). You should rely completely on 
your ear for this. 

Because of the feedback topology, the maximum gain reduction is usually lower 
than  VCA devices with forwards detection, usually  20  dB. This way, there is 
almost always a level matching amplifier in the feedback loop. The "drive" controller 
of the AM-Track regulates the feedback amplification here. This can be so high that 
the detector may become saturated by a loud input signal, resulting in signal peaks 
being swallowed up. Simultaneously, the setting becomes more intense as quieter 
signals also start reaching the threshold. You can creatively implement this according 
to the situation to create complex signal compression which doesn't much sound like 
dynamic compression due to the transients that slip through and release at high 
"drive" levels. 

The stated release of the signal, technically known as a ratio reduction, is also caused 
by the centerpiece of the circuitry: the FET. Level reduction works entirely as a 
function of its characteristic curve, resulting from the non-linear behavior of this 
element. The FET virtually comprises part of the input resistance of the compressor 
circuit. As a result, the input/output response curve does not create a plateau when 
"drive" is high, which would be the case for a reference line featuring a high ratio or 
even limiting. A saturated FET may no longer complete the job it was marked out to 
do, i.e. to keep its output at low Ohmic values. Once again, signal peaks pass through 
the entire circuit unaffected, but the average level could be severely compressed. 
From a technical point of view, the control process appears incomplete, but sounds 
pleasantly open and airy depending on its application.  

The entire detection is dependent on the spectral balance in the virtual AM-track 
circuit, the highs are automatically compressed less so that even extreme settings 
sound less flat and more lively. 

It's the same story with deep bass. On closer listening, you'll find that with strong 
compression the signal still retains its power which would otherwise be lost if the 
envelope were to follow shortly afterwards. 

"Vintage" mode has another feature to offer: At the output of the compressor in the 
signal path, an emulation of a transformer-coupled matching-level amplifier can be 
found. This contributes to some subtle, non-linear distortions at high levels, but is 
very much frequency-dependent. 

VCA Mode 

 

In VCA mode, the parameter selection and the circuitry design 
correspond to a modern compressor with a VCA element as the control 
circuit and a forward automatic gain control in the detector section 
("feed-forward design", i.e. the controlling signal for level reduction is 
taken from the input signal). 
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The typical basic sound for this category is accurate, largely neutral and, in relation to 
the adjustable parameters, easily predictable. 

In VCA mode, the control signal is accessed at the input where it firstly executes a 
controllable low-cut (which may be set up via  "detector hp freq" in "Expert" mode). 
The filter makes sure that deep-frequency signals have less influence on the 
adjustment settings; this is a popular trick for more power, e.g., when using drums in a 
sub-group.  

The filtered signal then arrives at the detector. With the forward gain control, 
previously set parameters apply fully and affect the adjustment settings immediately. 

 

In contrast to this, there is a "feedback" method which provides a second compressor 
mode. 

Compression Parameters 
Vintage Mode 
In this mode, you can intuitively (by ear) use the dynamic editing features with just 
three knobs. Do whatever you want, but keep in mind: less is sometimes more... 

• Drive: You can use the "drive" potentiometer to control the amplification factor 
in the feedback loop, i.e. the signal strength which the detection circuit 
calculates. Furthermore, the internal "ratio" changes within a limit, the more 
"drive" there is, the higher the compression ratio. 

• Attack and release: The same basic conditions as VCA mode apply here. 
However, not only do you change the actual control response time after 
detection, but the "temporal window" in the detector must be adjusted as well. 
Additionally, the feedback method does cause a certain amount of 
unpredictability. You should expect less control over the device in this mode, but 
more leniency on its part.  
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VCA Mode 
The regular set of parameters of dynamic compressors is available in this mode: 

• Threshold: The threshold above which dynamic reduction begins. 
• Check the threshold display if necessary (thr): If the input signal reaches the set 

threshold, the blue dash will move around the arrow symbols. If this dash moves 
upwards, the threshold is below the average level and compression is active. 
Inversely, if the dash moves below the marking, the input signal becomes too 
quiet to be able to reach the threshold; compression will be applied. 

• Ratio: This ratio (1:n) specifies by which factor the signal should be reduced 
once the threshold has been reached. For example, if the threshold is set to -20 
dB and the ratio to 1:4, an input signal of -10 dB will only be amplified by 2.5 dB 
(10 dB : 4 = 2.5 dB). 

• Attack: This is the response time, e.g. how long the project takes to execute the 
required level reduction. Short attack times intercept level peaks, and longer 
ones let them through unimpeded (compression only starts past this value). 

• Release: This is the time allocated to the circuit to reach the normal 
amplification factor. 

Note on attack & release: In general, short attacks are used for moderate 
compression and making the transient response softer; longer times retain the "bite" 
of a specific instrument at larger compression rates or make the sound a bit 
snappier. With more difficult sources, like a very dynamic vocal track (ballads), for 
example, you can use a longer attack so that the project runs more smoothly and 
quietly; the release time may be trimmed audibly to match the pauses or the song 
speed. Shorter release time may be used for modern, aggressive "close up" vocals, 
e.g. when breathing sounds are an important stylistic device and the voice should 
sound very full and compact. 

• Knee: Use this parameter to specify the shape of the characteristic around the 
threshold. A "hard knee" means that the transition of 1:1 amplification for level 
reduction occurs abruptly; a "soft knee" on the other hand starts much lower 
than the threshold and moves the characteristic softly into the reduction. A 
"hard" setting is useful for effect-filled, acoustic compression, e.g. individual 
drum tracks. A softer setting is useful for complex and sensitive sources like 
guitars, pianos, or vocals. The more complex the signal, the easier it will be to 
notice a difference. For less sensitive sources, this parameter is usually less 
important. Note that for "soft knee" settings, the "threshold" value will need to 
be re-adjusted, since the compression starts at a much lower level. 

Compression Expert Settings 
Of course, you can efficiently compress a lot of data with AM-Track without having to 
press the "Expert" button or try out additional options. However, we have added a few 
"handy" parameters behind the front panel. This applies equally to both compression 
modes. 
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• Look ahead: AM-Track is always ahead of the signal. You can specify how many 
milliseconds you want to "look ahead". The audio signal path is delayed 
according to the signal route so that the detection circuit is fed first with the 
input signal (so-called "look-ahead delay"). You can increase the attack time 
and still avoid fast peaks. The latency compensation in the host program ensures 
that other tracks in the project are adjusted and that no time delay occurs. For 
percussive signals, you can even set the delay all the way to "0". 

• Detector hp filter: This high-cut filter is positioned before the two compressors' 
detection circuit. You can use it to specifically exclude basses and mids from 
these rules. Complex signals with bass and hi information like a subgroup or 
complete mixdown produce fewer "pumping" artifacts. This is because 
low-frequency signals feature the most power and therefore always trigger 
regulation and modulate other frequency ranges in the volume 

• Auto makeup gain: Normally, you have to continuously adjust level reduction to 
generate "compression" at the same maximum level. This is done by activating 
auto makeup gain. The volume difference expected from the set working 
parameters is determined and applied as an output factor after master 
regulation. If you prefer to adjust the "classic" level reduction and amplification 
manually, you can deactivate this function. 

• Adaptive release: This is "semi-automatic", i.e. you can roughly adjust the 
release time, and AM-Track reduces it according to the current signal power 
from "a little (1%)" to "considerably slower (100%)". In "Vintage" mode, this 
regulation method is particularly intense, since it affects the feedback loop 
process. For instance, if you are editing vocal tracks or dense, complex material, 
it can sound "calmer" or more "musical" if adaptive release is activated. 

• Capacity: Adjusting the "capacity" controller sets the time response of the 
"adaptive release". The greater the capacity, the more sluggish the release 
adjustment. You can therefore influence larger parts of the compensation 
response. For instance, if you want to use vocals that have been "moved 
forward", you should use a short release time (maybe 80-100 ms) and a greater 
value for semi-automatic (e.g. 80). Vice versa, you can reduce automatic feed 
by switching the relation (smaller capacity, generally greater release time). 

• Comp mix: Parallel compression is a popular "studio trick", particularly with 
complex material. Adding the original signal retains the transients and spectral 
balance of the source. You can add compression by turning the mix controller. A 
mixed signal is particularly discreet, more transparent, and less "squishy" with 
vocals, whereby the compressed portion usually has a higher level reduction 
than without adding the original. 
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Tracks 
In the "Tracks" view you can check and edit the position and order of the tracks before 
export. 

 

 The "Tracks" buttons offer quick access to Automatic track marker recognition, 
setting track markers on all object edges or also deleting all markers. 

 freedb: Request for track information from the freedb Online CD Database (view 
page 143)  

 ID3 Editor: Opens the ID3 Editor (view page 110) for further editing of the track 
markers, track names, artists and other metadata (ID3 tags) 

 Track list: Here all of the tracks are listed by name and the name of the project 
(most often the album title) and artist is displayed above. To edit the names 
directly in the list, simply double-click on it.  

 Add album cover: Click on the cover area to add the selected cover to an album. 
If an album and artist have already been defined, an appropriate cover can be 
downloaded automatically from the Internet. But you can also load a file from 
the hard drive. 
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Track Agent 
In this dialog, all the CD tracks in the current project are displayed in a list. Every track 
can be given a name which is then shown in the master track. 

 

The track list and the buttons underneath it are always visible. You can change the 
dialog view with the "Marker/Positions" and "ID3 Tags" tabs. 

By choosing all tracks on the list, the corresponding objects are selected and the 
playback position placed at the track marker. All of the objects which belong to a track 
will also be selected and the playback position placed at the track marker. 

Previous/Next: Selects the previous or next track. 
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Play/Stop: Plays or stops the selected track. 

Close: Closes the dialog and applies the changes that were made. 

Keyboard shortcut:  l 

Markers/Positions 

 

You can edit the track markers in your project in the "Marker/Position" tab. 

Name: The name of the track. 

Set markers automatically: MAGIX Audio Cleaning Lab analyzes the audio material 
and sets the track markers automatically. 

Markers on object edges: Automatically sets track markers on all object edges. This 
option only makes sense if you have already cut (view page 57) a recording into 
separate tracks. 

Track Start: Here you can set the exact starting point of the track. The two arrows 
change the position of the track marker. This means that the track remains in the 
same position and the same order but starts earlier or later. 

Move track: The position on the CD of the track that is marked by the track marker 
can be changed by using the two buttons. 

New marker: Sets a track marker at the current playback position. 
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Delete marker: Removes the selected track marker. 

ID3 Tags 

 

In the "ID3 Tags" tab you can enter information about the artist, album, year and 
genre. This info will be included as ID3 tags when the MP3 is exported. The data is 
used by database and search functions in programs like MAGIX Music Manager. 

Track name/artist/album/year/genre: More details about the tracks (ID3 tags). 

Auto-numbering: Automatically numbers the tracks. 

Apply to all: applies the respective entry to all tracks in the project. If you want to 
apply an entry simply tick the small box behind it. This way you can standardize 
information which is imported from different files, e.g. the spelling of an artist's name 
etc.  

freedb loads the data for a complete CD or LP from a public database. For more about 
this see freedb (view page 143). 

Write ID3 tags in original file The ID3 tags will be added to the MP3 file you loaded. 
"Write all" updates all the files in the project. 
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Export 

 

In the export section, you can either save the project as audio file(s) or burn it directly 
to an audio or data CD or shared on the Internet. 

Files 
In the "Files" view you can save the tracks from the current project as audio files. 

 

 The file format, the total length of the project and the storage location are 
displayed here. 

 Settings...The default setting is MP3 files with a bit rate of 192 kbps saved in the  
project folder (view page 151). To select a different file format or storage 
location, open the advanced settings (view page 113). The changes made there 
will be applied to all subsequent exports. 

 Export: Starts the export process. 
 

Settings 
In this dialog you can adjust the settings for file export, e.g. to change the save 
location or the file format. 

In the upper part of the dialog you'll find a file explorer which you can use to set a new 
name or target folder for the audio file. Under „Last storage location” you can choose 
from a list of save locations that are already being used. 

File type: Here you can set the format for the exported file. In the "Format settings..." 
you can access the configuration options for the format. 
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Export: Closes the settings dialog and starts the export process. The changes to the 
settings will be applied to any subsequent exports. 

Format 
Wave: The audio material is exported as a standard Wave file. This is the 
conventional format for further use on Windows PCs. These files are not compressed 
and retain their full sound quality. 

FLACFLAC is the abbreviation for "Free Lossless Audio Codec". This is a freely 
savable format that can be used to compress your audio data to 50% of their original 
size. Unlike lossy compression methods like MP3 or OGG, the full sound quality is 
kept intact with FLAC. 

MP3: MAGIX Audio Cleaning Lab contains a high-quality and extremely fast MP3 
encoder. This can be used to save complete LPs including cleaning effects as MP3 
files. You can also make an MP3 CD, and for that you can use the function "Burn data 
CD/DVD (view page 120)". 

For good quality, we recommend a setting of at least 192 kbps. Sound quality will 
hardly be affected despite the compression. If you have memory to spare, full CD 
quality can be retained at 320 kbps – at approximately 1/3 of the original memory. 
This is ideal for building up a large high-quality music archive on your hard drive. 

AAC: This is a modern competitor format to MP3, which is primarily used for portable 
music players (iPod, etc.). 

Note: For exporting in MP3 and AAC formats, you may need to activate your MP3 
encoder. Simply go to "Help" >Activate additional functions. 

OGGOGG Vorbis files have all of the important characteristics of MP3 files, except 
that they do not require any kind of licensing for their codecs. – They can be freely 
decoded and encoded. Not all portable devices support this format. 

AIFF: The audio material is exported as an AIFF file. This is the most commonly used 
audio format for Apple™ computers. 

Windows Media: Exports the arrangement as a WMA format file (Windows Media 
Audio). 
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Format settings 
Output format: Here you can set the output bitrate. The bit rate is the data stream 
during playback of audio data. It is given in kilobits per second (kbit/s or kbps) and 
also determined the file size. An MP3 file that is 3 minutes long and has a constant bit 
rate of 128 kbit/s is ca. 2.8 MB in size. 

Common bit rates for music are 192 kBit for good quality, 256 kBit and more for 
excellent quality. For Internet streaming and speech recording (in mono), 128 kBit are 
enough. 

Encoder quality: The included MP3 encoder can be operated in three "Gears": An 
especially quick ("Fast"), an especially powerful for high sound quality ("Highest"), 
which however requires more time, and a compromise between the two. 

Format: Here you can set whether your MP3 file is exported in Stereo or Mono 
format. 

Variable bitrate: "Use VBR" adjusts the bitrate of the audio material, which means 
that a lower bitrate will be used during quieter parts. Therefore, VBR files are smaller 
than files of comparable quality without VBR. Instead of a constant bitrate there is a 
quality setting. Not all playback programs can process VBR correctly, some will result 
in problems during title length display or when rewinding. 

ID3 editor: Opens a dialog, where you can set ID3 meta data for files to be exported. 

Options 
Each track in its own file with names: Exports each track (i.e. the area between one 
track marker and the next) as a separate audio file. In addition to the audio files, a 
playlist file (.m3u) will also be created. This file includes the names of all the audio 
files in the correct order. It also contains the name of the project; the list field allows 
different naming schemes for the audio files. 

Scheme Example: 

(File name)_(Track number) CD_1.wav, CD_2.wav ,CD_3.wav 

(File name)_(Track number) 1 CD.wav, 2 CD.wav, 3 CD.wav 

Track name: AAA.wav, BBB.wav, CCC.wav 

(Track number) (Track name) 1 AAA.wav, 2 BBB.wav, 3 CCC.wav 

File names for a project "CD.vip" with the tracks AAA, BBB, CCC 

All tracks in one file: Saves the project in one audio file with the same name as the 
project. 
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File for track at playback position only: Saves the track that is currently placed at the 
playback position, i.e. the project area between the last track marker before the 
position line and the following track marker. This way you can cut out parts of an 
audio file and save them separately by simply placing markers. 

Play back exported file(s): After export the media player is opened to test the results 
of the export. 

Keyboard shortcut:  K 

Video 
This option allows you to export projects as video files. 

Note: The video export feature is not available MAGIX Audio Cleaning Lab.   

 

 Change video format here. If the audio track of a video that was loaded into 
MAGIX Audio Cleaning Lab has been edited, the format of the original will be 
discarded, in which case other properties of the original video will be preserved 
where possible. 

 Settings...: A settings dialog (view page 117) for the selected video format will 
open, this dialog allows you to change the properties of the exported video. 

 Once the export process has begun you will not be able to make any changes to 
settings. 
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Advanced settings for video formats 

 

The dialog will look different, depending on which video format is selected. 

Here you can adjust the settings for the exported video precisely. The options 
available vary according to the selected format.  

Presets: Under "Presets", you'll find typical settings for the selected format for the 
most important applications.  

  Click "Save" to save your own settings and "Delete" to remove them 
from the list. 

Export settings: You can specify general export parameters like resolution, aspect 
ratio and frame rate. Select the most frequently used values from the list fields; to set 
your own values click on the "..." The "Advanced" button reveals extra settings for the 
selected video format. (see below) Format description provides a summary of the 
most important core values of the exported video file and estimates the size of the 
finished file. 
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In the field below you can enter the file name for your exported file. 

 Use the folder symbol to select the folder into which you want to export. The 
dialog will remember the export path for future exports. 

The option "Overwrite file without confirmation" option allows you to execute 
multiple exports in the same file.  

Other 

Anti-interlace filter: This option should only be activated for playback on a TV screen, 
since it is intended to reduce line flickering. 

Shut down PC after successful export: Use this option to have the computer switch 
off automatically after lengthy export processes. 

Video as MPEG video... 
MPEG stands for "Motion Picture Experts Group" and is a high-performance 
compression format for audio and video files. 

Details on the settings of the MPEG encoder can be found in the program's Help file 
in the "MPEG Encoder Settings" appendix. 

Video as DV-AVI... 
This option exports the video as a DV encoded AVI. The arrangement can be easily 
transferred to the digicam using a Firewire interface. 

The dialog will provide further information on all available options. You can access it 
via "Advanced" in the export dialog. You will also be asked for which video standard 
you want to export the DV data - PAL (Europe) or NTSC (USA). 

Video as Quicktime Movie... 
Exports the project in QuickTime Movie format. This format ensures the best possible 
compatibility on Apple computers. 

Settings for video size, frame rate, and codec settings may also be specified here. The 
export dialog does not enable you to add comments, etc. to videos. 

Tip:For Quicktime files (*.mov), the Quicktime library must be installed. 

Video as MAGIX video 
Exports the project in MAGIX video format. 



 

120   

www.magix.com 

This format is used for video recording by MAGIX video software and is optimized for 
digitally editing high-quality video material. 

Video as MPEG-4 video 
MPEG-4 is the most advanced video format available at the moment. Unlike other 
formats, this provides very high-quality pictures at the same file size. 

Windows Media Export 
This is a universal audio/video format from Microsoft. Accordingly, the settings 
options in the "Advanced" dialog are very complex. 

Manual configuration 
Audio/video codec: Various codecs corresponding to the various Windows Media 
versions (7, 8, 9) are possible. Should compatibility problems arise on playback, try an 
older codec with a lower version number. 

Bit rate mode: Constant and variable bit rates are possible, most devices and 
streaming applications require constant bit rates. For VBR two pass modes the movie 
is compressed in two passes in order to optimally use the bandwidth for 
highly-compressed movies for the Internet. 

Bit rate/quality/audio format: The bit rate is decisive in defining the display/audio 
quality. The higher this is set, the better the videos will look and the larger the files 
and the required encoding time will be. For variable bit rates, the bit rate is adapted 
dynamically to the requirements of the corresponding picture or sound material. 
Either the quality value may be set between 1-100 or, for two-pass encoding, an 
average or maximum bit rate. For audio, the bit rate is set additionally by the audio 
format. 

Import from system profile (export type): For the most common methods (other 
than playback on mobile devices, with which you should use the supplied presets), 
like, for example, Internet streaming, Microsoft provides diverse system profiles to 
choose from. If you have the Windows Media Encoder 9 installed, which is available 
from Microsoft as a free download, you can edit the profiles or create your own. 
These can be loaded by pressing the "Import from profile file" button. 

"Clip info" enables the title and artist names, copyright details, and descriptions to be 
entered. 
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Audio CD 
Using the "Audio CD" button in the export section you can burn your projects as 
exact copies on an audio CD.  

 

 Capacity indicator: Standard blank CDs can hold either 74 or 80 minutes of 
audio. 

 The CD Title is displayed here and can be changed if necessary. This CD title is 
also displayed on most CD or media players when the CD is inserted. 

 Burn CD: Starts the burning process. In the background a large wave file of the 
project is exported and can be burned to CD. 

 Print CD cover: Opens MAGIX Print Studio, an included printing program which 
you can use to print a CD cover. Track information is automatically transferred 
as a spreadsheet into the print project in MAGIX Print Studio. 

 

Data disc 
This option allows the project to be burned onto a data CD or DVD in MP3, OGG 
VORBIS or WMA format. 
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 MP3/WMA/OGG: Here you can select the format. In most cases you can leave 
this set to MP3. 

 Settings..: Here you can change the format settings (view page 114) of each 
encoder. 

 Display on project length and bit rate 

 Burn data starts the burning process.  

 Print CD cover: Opens MAGIX Print Studio, an included printing program which 
you can use to print a CD cover. Track information is automatically transferred 
as a spreadsheet into the print project in MAGIX Print Studio. 

 

Share 
In this view you can share your project on the Internet on services such as 
SoundCloud, YouTube and Facebook. 

 

Simply click on the icon for the service you want to use. 

SoundCloud 
SoundCloud is an exciting Internet community for musicians, record companies and 
anyone else who wants to distribute music and communicate via songs. After 
registering with SoundCloud, you can upload songs directly from MAGIX Audio 
Cleaning Lab to your personal profile. When this is done you can add your songs to 
your own SoundCloud player and integrate it into your website or share it on social 
networks such as Twitter or Facebook. 

YouTube 
The command opens a dialog where you can set the name of the project for YouTube 
(default is the same as in MAGIX Audio Cleaning Lab), description, keywords 
(so-called "tags"), and the category for the video. After submitting this data by 
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pressing "OK", the project is exported and uploaded to YouTube®. This is why you 
have to enter your YouTube® account access data (username, etc.) to connect to 
YouTube®. If you don't have an account open your browser and go to YouTube® to 
sign up for an account first. 

If uploading was successful, your browser will open the info page for the video you 
just uploaded to YouTube® to double check your description and tags. If everything 
looks correct, just leave this page and the new video is already listed under your 
videos. YouTube® takes some time to process the video for online presentation, but 
after this period you and every web user around the world will be able to watch it. 

Facebook 
The command opens a dialog where the project name (displayed according to the 
settings in MAGIX Audio Cleaning Lab), a description and search words (tags) can be 
entered. After confirming this data with "OK", the project will be exported as a video 
and uploaded to Facebook. For connecting and transmitting the video file, you must 
log in with your Facebook username and password.  If you aren't registered on 
Facebook, first open your browser and create a Facebook account . 

After a successful upload, your browser will open to show you your video's info page 
so you can check the entered data once again. If everything is as you want it, you can 
leave the page and the new video will now appear in the list of your own videos.  
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File Menu 

New Project 
Using this option you can set up a new MAGIX Audio Cleaning Lab project (view 
page 54). 

Keyboard shortcut  E 

Load project 
Using this option you can load previously saved projects (view page 54).  

Keyboard shortcut:  O 

Save Project 
The current project (view page 54) is stored under its given name. If there is no name 
chosen, the program opens a file requester, where the path and name can be 
determined. 

Keyboard shortcut:  S 

Save project as 
It opens a file requester where you can determine the path and the name of the 
project (view page 54), under which it will be stored. 

Keyboard shortcut:  Shift + S 

Burn project backup onto CD/DVD / Burn data 
CD/DVD 
In addition to the integrated audio CD burner routines, MAGIX Audio Cleaning Lab 
contains the CD burning program MAGIX Speed burnR. It can help you burn data 
CDs/DVDs, too. 

Burn project backup on CD/DVD: The current project (including all audio files) can 
be burned directly to CD or DVD as a backup directly from the "File" menu in MAGIX 
Audio Cleaning Lab. Even extremely large files do not present a problem, since they 
are automatically distributed across several dics. The first of the backup discs 
contains a "Restore" program. This automatically begins the restore process to the 
hard disk as soon as it is placed in the drive. 
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Burn data CD/DVD: This command opens the MAGIX Speed burnR program with an 
empty burn queue for burning desired files to disc. 

Load audio file 
Switch to the Import section - File tab (view page 41) to import audio files. 

Keyboard shortcut:  W 

Load video sound 
MAGIX Audio & Music Lab Premium gives you the option of editing the audio tracks 
of video files like audio files. MAGIX Audio & Music Lab Premium can load video files 
in the following formats: DV-AVI, AVI (*.avi, suitable Codec, e.g. DivX must be 
installed), Quicktime (*.mov), MPEG1/2/4 (*.mp4,*.mv4, *.3gp), AVCHD (*.mt2) 
and Windows Media (*.wmv). 

The audio track from the video is displayed as an audio object in the master track and 
can now be edited. The video is displayed in the  video monitor during playback. A 
video preview strip (view page 28) is displayed in the the track window above the 
audio material. 

Note: The video track of a video file is loaded for display in the monitor, but can't be 
edited (cut, for example) with MAGIX Audio & Music Lab Premium. 

There are two other special video import options: 

• Show video image.If you deactivate this option, the video track is not loaded and 
displayed in MAGIX Audio & Music Lab Premium. At the end, you can export 
(view page 113) only the audio. 

• Optimize video for smooth playback in video monitor. Some video formats can 
be displayed directly in MAGIX Audio & Music Lab Premium, whereas others 
need to be converted into the internal MAGIX MXV format when opened. 
Opening them directly is faster, but places a larger demand on the system. If 
playback in the video monitor is jerky, you can use this option to convert the 
video into the resource-saving MXV format. 

Keyboard shortcut:  j 

Loading an audio CD 
Switch to the Import section - CD (view page 42) tab to import audio CDs. 

Keyboard shortcut:  Shift + D 
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Import DVD audio 
This command imports the audio contents of a DVD into MAGIX Audio & Music Lab 
Premium. 

Note: Importing the audio track(s) from a video DVD is not possible! 

Record 
With this command you can open the MAGIX Audio Cleaning Lab record dialog. 
More information on this topic can be found in the chapter Record audio (view page 
43). 

Keyboard shortcut:  R 

Export audio 
Read the section "WAV and other file formats" (view page 113) in the "Export 
section" chapter. 

Export video 
Please read more on this in the section "Video files" (view page 116) in the "Export" 
chapter! 

Internet 
Catooh – the Online Content Library 
Catooh provides you with high-quality photos, videos, and music for every theme, 
expanded by intelligent iContent with professional Soundpools, DVD menu 
templates, and brilliant MAGIX ShowMaker styles to help you make your photo, 
video, and music projects reality. All of this is available directly from your MAGIX 
software. 

Just choose "Share" from the menu "Catooh" to set up an Internet connection. 

Browse through the thematically sorted categories or view the results directly by 
entering a keyword. After downloading, you can drag the objects from the Media Pool 
directly into your arrangement. 
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Tip: Read the introduction online http://rdir.magix.net/?page=JRF6LASAR2Z3! 

Open the Online Media Marketplace 
This opens Catooh in a separate browser. 

Import media backup 
iContent (for example, 3D transitions) which you buy and download from Catooh is 
stored directly in your central My files\MAGIX Downloads\Backup directory. If you 
have downloaded these files from other MAGIX programs, then you can use the 
command "Import media backup" to make them accessible for use in MAGIX Audio 
Cleaning Lab. 

Manage login details 
These are options for managing user names (email addresses) and the associated 
passwords so that you are able to access your Online Services without having to enter 
the details each time. 

This information applies to all of my Online Services: If this option is activated, then 
the account details you have entered will be applied to all Online Services. Deactivate 
this option if you have different details for individual services, then choose the 
corresponding service via "Select service and enter the associated login details.  

Delete old projects 
The command "Delete old projects" is a convenient method for deleting old projects 
with all affiliated audio files. 

Project: All of your most recently saved projects as well as all projects contained in 
the Project folder (view page 151) are listed here. You can choose one that should be 
deleted. Use "Search for project" to add other project files from any folder to the list. 

Select the project file (.vip) that should be deleted by clicking on it. Of course, a 
project can not be opened if it is to be deleted. 

The "Open in Windows Explorer" option opens an explorer window with the folder of 
the selected project. Here you can...no longer required files manually. 

Used files: Lists the files used in the project that you want to delete. Use the small 
boxes to select the files you wish to delete.  

With "Delete" you can delete the project (.vip) and the files selected for deleting in 
the file list. 

http://rdir.magix.net/?page=JRF6LASAR2Z3�
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When you select a project you wish to delete, some files in the list, i.e. files located in 
the project folder are selected already. They are recording files, files that are 
automatically produced when importing specific formats, and back up copies. In other 
words, data which is used only within one project of MAGIX Audio Cleaning Lab. 

Files which are not located in the project folder, MP3 files from music collections or 
videos, for instance, are not selected, as you will probably use them in other projects 
or with other programs. You can select them if you're sure you don't need them 
anymore. In general, it's quite sensible to have the preset apply to the project folder 
because it allows you to simply choose a project at the top and to click "Delete" at the 
bottom to delete files which are no longer needed in a project. 

Exit 
Closes MAGIX Audio Cleaning Lab. 
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Edit Menu 

Undo 
In the project you can undo the last changes you made. This way, it's no problem if 
you want to try out critical operations. If you don't like the result, you can always 
revert to the previous state using "Undo". 

Keyboard shortcut:  Ctrl + Z 

Redo 
The “Redo” function undoes the previous “Undo” function. 

Keyboard shortcut:  Shift + Y 

Undo list 
The last 20 editing steps are listed. This makes it easy to go back to a specific editing 
step. 

Set marker 
With this command you set a marker into the track to mark a certain time position in 
the project. You can jump between the markers with the keyboard commands 
Alt+Arrow left/right. 

Keyboard shortcut  Alt+M 

Split 
A selected object is split into two objects at the position line. This also works during 
playback. 

Keyboard shortcut:  T 

Remove object beginning 
This command removes the part of an object beneath the position line, 
chronologically located before the position line. The audio material following it is 
moved forward to the initial position. 

Keyboard shortcut:  Z 
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Remove object end 
This command removes the part of an object beneath the position line, 
chronologically located after the position line. The audio material following it is moved 
closer. 

Keyboard shortcut:  U 

Cut 
The selected object is cut out from the project and placed on the clipboard. It can then 
be reinserted elsewhere. 

Keyboard shortcut:  Shift + Del 

Copy 
The selected object is copied from the project into the clipboard. It can then be 
re-inserted elsewhere. 

Keyboard shortcut:  C 

Paste 
The content of the clipboard is inserted into the project at the position line.  

Keyboard shortcut:  Ctrl + V 

Delete 
The currently selected object will then be deleted from current project. The 
subsequent objects are moved forward so that there is no gap in the track.  

Keyboard shortcut:  Del 
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Remove pauses 

 

This function automatically removes sections without or with low audio level in the 
selected object. In the dialog, you can set a minimum time and threshold for 
recognition. 

Threshold detection for pauses (dB): The threshold is set here. The value is specified 
in decibels, 0db corresponds to the maximum level. Typically you will enter negative 
values. The higher the numerical value, the lower the level and the less audio material 
is removed. 

Minimum pause length: The minimum pause time is set here. If the function removes 
intended (musical) pauses in the music, increase the value. 

Apply to all objects: If this option is activated, the function will be applied to all audio 
objects in the project. 

Voice over 
The "Voice over" effect creates a volume curve for automatically fading background 
music during spoken sections. To do this, proceed as follows: 

1. Record speech. 
2. Load your background music. 
3. Move the object containing the background music to the second track below the 

spoken portion. Note: The second track can be opened with the "2" key. 
4. Place your speech recording at the correct position, then cut and edit it with the 

object handles to remove undesired noise or mistakes. 
5. Now open the voiceover dialog via "Edit" and activate the voiceover effect. 
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6. A volume curve (view page 146) is created on the second track which 
automatically fades the background music at the correct positions. 

 

Use the faders to set by how much the volume of the background music should be 
reduced during speech passages and how quickly this should happen.  

Use the selection list to apply the curve to the first track as well, should you have 
placed your background music there. 

If you later want to move or shorten your voice recordings, click on the "Update" 
button to adjust the volume curve. 

Note: The Voice Over feature is not available in MAGIX Audio Cleaning Lab.   

Batch conversion 
Batch processing lets you automate work processes. You can extend a specific editing 
process from a single audio file to a list of files any size (i.e. the "batch"). The files are 
then executed automatically, over night, all day, or however you like. 

Possible jobs may include: 

• Normalization, volume adjustment, loudness 
• Linear fading (in and out) 
• All real-time cleaning and mastering effects 
• Removing direct current 
• Resampling/Timestretching (view page 138) 
• Format conversions: Bit width (8/16/24-bit), sample rate, 

stereo/mono/left/right 
• Save in all available export formats (view page 113). 

Examples of use: 

• Encoding a large number of wave files into MP3 while simultaneously adjusting 
volume and freshening up higher frequencies 

• Loss-free conversion of wave files into FLAC to save up to 50% hard drive space 
• Correcting multiple LP recordings with incorrect speeds 
• Denoising original sound tracks 
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The process for batch conversion is as follows: 

1. In the "Source file" tab, select the files for editing. 
2. In the "Effects" tab, select the required editing processes. 
3. In the "Time format" tab, select the output format. 
4. In the "Target files" tab, specify where and under what names the files should be 

saved. 

Note: The Batch processing feature is not available in MAGIX Audio Cleaning Lab.   

Source files 

 

 Drive 

 Path 

 Superior folder level 

 Refresh 

 File browser 

 Add to editing list 

 Editing list 

 Preview 

 File filter 

 Start editing 

Create the list of files you want to edit. You will find a file browser on the right side. 
Select the files you would like to edit by clicking them; multiple selection is also 
possible (Ctrl + click for individual files, Shift + click for series, Ctrl + A to select 
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everything). The view can be limited to certain audio formats via the file filter at the 
bottom. Every audio file can be pre-listened with the preview button. 

The "Add" button in the middle inserts all of the selected files into the editing list. If a 
folder has been selected, then all audio files in the folder, including all subfolders, will 
be added to the list. 

 
Loads a list (*.m3u format). 

 
Saves the list in *.m3u format for using your selection of files later.  

"Remove" deletes all selected list entries. "Remove all" deletes the complete list. 

Effects 

 

Amplitude 
No changes: The amplitude remains unchanged. 

Normalize/change level to: You can normalize to a specific maximum value in %/dB 
or sink/raise the level by a certain value. Read more about this in the section "Edit 
menu -> Normalize object volume (view page 136)". 

Adjust loudness: Loudness adjustment ensures a balanced average volume for each 
audio file. Read more about this in the section "Edit menu -> Adjust loudness". 

Fades at project start and end 
Linear fades of any length can be added to the beginning and/or end of files. 

Effects 
No effects: No effects editing takes place. 
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Current settings/effects presets: This section allows all cleaning and mastering 
effects in MAGIX Audio & Music Lab Premium to be used for batch conversion 
(including plug-ins). The batch processing dialog does not in fact offer direct access 
to the extensive settings options for the individual effects; instead, there are two 
choices: 

• "Current settings": All effects settings in the currently loaded project will be 
applied (except object effects). First you can load one of the edited files into a 
new MAGIX Audio & Music Lab Premium project and make the required effects 
settings in real time there. Then you can open batch conversion and apply these 
settings to all of the other files. 

• "Effects presets": You can select the cleaning or mastering effects presets 
included with the program or the ones you created yourself. 

Remove direct current: Remove direct current noise from analog recordings; see 
"Remove direct current (view page 73)" in the "Edit" menu. 

Resampling/Timestretching: Changes the playback tempo; see 
"Resampling/Timestretching (view page 138)" in the "Edit" menu. 

Target format 
File format: All export formats (view page 113) available in MAGIX Audio & Music 
Lab Premium are available here with their associated format options. 

Stereo/Mono: You can convert in stereo (mono sources feature the same signal on 
both channels), save one of the stereo channels as a mono file, or mix both stereo 
channels together to create a mono file. 

Bit resolution/sample rate: The bit resolution can be changed to 8/16/24-bit, and 
the sample rate to 11,025, 22,050, 32,000, 44,100, or 48,000 Hz. 

No changes: This means that the output format is applied unchanged. 

Destination files 
There are several ways to save edited files: 

Replace source files: The original files are replaced by the edited files. If the file is 
used in a project, then the project will be closed first. 

Save files in source directory with changed name/save files in following directory: 
The edited file is saved in the source directory or in any chosen directory. The 
specified suffix/prefix is added to the file name. Optionally, you can delete the source 
files after editing them. 

Keep source directory structure: This option saves all files including the source path. 
The folder structure is preserved if the source files originated from different folders. 
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Load/Save realtime effects settings 
Here you can save and load your favorite effect settings as "Mastering effect presets" 
or "Cleaning FX presets" so you can use them in other projects or objects. 

FX presets can be applied to the "Object FX" page for individual objects or as project 
effects for the whole sound. 

Since the available object effects are different from the project effects, some settings 
may be ignored. 

Apply all realtime effects 
If the effects settings become too full to manage or you just want to ”summarize” 
your production, use this function to convert the entire audio arrangement into a 
single audio file. It will appear as a long object in a new project. 

Once the effects have been added they will no longer require CPU power. 
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Effects menu 
Here you can open all the settings dialogs for the "Cleaning" and "Mastering" effects 
as well as other effects. The effects are sorted categorically in submenus. If the 
cleaning or mastering section is switched to object mode, the effect will be loaded as 
an object effect (view page 72), which means it will only affect the selected object 
and not the entire audio material on the master track. 

A description of the effects which are not explained here can be found in the 
sections "Cleaning effects" (view page 62) and "Mastering effects" (view page 74). 

Normalize object volume 
This function raises the volume of an object to the maximum level without the 
material being clipped. This utilizes the dynamic range the best way possible. First the 
highest levels are detected, and then the object level is adjusted so that the max. level 
amounts to 0 dB, i.e. the maximum volume (or another value between 1% and 
400%). 

Note: If you experience very slight clipping during recording and then proceed to 
normalize the material, then you won't achieve the same quality as if you produce a 
correctly clipped recording! For example, if you only modulate half of the material, 
then your recording will have a quality of 15-bit samples – normalizing to 100% 
doesn't change anything. 

 

Normalize to: Here you can set the value to which the audio material should be 
normalized by entering it into the input field, moving the fader, or selecting one of the 
presets (50, 95, 100 or 200%). The value will be shown in % and dB (100% = 0 dB = 
max.). Values above 0 dB bring about digital clipping. 
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Maximum level: Displays the highest detected peak in the selected range/object. 

Level change: Displays the level change in dB, in accordance with the selected 
normalize level and the detected maximum level. 

Different methods can be specified under "Selection": 

Normalize the selected object only: Normalization is only applied to the selected 
object. This function can also be executed in "Object FX" mode by clicking the "Auto" 
button below the volume controller (always normalizes to 100%). 

Normalize all objects separately: Each object in the project is normalized according 
to its own maximum (peak) level. The level ratios between the individual objects 
changes for this reason. 

Normalize all objects as a single unit: The maximum level is detected for all objects in 
the project, and each object is normalized according to that value. The level ratios 
between the individual objects is preserved, but only the object that contains the 
maximum level is optimally clipped. 

Start loudness adjustment: Starts normalization including the average loudness of 
objects, see Loudness. 

Shortcut:  N 

Loudness adjustment 
This function unifies the volume of the individual tracks in the project. First all of the 
levels for every object are increased separately to the maximum without clipping the 
material (see Normalization (view page 136)). Depending on the musical production, 
however, each title may have a different volume at full level, since the relation 
between loud and quiet sequences within the track also influences how we perceive 
volume. In the second step, the average loudness of the song is determined and the 
object level is adapted accordingly. 

Tracks with higher peak values but lower loudness may be normalized at a level above 
0 dB (full clipping). To avoid overloads, the limiter is automatically activated (see 
MultiMax). 

A target loudness can be given in dB. Since this is the average value, the loudness 
value is always less than 0dB; -15 is the preset. 

The degree of adjustment decides how strictly the loudness normalization is applied. 
At 0%, no adjustment is made to the target value. At a value of 50%, the level is 
raised to half the difference between the detected loudness and the target value. 
Volume differences remain between the tracks in this case. At 100%, every track is 
raised to the target value regardless of its loudness. This is only recommended in rare 
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cases because even in a single party mix, a dance hit will not have the same volume 
as a ballad.   

Tip: Volume fluctuation within a song can be balanced with the MultiMax loudness 
presets. 

Keyboard shortcut:  Shift + N 

Isolate Stereo Channels 
Displays a stereo file from two mono objects. The two mono objects are totally 
independent, are located one above the other on two tracks and can be worked on 
separately. This option is particularly suitable for removing undesirable audio 
interference that can only be heard on one channel. 

Switch channels 
This function switches the left and right stereo channels.  

This is useful for correcting recordings with switched channels. This function can be 
reversed if you don't re-select the range; opening it again will bring back the original 
material.  

Invert phase 
The sample data is inverted along the amplitude axis, which means that negative 
values become positive and vice versa. This function allows you to adjust recordings 
with different phases to one another. 

An incorrect phase occurs if during an analog recording parallel cables are switched. 
To correct such errors, some mixers have a switch that can be used to invert the 
phase of an input. If you press the switch by mistake, errors might occur as well. 

This function is reversible, so if you repeat it, the original signal is restored. 

Backwards 
When Backwards is applied the sound file will be played in reverse. This way you can 
create very interesting effects, not to mention the “hidden messages” in many songs... 
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Resampling/Timestretching 
The pitchshifting/timestretching/resampling editor opens. This effect can change the 
tempo and pitch of the audio material separately. The effect is also available as a 
mouse mode or object effect. The dialog's advanced settings options and the pitch 
changing options are missing, however. 

 

Algorithm: Selects the applied timestretching process. 

Time factor calculation: All algorithms in this dialog apply a time factor as the input 
parameter. The input fields for the group "Time factor calculation" enable convenient 
detection of the time factor from the desired new length or a new tempo in BPM in 
relation to an old tempo (required beforehand). 

Pitch (semitones): For any algorithm except resampling, the pitch can also be set 
independent of the tempo. Use the pitch fader beside the factor fader to experiment. 

Play/Stop/Play orig.: "Play/Stop" can be used to immediately control the result of the 
algorithm. "Play orig." plays the unedited material for comparison. 

Algorithms for timestretching/pitchshifting 
• Élastique Pro:This algorithm is used by default and provides optimal results for 

most audio material. 
• Élastique Efficient: This is a version of the algorithm that saves computer power 

and has reduced sound quality as a result. 
• Monophonic voice: Timestretching and pitchshifting for vocal solos, speech, or 

solo instruments. The material must not contain background noise, and 
excessive reverb may also be detrimental to the use of this method. With 
suitable material the audio quality is very high. The "Correct formant factor" 
option preserves formants if pitches are changed. These are characteristic basic 
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frequencies of the voice that are independent of the pitch that is sung. In other 
words, the characteristic discoloration of pitch ("Mickey Mouse") effect does 
not occur in this case. The formants, however, can be shifted by +/- 12 half 
tones. This achieves suitable vocal distortions. Beat markers are not evaluated.  

• Resampling: Pitch shift and tempo cannot be changed individually. This method 
requires considerably less CPU time. If the pitch is increased or the sample is 
shortened, then resampling is almost completely free of loss, and the sample 
material will suffer almost no damage. In other cases, resampling causes loss of 
overtones. For example, if the length of a 44.1 kHz sample is doubled, then the 
frequency level of the result will be limited to 11.025 kHz. The sound is the same 
as when the playback speed of a record player or tape recorder is changed. 



 

142   

www.magix.com 

CD menu 
The CD menu contains all special functions for audio CDs and CD mastering 
processes, e.g. setting CD tracks and pauses as well as the "Create CD" function. 

Set track marker 
Allows you to set a track marker at the current location of the position line. All the 
following markers will automatically receive a corresponding number. Each CD track 
needs a track marker. The minimum length for a track is 4 seconds, whereas the 
maximum length of a track is only limited by the capacity of the CD. 

Keyboard shortcut:  M 

Set Pause marker 
This function lets you set pause markers. At these points some CD-Players switch to 
absolute silence during playback until the next track marker appears. The CD-player 
displays a countdown for the next title. 

Keyboard shortcut:  Shift +M 

Set track marker automatically 
Use this option to automatically detect pauses between the tracks and set track 
markers. The audio material is analyzed for quiet sections. 

For more detailed information about the functioning of automatic track marker 
recognition please refer to the chapter „Cutting and arranging objects“. 

Keyboard shortcut:  Ctrl + M 

Set track marker on the object edges 
This function is used to set automatic track markers at the start of each object on the 
track. Before using the function, execute the "Remove all markers" command to delete 
any already existing track markers. 

Keyboard shortcut:  Ctrl + Shift + M 
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Split objects at marker positions 
This function will split all objects at the position of the track markers. 

Keyboard shortcut:  Ctrl + T 

Set auto pause length 
Audio files that have been loaded successively into MAGIX Audio Cleaning Lab are 
arranged consecutively in the project. Between the tracks, a standard pause of 2 
seconds is preset. In this dialog, the value can be modified. 

Remove markers 
This function is used to delete existing markers. First put the position line at the same 
place as the marker (snaps to marker) 

Keyboard shortcut:  Del 

Delete all markers 
This function removes all existing track and pause markers. This can be useful if you 
are going to use the "Set track markers automatically." function. 

Keyboard shortcut:  Ctrl+Del 

Delete CD track 
This command deletes a selected track marker and the corresponding audio material 
from the position of the track marker to the next track marker. The audio material 
following it, is moved closer. 

Keyboard shortcut:   Alt + Del 

Create audio CD 
This option does the same thing as the "Audio CD" button in the export section. 

Keyboard shortcut:  B 
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Show CD-R drive information 
This dialog shows you all available information on the active CD-writer. This includes 
the manufacturer, product name, product revision, cache and the features supported 
by the drive. 

Show CD-R disc information 
Displays all available information on the CD inserted in the drive. The most important 
feature is the maximum length, which cannot be exceeded during production, for 
example: 74 minutes and 59 seconds. 

ID3 Editor 
This opens the ID3 Editor (view page 110). 

Keyboard shortcut:  L 

Print CD cover 
MAGIX Audio Cleaning Lab contains an easy-to-use CD print studio. Here, you can 
design and print not only simple track listings, but also sophisticated CD covers, CD 
booklets, and circular CD labels. The track information is automatically transferred 
from the playlist to the print studio. 

Get CD track information online (freedb) 
You can retrieve the track information for imported CDs from the Internet using the 
Online freeDB Query function. This query is based on the exact combination of track 
lengths and the order of all tracks on an album. This also works if the tracks are 
loaded into the project individually (e.g. as MP3 files) and are in the right order. If the 
track lengths differ here by a few seconds from the exact track length, the correct CD 
should still be recognizable. 

Query album information recording online 
(freedb) 
When recording cassettes or records onto your computer, one large file is created in 
which all tracks are arranged one after the other without track markers, much like a 
CD. You can, of course, use the function "Set track marker automatically" to analyze 
the audio material and, with the help of the pauses, separate the file into individual 
tracks. This does not work, however, when the tracks run into one another without a 
pause. 
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In this case you can ascertain the exact track division by querying the Online freedb 
CD database. To do so, proceed as follows: 

1. Start up your Internet browser and go to the freedb search page by pressing the 
"Start Internet search" button. 

2. Enter the name of the album or band into the search field. One or more albums, 
which match the search request, are listed. If you know that a certain album fits 
your recording, then click on "Details". It will display the CD track list you were 
looking for alongside other details. 

3. Click on the link above the disc ID (a combination of 8-digits of numbers/letters, 
e.g. 7e120419). freedb data record  is displayed for this CD. 

4. Copy the URL (Internet link) from the address bar of your browser onto the 
clipboard. 

5. Change back to MAGIX Audio Cleaning Lab and enter the Internet link into the 
text field in the lower portion of the dialog. Then click on "Apply CD data". The 
CD tracks will be added to the project. 

Warning: Sometimes the first track may begin very quietly (for instance an intro or 
applause in live recordings) and the start of the recording occurs too late. Due to 
this, it may happen that the length of the first track does not correspond to the track 
length suggested by the database. As a result, all track markers will be a little bit too 
far back. In this case, move the second track marker forward while holding down the 
Ctrl-key; all subsequent track markers will then be moved by the same amount and 
should be positioned appropriately at the start of each track. 

CD info options 
Here you can start different advanced options for "freedb CD Database". 

freeDB > Submit CD to freeDB 
You can add CDs in the online CD database. The enormous freedb project exists 
courtesy of the contributions made by worldwide users. 

If you have a CD that is not in the database, you can enter the CD information. 

• Make sure the right CD is in the drive. 
• Select "Enter New CD in freedb " 
• Enter the information, double-checking the details for possible errors. 
• Press "OK" 
• Within an hour or two, the new information will be online for everybody to 

access. 
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freeDB user preferences 
User info is entered here for MAGIX Audio Cleaning Lab to use when freedb is 
queried. Of course, using freedb is completely anonymous, but freedb often has to 
process several queries at once, so an i.d. is assigned to identify the user. If you have 
problems accessing info, maybe someone is using the same data; you can change the 
settings to avoid this problem. 

freeDB proxy options... 
If you are having difficulties connecting to the freedb server, then you can choose 
another server from the list, or you can increase the "timeout" value. An increased 
work load causes the server to react slowly and a connection cannot be made 
properly. 

freeDB > Delete freeDB Cache 
The freedb online database creates a cache on your hard disk, containing all data 
available via the freedb button. This allows you to access the data without having to 
go online. You can of course delete the cache, should it contain false data or when 
up-to-date current data is available. 
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Options menu 

Mouse mode 
"Mouse modes" are your tools for working in the track window of MAGIX Audio 
Cleaning Lab. For most processes the preset Edit mouse mode is sufficient. However, 
in the "Options" menu you'll find other modes for specific tasks. Depending on the 
mode, the function of mouse-clicks in the project changes. The current mouse mode 
is indicated by the appearance of the mouse pointer in the track window. 

Edit mouse mode 
The Edit mouse mode is preset. You can take care of all important tasks with this 
mode. Select objects in the track window with a left-click. Selected objects can be 
moved using drag & drop. All subsequent objects are also moved so that no 
unwanted gaps develop later in the track. 

In Edit mode you can use the 5 handles to fade or shorten all objects or to adjust the 
volume. Right-clicking on an object opens the context menu where you can select 
important editing options for the object. 

Keyboard Shortcut:  V 

Range Mode 
In Range Mode you don't edit object with the mouse but ranges of audio. For  more 
information, see Range Mode (view page 33) in the "Track window and constant 
control elements" chapter. 

Note: This feature is not available in MAGIX Audio Cleaning Lab. 

Volume draw mode 
In Volume Draw mode the volume curve can be "drawn". This way, you can create 
irregular volume progressions quickly. 

To delete volume curve points, double-click on the corresponding point or click on a 
point in the Delete Object mode. 
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Wave draw mode 
Repair short distortions such as crackling directly in the wave form of the audio file by 
using the Wave drawing mode. These distortions usually only last a few sample 
values, so you can use the mouse and try to draw along the original waveform without 
the distortion. 

There is an automatic zoom function in the wave form display when you switch into 
the Wave drawing mode, so sample values become visible. 

Warning: Unlike other editing of the master track which only affects the project, this 
mode lets you work directly with the Wave audio file, i.e. with the recorded raw 
material. The latter is changed directly and permanently. Create a backup copy so 
you can undo changes. This automatically occurs when working with MP3 and other 
compressed formats, since such files have to be converted into the Wave format for 
this function. 

Resampling/Time stretching mouse mode 
This mode lets you change the playback speed of objects with the mouse so that they 
are better aligned. This mouse mode can be found in the "Options" menu.  

You can use this mouse mode to stretch or compress the object using the lower 
handle at the rear. The mouse pointer turns into a clock. 

Resampling mode (preset) can be used to change speed and pitch just like on a tape, 
i.e. speed and pitch are changed together as one. If an object is compressed with the 
mouse, the speed and pitch increase just like a tape when it is played faster. 

In the Time Stretch mode, the pitch remains unchanged if the object length and with it 
the speed are changed. 

You can change modes by switching to the cleaning effects, selecting "Object" editing 
and then selecting time stretching from the tempo/resampling effects presets list. 

Edit spectrum directly 
With the mouse mode "Edit spectrum directly" you can remove specific noises from 
the sound spectrum of the audio material. 

The view of the master track changes to Spectral display (view page 32). You can 
create an area around the noise with your mouse.  Its size is still adjustable 
afterwards by simply stretching the handles on the frame. 

Four buttons are located at the frame of the disturbances. 



 

 

Options menu 149 

 

 

 Click the upper play button to hear the impact of the effect by playing the 
corresponding passage with filtering. 

 By clicking at the checkmark the editing will be calculated into the audio material 
instantly. A copy of your original material has been automatically saved 
beforehand so you can undo any editing (Ctrl + Z).  

 For comparison you can play the same passage without filtering with the lower 
play button. 

 By clicking  the crossmark you delete the frame and cancel the filtering process. 

Note: Spectral Edit mouse mode is not available in MAGIX Audio Cleaning Lab.  

Display volume curve 
This option activates the volume curve. 

For more about this, please refer to the chapters "Cutting and arranging objects" 
(view page 54) and "Track window" (view page 26). 

Lock/Ripple/Freely moving objects 
Options of the "Ripple" button. For more about this, please refer to the section 
Deleting and moving objects (view page 57). 
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Playback parameters 
This option opens the playback parameter window. 

 

Audio line-out: Here you can specify the output of the sound card that will be used for 
playback. This is particularly important if you have a sound card with several outputs 
or if you have several sound cards in your computer. The lower entries in the list with 
the added prefix WASAPI use the more modern driver model of the same name. 

? Here the supported audio formats of the sound card and the sound card driver 
information can be displayed. You can also toggle between driver types (MME and 
WDM). Adjust this setting only if you have problems with audio playback or 
recording. If WASAPI was selected for the audio line-out, the dialog also includes the 
option of switching the device mode between "Shared" and "Exclusive" besides the 
settings for the audio buffer. For recording the output of other programs (view page 
51) (e.g. browser), "Shared" mode must be used.  

Sample rate: This sets the sample rate of the project. For maximum sound quality, the 
sample rate of the project should agree with the sample rate of the recorded or 
imported material. 44 kHz is preset. If you are planning to edit video sound, you 
should change the sample rate before importing video files (whose audio track is 
mostly available with 48 kHz). 

Playback buffer: If many effects are subject to dropouts during playback on older 
computers, you can increase the length of the playback buffer here. But this also 
increases the reaction time of the program when starting and stopping the playback 
or recording, and when changing the effect parameters. 

Autoscroll: If active, the displayed section of the position line follows; "Soft" and 
"Scrolling" can be selected to choose between page-by-page scrolling and soft 
scrolling. 

Keyboard shortcut:  P 
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Units of measurement 
This sub-menu allows you to determine different units for the timeline. You can 
choose between samples, milliseconds hour/minute/second and CD frames. 

Keyboard shortcuts: 

Samples    Shift + 1 

Milliseconds Shift + 2 

h:min:sec Shift + 3 

Min:Sec:CD frames  Shift + 4 
 

Mouse snap active 
When the mouse grid is switched on, the objects snap into place beside one another 
so that everything fits in seamlessly. 

Auto crossfade mode active 
With every cut the two objects that are created are slighlty crossfaded in order to 
avoid crackling. This is referred to as "Auto crossfading" (for more info on crossfades 
please also see Crossfading objects (view page 55)). As all recorded and imported 
objects can be easily faded  – which is not always desired – this option can be 
deactivated. 

Display values scale 
The right edge of the track view shows a values scale. This indicates the level of 
waveforms in dB, and the spectral display indicates specific frequencies in Hz. 

Options for track marker recognition 
For more detailed information about the functioning of automatic track marker 
recognition please refer to the chapter „Cutting and arranging objects“ (view page 54). 

Settings for recordings of vinyl/tape/speech and audio books/digital: These are 
presets for various types of media. If you make adjustments to the following 
parameters, these changes will be saved in the presets. 

Minimum pause length: The higher this value is set, the fewer the number of pauses 
that will be detected. If the value is set too low, it can also happen that very short 
breaks during a song will be recognized as pauses. 
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Minimum track length: A new marker will only be set when the time between the last 
track marker and the pause is at least this value. For example, if you want to burn a 
CD of pop songs from a cassette, you can set the track length to around 2 minutes. 
However, if you are working with a cassette with very short audio segments, you 
should set this value accordingly. 

Maximum (Minimal) level for pauses: MAGIX Audio Cleaning Lab searches for 
logical volume levels during pause recognition. If too many (an therefore incorrect) 
pauses are found, you should move both sliders further to the right. If not enough 
pauses are marked, you should move the sliders to the left. 

Recognition of cassette or LP sides: In some cases you may want to record both sides 
of a record one after the other without having to interrupt the recording process. The 
result is usually a very long audio file with a very quiet section in the middle. MAGIX 
Audio Cleaning Lab then only finds one pause, recognizes the situation, splits the 
recording into two objects at this position and reattempts the process using these two 
objects. In the best case, the noises created when the record or cassette is turned 
around are also removed. 

Path settings 
In this dialog, you can set the memory path for your recorded audio files (New 
projects) as well as the search path for VST plug-ins. 
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View Menu 

Display 2 tracks / Display 4 tracks 
Switches the track view to two or four tracks. For more information, see Number of 
tracks (view page 32) button. 

Note: The Additional tracks are not available in MAGIX Audio Cleaning Lab.   

Keyboard shortcut:  2 

Stereo display 
Using this option you can switch the view of the wave shape, which splits up the 
material between the two stereo channels. This view is useful to visually control the 
material in the stereo panorama or to find zero-crossings for cutting operations. 

Keyboard shortcut:  Tab 

Spectral display 
Spectral display equates the X axis (horizontal) to the time dimension. In contrast to 
the waveform display, whereby the height of the waveform only indicates the total 
level of the signal, the spectral display shows the level of each of the audio signal's 
individual frequencies. The actual level of each frequency is indicated by the color of 
the points in the spectrogram image. 

 

The whole color spectrum is used to display the volume of individuals frequencies. 
Pink indicates loud sounds in a frequency range, green indicates the areas with middle 
volume and red the very quiet sounds (in the preset color palette). Black is used for 
silence and white for maximum volume. Other different color palettes can be selected 
in the menu "Options -> Spectral display". 
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The spectral display is significantly more processor-heavy than the normal waveform 
display, so redrawing after a section changes is always slightly delayed. This delay is 
increased the further the zoom is extended, since MAGIX Audio & Music Lab 
Premium needs to include more and more data for calculation of the display. For this 
reason, spectral display is only available from a certain zoom level. 

Spectral display of the audio enables specific disturbances in the audio material to be 
detected. Crackling can be recognized by vertical lines across the entire frequency 
spectrum; continuous disturbing sounds can be detected by horizontal lines.  

This display also makes it easier to find sections in a song quickly, since instrumental 
changes can be clearly seen in the spectrum. On the other hand, the waveform 
display will not indicate changes if the volume level does not fluctuate. 

Note: The spectral display is not available in MAGIX Audio Cleaning Lab.  

Overview mode 
Use the "Overview mode" in the "Options" menu to show or hide the overview track 
(view page 28).  

Maximize Upper/Lower/Info area 
Maximize quickly the according screen areas, for more info see Changing the size of 
sections in the program interface (view page 40). 

Keyboard shortcut: Maximize upper section  F5 

   Maximize lower section  F6 

   Maximize Info area  F7 
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Share menu 
The Share menu provides access to online social networks as well as transfer 
functions to other MAGIX programs.  

Here you'll find options for uploading individual objects in the Arranger or files from 
the Media Pool as well as the entire arrangement, as audio or video. You can also 
transfer your arrangement to another MAGIX program (if it is installed) in order to, 
for example, use it as background music for your slideshow. 

Use as background music 
Converts the project into MP3 and forwards it directly to a MAGIX video editing 
program (e.g. MAGIX Movie Edit Pro deluxe MX) where it can be used as background 
music.  

Note: This function is only available if you have installed an appropriate MAGIX 
program.  

Add to music collection 
Converts your arrangement into MP3 format and sends it directly to a MAGIX music 
management program (e.g. MP3 deluxe MX), where it is added to an existing music 
collection.  

Note: This function is only available if you have installed an appropriate MAGIX 
program.  

Publish online 
Publishes the project or single tracks form it on various online platforms. For more 
information please refer to Export section > Share (view page 121). 
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Help menu 

Help 
Open the program's help file. The help file provides explanations of all functions in the 
program and step-by-step instructions. 

Keyboard shortcut:  F1 

Display tips 
Determines whether the tooltips are displayed or not. If activated, a small help 
window will be displayed as soon as you hold the mouse over a button for a while. 

Tutorial videos... 
This plays a tutorial video for MAGIX Audio Cleaning Lab. An Internet connection is 
required. 

magix.info 
Share your knowledge & get answers This MAGIX service offers you and the MAGIX 
Community at large a central platform for exchanging knowledge, photos, videos, and 
music, for discussing and evaluating, for communicating with one another, for 
presenting yourself, and networking with other members.  

You will find the sections "Questions & Answers", "Show & Discuss", "Online 
Training", and "Chat" where you can play an active or passive role in the MAGIX 
Community. For this there's not only the www.magix.info portal, but magix.info 
directly in your product. 

Ask questions online 

If you have questions or problems with your MAGIX program or you're looking for 
tips & tricks concerning multimedia, then you're at the right place. 

Display all questions & answers... 

Use the questions which other community members have asked and the collective 
knowledge of the answers to improve your own working methods, to solve problems, 
and to get to know the details of MAGIX Audio Cleaning Lab. 

Launch the online training center 
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Learn not only theoretically, but also practically what the program is capable of: 
"learning by doing", quickly and uncomplicated. 

Let your friends view the contents of your MAGIX.info screen over the Internet on 
their PCs. 

Ideal for viewing photos and videos together or for receiving support for questions 
arising during your creative workflow while using the program (a licensed client will 
be installed for this purpose). 

Register online 
This option opens the MAGIX homepage for online registration where you can 
register as a MAGIX user. Registration grants you access to the MAGIX support 
website where various program updates and help programs can be downloaded. 

Update online 
Update your program to the newest version by downloading any available patches 
from the Internet. 

Deactivate Program 
This menu item deactivates MAGIX Audio Cleaning Lab with immediate effect. After 
deactivation, it is possible to immediately install and activate MAGIX Audio Cleaning 
Lab on another computer  

About MAGIX Audio Cleaning Lab 
Copyright notices and version numbers are displayed. 

Restore original program behavior 
This command resets all settings of the program to the delivery status. 

Language 
Here you can switch the language of the program interface. After changing the 
language, the program is restarted. Note that the help and manual continue to be 
available only in the language in which the program was installed. For a completely 
different language version, you have to reinstall the Audio & Music Lab. Choose the 
required language using the flag at the lower edge of the start window of the 
installation program. 
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Keyboard layout and mouse-wheel support 

Keyboard layout 
Sections 

Import Ctrl + 1 

Cleaning Ctrl + 2 

Mastering Ctrl + 3 

Tracks Ctrl + 4 

Export Ctrl + 5 

Menu functions 

New project E 

Load project O 

Save project S, Ctrl + S 

Save project as Shift + S 

Load audio file W 

Load video file J 

Loading an audio CD  Shift + D 

Recording Shift + R 

Export audio (Wave) K 

Close Alt + F4 

Undo Alt + Back, Ctrl + Z 

Redo Ctrl + Y 

Set marker Alt + M 

Split T 

Remove object start Z 

Remove an object end U 

Cut Shift + Del, Ctrl + X 

Copy Strg + Ins, Ctrl + C 

Insert Shift + Ins, Ctrl + V 

Remove (delete) Del 
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Batch processing Shift + B 

Normalize object volume N 

Loudness normalization Shift + N 

Set track marker M 

Set pause marker Shift + M 

Set track marker automatically Ctrl + M 

Set track marker on object edges Ctrl + Shift + M 

Split objects at track marker positions Ctrl + T 

Remove all markers  Ctrl + Del 

Delete CD title Alt + Del 

Create audio CD B 

ID3 Editor L 

Edit mouse mode V 

Playback parameters P 

Measurement units Shift + 1...4 

Mouse snap active Ctrl + R 

Display values scale #, ' 

Display 2 tracks 2 

Stereo display Tab 

Maximize upper section F5 

maximize lower sectio F6 

Maximize Info area F7 

Help  F1 

Search Ctrl + F 

Transport functions 

Playback/Stop Space bar 

Pause , 

"Emergency" stop during playback  Esc 

Back to the start Home 

To the end End 
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Playback/Stop Space bar 

Fast forward (rewind) Arrow left (right) 

Playback position to next (previous) 
track marker  

Alt + arrow left (right) 

Playback position to the next (previous) 
object edge  

Shift + Alt + arrow left (right) 

Keyboard shortcuts for zooming the display are outlined in the chapter Zoom 
commands (view page 29). 

Mouse wheel support 
Click on the middle mouse button  Start/Stop playback 

Wheel Horizontal scrolling 

+ Ctrl Horizontal zooming 

+ Shift Vertical zooming 
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If you still have questions 

Tips for Program Help 
When the program is open, you can access the Help feature by pressing F1 on your 
keyboard. The program Help contains tips on how to use the program and lots of 
additional information. Many important terms are indicated in the text in italics. 
Simply click on these terms for a more detailed explanation of what they mean. 

Context Help: Press the "F1" key on your keyboard at any point in the open program 
and Help will open with the matching help topic. 

Search function: This feature can be used to look for specific words in the Help 
section. Enter either the individual word or use logical operators (e. g. OR, AND, 
NEAR) to refine your search if you have several search words. 

• OR (between two words): all topics which contain both words or one of the 
words will be listed. 

• AND (between two words): only those topics will be listed which contain both 
words. 

• NEAR (between two words): only those topics will be listed which contain both 
words. A maximum of 6 additional words are allowed between two search 
words. 

• NOT (before a word): topics which contain this word will not be listed. 

Print: The print function can be used to print out specific Help topics or entire topic 
sections. The print button is located at the very top of the toolbar in the Help window. 

System requirements 
Operating system: 
Microsoft Windows Vista | 7 | 8 | 8.1 | 10 

Minimum configuration: 
• 1 GHz processor or higher 
• RAM: 2 GB 
• Hard drive memory: 1 GB 
• Graphics card resolution 1024 x 768  
• 16-bit sound card 
• CD-ROM drive 
• Internet connection required for activating and validating the program* 
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*Software can also be used offline. Please note, however, that the software requires 
an Internet connection at least once a month to validate your license.  

Optional: 
• Burn CDs/DVDs with CD/DVD±R(W) recorder 

Uninstalling the program 
If you would like to uninstall MAGIX Audio Cleaning Lab, go to the Control Panel and 
select "Software" or "Programs and Features". 

Serial number 
A serial number is included with each product. This serial number is required for 
software activation. Please store this number in a safe place. 

What does a serial number do? 
With a serial number your program license is clearly assigned to you and only you. 
This allows you to use the free customer service via email.  

Serial numbers also help protect against software piracy. This makes it possible for us 
to offer our customers the most value for their money. 

Where is the serial number located? 
The serial number is on the insert card in the program box. 

If you have purchased the download version, you will receive a confirmation email 
containing the serial number that you can use to activate the program. This will be 
sent immediately following purchase to the email address you provided. 

When is the serial number needed? 
The serial number is required when you start the program the first time, as well as for 
program registration. 
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MPEG-4 encoder settings 
MPEG-4 is actually a collection of highly efficient codecs for video and audio based on 
the MPEG standard. Compared to MPEG-2, the same quality can be achieved with 
smaller file size. 

Recommendation: Check the presets that the program offers to find the right preset 
for each application and the right playback device. These presets are optimized for 
typical applications. 

The advanced settings in "Advanced" are divided into "Video", "Audio", and 
"Multiplexer".   

Under "Video“ there is a choice between "MPEG-4 Simple" (MPEG-4 
Visual/MPEG-4 Part 2)  (view page 168)and "MPEG-4 H.264" (AVC/MPEG-4 Part 
10) (view page 163).  

Depending on the purpose of application of the material to be exported, either one of 
these encoder settings can be selected for compressing the video material. Refer to 
the manual for the playback device to find out which encoder is supported. 

Under "Audio", "AAC" (view page 171) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available.  

Under "Multiplexer" you can adjust certain presets, e.g. container format and 
streaming properties. This is only recommended for experts. 

The option "Export as website" also creates an HTML page in an integrated Flash 
player that can play back the video created. Read the topic "Embed Flash videos into 
your own web site". 

Tip: First, check if there is a suitable preset in the export dialog for your purposes. 
Advanced users can make specific adjustments to these three areas using the 
advanced settings. 
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Video codec 
MPEG-4 H.264 
The MPEG-4 H.264/AVC codec is suitable for all types of material; however, it 
requires relatively higher CPU power for later decoding. 

In the advanced encoder settings of the AVC encoder the "Generic" options in "Main 
Settings" are mainly interesting. 

The AVC preset and video format can be adjusted here. For instance, if DVD quality is 
desired you should select "DVD". The video format should be selected specific to the 
country so that the material can be played on the devices most commonly available in 
these countries. For instance, you should select PAL for Germany, SECAM for France 
and NTSC for the US. 

MVC 
MVC: Multiview Video Coding (MVC) is an expansion for stereoscopic applications. 
Activate this to export MVC files.  

Note: MVC is only available in the Video deluxe Pro versions. 

2-pass 
The video to be exported will be encoded twice. The first run-through serves to 
calculate the streaming rate for each section (for video this is per frame). The second 
run-through is when the actual video is created with the streaming rates that were 
calculated in the first run-through. The result is an improved image quality, but 
encoding takes place approximately twice as long. 

Smart Render and Smart Copy 
Smart Render lowers the demand on the encoder for AVCHD material. In the 
production of AVCHD files, only those parts of the movie that were changed in the 
program (e.g. by video cleaning or effects) are re-encoded. Please note: The AVCHD 
files contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

The Smart Rendering special mode „Smart Copy“ enables AVCHD material to be 
transferred without having to encode it for the target medium which greatly increases 
the encoding speed. The video material cannot appear to have been altered in any 
way, only hard cuts (without fades) are permitted. These won't be executed precisely 
to the frame, but rather take place at the next GOP borders. For this reason, cuts 
should be set somewhat more generously. 
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Hardware acceleration - CUDA, Quick Sync Video, OpenCL 
MAGIX Audio & Music Lab Premium supports hardware acceleration for AVCHD 
exports as well as AVCHD and Blu-ray discs. This can noticeably speed up the 
encoding process. 

The hardware acceleration that is applied depends on the encoder being used and the 
hardware built into the system. 

• Quick Sync Video: Intel processors starting with „Sandy Bridge“ when using a 
standard MPEG-4 encoder (view page 162) or a Main Concept MPEG-4 
encoder (view page 162). 

• CUDA: NVidia graphic cards when using a Main Concept-MPEG-4 encoder 
(view page 162). 

• OpenCL: AMD graphic cards when using a Main Concept MPEG-4 encoders 
(view page 162). 

Note: Ask your graphics card manufacturer whether your graphics card supports 
hardware acceleration.  Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it in the "Encoder 
Settings" dialog under "Advanced..." > "Hardware acceleration". 

Advanced video settings 

Generic 

AVC preset 
This is where the actual video stream that will be exported is selected. 

• Baseline: According to ISO/ICE 11172-1/2 standard 
• Main: Corresponds with ISO/ICE 13818-1/2 standard 
• High: High Profile 
• SVCD: Corresponds with MPEG-2 Super VideoCD 
• D1: Corresponds with MPEG-2 DVD 
• DVD: DVD video 
• Blu-ray: Blu-ray-Disc 
• Blu-ray HD: Blu-ray-Disc in High Definition 
• Sony PSP: Sony PSP-compatible format 
• HD 1280x720p: High Profile with a resolution of 1280x720p (progressive) 
• HD 1440 x 1080i: High profile with a resolution of 1440 x 1080i (interlaced) 
• Apple iPod: Apple iPod-compatible stream. 
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Profiles 
Profiles 

Profiles define the encoder properties that are supported. 

• Baseline profile: The basis of applications with limited computing performance, 
especially for video conferences or videos on mobile telephones. 

• Main profile: This profile was originally intended for the broadcast industry and 
for backup purposes. It has become less popular since the development of the 
"High Profile" for this purpose. 

• High profile: This profile is used for broadcast and backup applications, and it is 
also used sometimes in the HDTV industry (High Definition Television). This 
profile is used for HD-DVD and Blu-ray Discs, for example. 

Level 

H.264 defines different levels. The level determines which bit rate and resolution are 
possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 

Frame type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Progressive Frame: A single image from a video sequence, also called a 
fullscreen. 

• Interlaced Field:  This is half an image. Two of these are combined to produce a 
frame. Read more about this explanation regarding "Interlace (view page 175)". 

• Interlace Frame: The encoder creates a „Frame field“ which is the basis for the 
encoding. 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 175)". 

Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
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Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Constant quantizer: In this mode, a fixed colour quantization is used for the 

macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 175), P-Frame, or 
B-Frame (view page 176)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 

• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 
rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

Pass 
Here you can choose whether you want to manually perform one-pass or multi-pass 
encodings (2-pass, multi-pass) 

Note: The 2-pass option in the main dialog of the MPEG-4 export is recommended. 
This automatically performs two encoder passes. 

If you want to perform 2-pass encoding manually, you must select "Multi-pass 
analysis" in the first pass and "Multi-pass encode" in the second pass. 

• Single pass: The encoder process takes place without prior analysis. This 
requires the least amount of time.  

• Multi-pass analysis: Analysis data is calculated during encoding and used for 
multi-pass encoding. 

• Multi-pass encode: Assumes that an analysis has already been performed The 
analysis data is used during encoding to optimize the results. 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 
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HSS rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. "Use HRD" must also 
be activated. 

Aspect ratio 
In the film industry, this is an indication of the ratio between width and height of a 
rectangle, monitor, or screen.  

There are 3 different sizes available: 

• Picture Aspect Ratio (also Display Aspect Ratio, DAR): This indicates the 
desired aspect ratio of the video to be exported. Here are some examples of 
typical aspect ratios: at home 4:3, 16:9 (typical for TV sets) or 16:10 
(widescreen-flatscreens, widescreen notebooks), 3:2 for 35mm films and 
photos. In cinemas you mostly find 1.85:1. 

• Pixel Aspect Ratio (PAR, pixel aspect ratio: Indicates the aspect ratio of 
individual pixels. The majority of computer monitors have quadratic pixels 
(PAR=1:1), for analog television monitors (PAL at 4:3) 128:117. 

• Sample Aspect Ratio (SAR, also Storage Aspect Ratio): Aspect ratio of the saved 
resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture 
aspect ratio and pixel aspect ratio: SAR = DAR / PAR. 

Note: In the standard case, the "Aspect ratio" remains set the way it is. You should 
only change the settings if the resulting video is exported distorted or stretched or if 
you need to correct the video because it is in the wrong aspect ratio. 

GOP structure 

Max GOP length 
Determines the maximum GOP (view page 174) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 

Max b-frames count 
The maximum number of b-frames (view page 176). Several cases of application, e.g. 
video conferences require "no b-frames" in order to achieve the shortest possible 
reaction times during transfer. 



 

 

MPEG-4 encoder settings 169 

 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 175) after a scene change.  

MPEG-4 simple 
If MPEG-4 H.264 cannot be played back on your device, use MPEG-4 Simple. 

Note: We recommend that only advanced users make adjustments to the advanced 
settings. You can use the technical specifications of your playback device to help 
with this. 

Advanced video settings 

Generic 

MPEG-4 preset 
Different presets located within the encoder. 

(A)SP@L0-L5: (Advanced) Simple Profile in Level 0-5 

(Q)CIF (Common Intermediate Format): CIF is a video format produced as soon as 
1990 with the video compression format H.261. At that time, the format was used for 
video telephone conferences. 
The "Q" in QCIF stands for "Quarter", and since resolution is halved in terms of height 
and width compared to CIF, the entire size is only a quarter of CIF. 
QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 
144 pixels was sensible for the first affordable SmartPhones (144 x 176). 

(Half)D1: D1 corresponds with MPEG-2 DVD. HalfD1 has exactly half of the entire 
number of pixels, meaning that the pixel number of the height and weight is 2/3 of D1. 

720p: Video stream with a resolution of 1280 x 720p (progressive). 

Apple iPod: Apple iPod-compatible stream. 

Sony PSP: Sony PSP-compatibler stream. 

Profile/Level 
Profiles: Profiles define the encoder properties that are supported. 

Level: The level determines which bit rate and resolution are possible for the video.  
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Picture type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Frame: A frame is a single image from a video sequence, also called a full image. 
• Field: A half-image, two of which combine to produce a frame. Read more about 

this explanation regarding "Interlace (view page 175)". 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 175)". 

Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 

Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 

rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

• Constant quality: Similar to the "Variable bit rate" mode, the bit rate varies 
according to the video material. The quality depends on the selected profile and 
can be changed. 

• Constant quantizer: In this mode, a fixed colour quantization is used for the 
macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 175), P-Frame, or 
B-Frame (view page 176)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 



 

 

MPEG-4 encoder settings 171 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

Max. rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. 

Pixel aspect ratio 
Specifies the page ratio of the individual image points (pixels). 

Meaning: Different television norms and the standard pixel ratio. Select a setting and 
the results are displayed as "X" and "Y". 

X/Y: The actual pixel ratio. If under "Meaning" the setting "Custom" is selected, then 
a custom ratio can be set. 

GOP structure 

Max key interval 
Determines the maximum GOP (view page 174) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 

B-frames count 
The number of B-Frames (view page 176). Several applications, e.g. video 
conferences, require a setting of "0" for this, i.e. no B-Frames, in order to enable the 
shortest possible reaction times for transfer. 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 175) after a scene change.  
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Audio codec: 
Under "Audio", "AAC" (view page 171) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available. 

AAC 
AAC was developed by MPEG, the Moving Picture Experts Group, as an audio data 
compression process that was specified as a further development of MPEG-2 
Multichannel in the MPEG-2 standard.  

AAC is equally suitable for encoding general audio information and not especially 
optimized for certain types of audio material.  

AAC audio can be encoded with a sample rate of 8000, 16000, 24000, 32000 or 
48000 Hz in either mono or stereo. By default, the sound is set to 48000 Hz stereo. 
The higher the sample rate is, the larger the resulting file and higher the audio quality. 
You can use the technical specifications of your playback device to help with this. 

Advanced audio settings: 

• The bit rate can be set between 6 and 512 kbit/s. 160 kbits/s is active by 
default. The higher the value is, the larger the resulting file and higher the audio 
quality. After a certain limit, additional improvements to audio quality will not be 
perceived. Bit rates under 64 kb/s are not recommended. 

• As an MPEG version, set MPEG-4 or the older, proven MPEG-2 format. 
• For the File Header Type, choose either RAW or ADTS. The "Header" indicates 

an explanatory head for the beginning of the file segment, which in fact takes up 
extra space, but is required for decoding under circumstances. 
- RAW indicates material which does not include a file header in audio format. 

The audio material is therefore transferred directly without any special 
additional information (raw). 
This requires that decoding routines are able to process the material without 
the explanatory file header. Especially in case "exotic" sample rates are set, 
this can lead to problems during RAW encoding. 

- ADTS indicates a file header type which contains information for encoded 
audio material. In case of doubt, select this file header type, since fewer 
problems can be expected in this case. 

Profiles:  

• Low complexity: Data is present in a form that hinders different decoding 
algorithms (noise replacement), but enables others (temporal adjustment noise 
formation). 
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Note: For example, Apple iPod requires "low complexity encoding". However, you 
don't need to worry if you select the right preset for Apple iPod in the export dialog. 

AVCHD audio track 
If you have chosen an AVCHD, AVCHD transport stream, or Blu-ray (H.264) from 
the presets, "AVCHD audio track" will be available. 

Note: 5.1 surround is only available in MAGIX Audio & Music Lab Premium. 

Multiplexer 
The Multiplexer combines audio and video streams so they can be played back 
together on playback devices. 

Output format 
MPEG-4 file: This is an MPEG standard (ISO/IEC-14496) with the original goal of 
supporting devices with less computing performance. Currently, MPEG-4 has reached 
a wide bandwidth of application, from HD video to support for mobile telephones. 

JPEG2000 file: DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 
format for encoding movies. The current distribution and presentation of films has 
been taken over by digital projectors that play back high-resolution Mj2 streams in 
outstanding image and sound quality. 

3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP 
is very similar to the MPEG-4 standard, but also supports formats that are not 
permitted by MPEG-4. 

Streamable format 
Activate this option if you would like to create files that can be integrated into and 
played back on websites. This way the file can be played back without having to be 
completely preloaded. 

Note: This setting is recommended if you choose the option "Export as website". 

For Sony PSP 
Switch on this option if the video should be played back with the Sony PSP. 

For iPod 
Switch on this option, if the video should be played back with the Apple iPod. 
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MPEG glossary 

Motion estimation 
Motion estimation is a further element for reducing data used in MPEG encoding.  

Motion estimation also occurs in the B and P frames. The image difference that still 
exist after prediction (view page 177) are examined. Complex algorithms are used to 
search for an original occurrence of the macro block in the reference frame of each 
macro block of the P or B frame (these are units of 2x2 blocks specially combined for 
this purpose), which have been moved either by movement or by camera pan. They 
can then be left out in the P and B frame. Only the information by how far and to 
where the macro block has been moved is saved instead. This vector is called the 
motion detector. 

In the General encoder settings, you can specify the quality of the final MPEG video. 
This factor also influences the time required for encoding. The longer it takes, the 
better the quality. 

Bit rate 
MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you 
could predict that 20 seconds of movie would result in 20 MB of data. The file size is 
this a direct measurement of quality.  

This is different for MPEG: The amount of data available can be used differently for 
different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet 
streaming in thumbnail format. The quality of an MPEG video is measured by the 
width of the created data stream, the bit rate. This is the amount of the transmitted 
data per time unit; it is stated in kBit/s or bit per second. 

Bits, not bytes are used, since the data word width has to address the transmission 
restrictions. 

The file size can be calculated from the average bit rate, if its length is known: 

F = (BRV + BRA) * t 

F=File size BRV= 
Video bit rate 

BRA= 
Audio bit rate 

t=Length in s 
 

Block 
For almost all image file editing techniques the image is subdivided into 8 x 8 pixel 
blocks (image points). This should be noted if you would like to used user-defined 
image resolutions (width/height), and they should always be a multiple of 8. 
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Chroma format 
The color value of each image point consists of the color values for the primary colors 
red, green, and blue (RGB), and for traditional and technical reasons it is transformed 
into one brightness value (Y = 0.299*R = 0.587*G + 0.114*B) and two color 
difference values (U = R - Y, V = G -Y). 

The Y value alone produces the black and white picture. These signal components 
allow brightness and color information to be handled separately. The first data 
reduction occurs  when single rows comprising a picture are read. Because the 
human eye has a lower color resolution than a brightness resolution, the color 
components are recorded only for every other point of a row (4:2:2) for each four 
pixels grouped (4:1:0), i.e. color signal under-reading. 

4:2:2 This corresponds to the established TV standard. One piece of color information 
is transmitted per row for two pixels which corresponds to a 2/3 compression of the 
output data. 

4:1:0  This is the color coding used for DVDs and most other consumer video 
applications. For each 4 pixels grouped together on two rows, one unit of color 
information is saved. This corresponds to a output data compression of 1/2. 

Field 
A half-image, i.e. two halves which combine to produce a frame (see de-interlacing 
(view page 175)).  

Frame 
A frame is a single image from a video sequence which also called a full image. PAL 
video, for example, contains 25 frames per second, NTSC 29.97 frames. Video 
recordings, with the exception of computer animations and still frames, don't contain 
full images. Instead, they have double numbers of half-images (fields) which are 
transmitted in an interlaced state. However, we still refer to frames, since many 
predecessors of MPEG compression are based on such frames. Video editing 
literature usually refers to frames. 

GOP 
Group of Pictures: The sequence of I frames and the P and B frames that belong to 
them. 

e.g. I B B P B B P B B I ... 
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(This GOP has a length of 9, with 2 P frames and 2 B frames) 

I frames contain the entire image information of a frame, while P and B have part of 
the information. So-called prediction (view page 177) and movement approximation 
are methods used for reduction. 

The combination P B B is called a subgroup. 

I frames must appear in regular intervals in the data stream for image and sound to be 
synchronized. Between the I frames only a limited count of P and B frames is allowed. 
This explains a few things: Since P and B frames contain only differential information, 
these differences will be larger with time, since more and more changes takes place 
from frame to frame. A large count does not make much sense, since GOP has a 
maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B 
frames between P frames is not allowed). 

In a closed GOP, B frames of the last subgroup may contain only backward 
predictions or references to the preceding P frame, but no references to the following I 
frame, since it belongs to the next GOP. 

I frames 
Intra-frames: In these pictures, the entire image information of a frame is saved and 
only information from this frame is used ("intra-frame encoded"). In contrast to the I 
frame, P and B frames save only the differences between the current frame, and 
preceding and/or following frame are also found in MPEG video (P frame = "predicted 
frame", B frame = "bidirectional frame", see Prediction (view page 177)). 

Interlace 
For historical reasons, pictures in a movie are always recorded and transmitted in the 
form of two fields, first the lines with even numbers and then those with odd 
numbers. These fields are alternatively displayed with a double-frame rate. The (lazy) 
eye of the viewer or the processing of the TV tube puts the two frames together to 
form one. 

   

The output image First field Second field 

You normally don’t have to worry about field processing. The video material goes 
through the entire processing chain as fields and is exported again as fields or burned 
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onto DVD or shown on TV when played back on a DVD as a full picture. Only in 
certain rare conditions is it necessary to delve deeper into this process. Two problems 
can occur: 

Interlace artifacts 
To be displayed on a computer monitor the two fields must be combined to form a 
full screen.  

These two fields are not the same, since two fields are created during the recording 
(between which a 1/50 of a second gap is evident). Moving objects can therefore 
produce artifacts at the vertical edges. 

  

Typical interlacing errors 

You can use so-called "de-interlacing" to avoid these artifacts. A picture in between 
the two fields is created (interpolated). So if you want to create stationary pictures 
from movies, then you should definitely use a de-interlace filter. 

In the system settings (File menu-> Program settings) you can set the preview 
monitor display to use hardware de-interlacing during video recordings, for the video 
recorder, and for display in the arranger. 

Incorrect field rate 
If you move around the series of fields in a movie data stream you can see strong jitter 
and flicker effects. Picture objects move in a backward movement - two steps 
forwards, one back - since a delayed field is shown before the previous one. This can 
happen in the processing chain if you export video material improperly with the wrong 
field order and then import it into different material.  

We use MXV or MPEG "Top field first" format for all analog recordings ("odd" in 
other programs). DV-AVI on the other hand is saved with “Bottom Field First”.  

You can correct the field series for each video object in its object settings. See: Menu 
-> Effects -> Object properties 

P frames and B frames 
P frames save only the difference between the current picture and the preceding I 
frame. The "P" comes from the term "prediction" which describes this process. 
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B frames save the differences between the current picture and the I or P frame 
preceding and following. This includes the information that was the same before and 
remained the same after the current frame. Both directions are analyzed (indicates 
the "B" in the name, i.e. "bidirectional-predicted"). You can read more under 
prediction (view page 177). 

Prediction 
Prediction is a method of data reduction used by the MPEG format. The image 
elements already known from the previous or following frames are removed from the 
data stream. 

How does it work? 
The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is 
transmitted together with the encoder, which always knows exactly which kind of 
frame comes next. I, P, and B frames are differentiated. 

Hint: When we talk about pictures, we mean frames of the video output, and I, P an 
dB frames are the frames of the encoded video. Just as in movement approximation, 
blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction. 

The first frame is always the I frame. It is completely encoded from the first picture. 
Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As 
already said, the encoder, and later the decoder, will know that two B frames belong 
between them.) This image will also be completely encoded, and afterwards all 
macroblocks that haven't changed in comparison to the I frame will be deleted. They 
will be replaced by corresponding references for the decoder that tell it "you already 
know what should be shown here, and you can get it from the last I frame". 

Now, the 2nd will be completely encoded, and all macroblocks identical to the first I 
frame and the following P frame will be removed. References to previous frames  are 
called backward predictions, and references to following frames are called forward 
predictions. The third picture will be edited in exactly the same fashion. 

The fourth picture we have already explained, and now we need the next P frame, or 
picture number 7. Pictures 5 and 6 are B frames again, which are compared to P 
frames to both sides of them (picture 4 and 7); these are followed by the last two B 
frames. These have a special place, since in closed GOPs, they may contain only 
backward predictions, and no references to the next I frame, because it belongs to 
the next GOP. 

Something else: Since the decoder is no prophet, the P frames are always transmitted 
before the B frames! The GOP explained above will be encoded and transmitted in the 
order it is written. 
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Original 
GOP 

I0 B01 B02 P01 B11 B12 P02 B21 B22 I1  

Data stream I0 P01 B01 B02 P02 B11 B12 B21 B22 I1 ...  for closed GOPs 

 I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11...  For open GOPs 

Due to this nested structure, it is easy to see that during direct editing of MPEG 
material, complicated computations have to take place! These are made easier using 
a frame table. A frame table contains a list, where the information of every frame in 
the data stream is found, identifying the type of frame it is.  

Using Movement prediction (view page 173) P and B frames are likewise reduced. 

Quantization scaling 
The single pictures in MPEG are saved using a compression method comparable to 
JPEG with bitmaps and associated with quality loss. For this single images are divided 
into 8 x 8 blocks (view page 173). 

Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows 
and columns) using a DCT (discreet cosinus transformation) mathematical method. 
Each of these values is produced using all 64 individual pixels of the block, but the 
values in the matrix are ordered in such a way that the image information is ordered 
according to its importance. 

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. 
Exactly how and why this matrix must be created is the biggest secret of encoder 
programmers, since this determines the quality of the whole encoding process. What 
is known is that the result should contain as many zeros as possible! These zeros 
correspond to the "unimportant" image elements mentioned and will not be 
transmitted in the data stream. 

Depending on the encoder parameters regarding the target bit rate, fewer or more 
values of the matrix will be declared unimportant by dividing the quantization matrix 
by the quantization scaling factor. Since only whole numbers are used, a division can 
produce a zero is the remainder is discarded. 

This factor is also a direct measure of the sought image quality of the MPEG data 
stream, since the "Q" in "Q" factor stands for quantization and quality. 
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